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I. Using jEdit
This part of the user’s guide covers jEdit’s text editing commands, along with basic
usage of macros and plugins.

This part of the user’s guide was written by Slava Pestov <slava@jedit.org >.





Chapter 1. Starting jEdit

1.1. Conventions
Several conventions are used throughout jEdit’s user interface and this manual. They will
be described here.

When a menu item selection is being described, the top level menu is listed first,
followed by successive levels of submenus, finally followed by the menu item itself. All
menu components are separated by greater-than symbols (“>”). For example,
View>Scrolling>Scroll to Current Line refers to theScroll to Current Line command
contained in theScrolling submenu of theView menu.

As with many other applications, menu items that end with ellipsis (...) display dialog
boxes or windows when invoked.

Many jEdit commands can be also be invoked using keystrokes. This speeds up editing
by letting you keep your hands on the keyboard. Not all commands with keyboard
shortcuts are accessible with one key stroke; for example, the keyboard shortcut for
Scroll to Current Line is Control -E Control -J. That is, you must first pressControl -E,
followed byControl -J.

In many dialog boxes, the default button (it has a heavy outline, or a special border,
depending on the current Swing look and feel) can be activated by pressingEnter.
Similarly, pressingEscapewill usually close a dialog box.

Finally, some user interface elements (menus, menu items, buttons) have a certain letter
in their label underlined. Pressing this letter in combination with theAlt key activates the
associated user interface widget.
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Chapter 1. Starting jEdit

MacOS

jEdit tries to adapt itself to established conventions when running on MacOS.

If you are using MacOS, mentally substitute the modifier keys you see in this
manual as follows:

• ReadControl asCommand

• ReadAlt asOption

If you only have a one-button mouse, a right button click (to show a context menu,
and so on) can be simulated by holding downControl while clicking. A middle
button click (to insert the most recent selection in the text area) can be simulated
by holding downOption while clicking.

1.2. Platform-Independent Instructions
Exactly how jEdit is started depends on the operating system; on Unix systems, usually
you would run the “jedit” command at the command line, or select jEdit from a menu; on
Windows, you might use the jEditLauncher package, which is documented inSection
1.3.

If jEdit is started while another copy is already running, control is transferred to the
running copy, and a second instance is not loaded. This saves time and memory if jEdit is
started multiple times. Communication between instances of jEdit is implemented using
TCP/IP sockets; the initial instance is known as theserver, and subsequent invocations
areclients.

If the -background command line switch is specified, jEdit will continue running and
waiting for client requests even after all editor windows are closed. When run in
background mode, you can open and close jEdit any number of times, only having to
wait for it to start the first time. The downside of this is that jEdit will continue to
consume memory when no windows are open.

For more information about command line switches that control the server feature, see
Section 1.4. Note that if you are using jEditLauncher to start jEdit on Windows, this
switch cannot be specified on the MS-DOS prompt command line when starting jEdit; it

14
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must be set as described inSection G.2.

Unlike other applications, jEdit automatically loads any files that were open last time in
was used, so you can get back to work immediately, without having to find the files you
are working on first. This feature can be disabled in theLoading and Saving pane of
theUtilities>Global Options dialog box; seeSection 6.3.

The edit server and security

Not only does the server pick a random TCP port number on startup, it also
requires that clients provide anauthorization key; a randomly-generated number
only accessible to processes running on the local machine. So not only will “bad
guys” have to guess a 64-bit integer, they will need to get it right on the first try;
the edit server shuts itself off upon receiving an invalid packet.

In environments that demand absolute security, the edit server can be disabled by
specifying the-noservercommand line switch.

1.3. Starting jEdit on Windows
On Windows, jEdit comes withjEditLauncher- an optional package of components that
make it easy to start jEdit, manage its command line settings, and launch files and macro
scripts.

The jEditLauncher package provides three shortcuts for running jEdit: one in the
desktop’sStart menu, a entry in the Programs menu, and a third shortcut on your
desktop. Any of these may be deleted or moved without affecting jEdit’s operation. To
launch jEdit, simply select one of these shortcuts as you would for any Windows
application.

The jEditLauncher package includes a utility for changing the command line parameters
that are stored with jEditLauncher and used every time it runs jEdit. You can change the
Java interpreter used to launch jEdit, the amount of heap memory, the working directory
and other command line parameters. To make these changes, selectSet jEdit
Parameters from the jEdit group in the Programs menu, or runjedit /p from a
command line that has jEdit’s installation directory in its search path. A dialog will
appear that allows you to change and save a new set of command line parameters.

15
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The package also adds menu items to the context or “right-click” menu displayed by the
Windows shell when you click on a file item in the desktop window, a Windows Explorer
window or a standard file selection dialog. The menu entries allow you to open selected
files in jEdit, starting the application if necessary. It will also allow you to open all files
in a directory with a given extension with a single menu selection. If a BeanShell macro
script with a.bsh extension is selected, the menu includes the option of running that
script within jEdit. If you have the JDiff plugin installed with jEdit, you can also select
two files and have jEdit compare them in a side-by-side graphical display.

For a more detailed description of all features found in the jEditLauncher package, see
Appendix G.

1.4. Command Line Usage
On operating systems that support a command line, jEdit can be passed various
arguments to control its behavior.

If you are using jEditLauncher to start jEdit on Windows, only file names can be
specified on the command line; the parameters documented below must be set as
described inSection G.2.

When opening files from the command line, a line number or marker to position the caret
on can be specified like so:

$ jedit MyApplet.java +line:10
$ jedit thesis.tex +marker:c

A number of options can also be specified to control several obscure features. They are
listed in the following table.

Option Description
-background Runs jEdit in background mode. In background mode, the edit

server will continue listening for client connections even after
all views are closed. SeeChapter 1.
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Option Description
-nogui Makes jEdit not open an initial view, and instead only open

one when the first client connects. Can only be used in
combination with the-background switch. You can use this
switch to “pre-load” jEdit when you log in to your computer,
for example.

-norestore Disables automatic restore of previously open files on startup.
This feature can also be set permanently in theLoading and
Saving pane of theUtilities>Global Options dialog box; see
Section 6.3.

-run=script Runs the specified BeanShell script. There can only be one of
these parameters on the command line. SeeSection 14.3for
details.

-server Stores the server port info in the file namedserver inside the
settings directory.

-server=name Stores the server port info in the file namedname. File names
for this parameter are relative to the settings directory.

-noserver Does not attempt to connect to a running edit server, and does
not start one either. For information about the edit server, see
Chapter 1.

-settings=dir Loads and saves the user-specific settings in the directory
nameddir , instead of the defaultuser.home /.jedit . The
directory will be created automatically if it does not exist. Has
no effect when connecting to another instance via the edit
server.

-nosettings Starts jEdit without loading user-specific settings. SeeSection
6.4.

-noplugins Causes jEdit to not load any plugins. SeeChapter 8. Has no
effect when connecting to another instance via the edit server.

-nostartupscripts Causes jEdit to not run any startup scripts. SeeSection 14.2.
Has no effect when connecting to another instance via the edit
server.

-usage Shows a brief command line usage message without starting
jEdit. This message is also shown if an invalid switch was
specified.

17
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Option Description
-version Shows the version number without starting jEdit.

- - Specifies the end of the command line switches. Further
parameters are treated as file names, even if they begin with a
dash. Can be used to open files whose names start with a dash,
and so on.

18
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2.1. Buffers
Several files can be opened and edited at once. Each open file is referred to as abuffer.
The combo box above the text area selects the buffer to edit. Different emblems are
displayed next to buffer names in the list, depending the buffer’s state; a red disk is
shown for buffers with unsaved changes, a lock is shown for read-only buffers, and a
spark is shown for new buffers which don’t yet exist on disk.

In addition to the buffer combo box, various commands can also be used to select the
buffer to edit.

View>Go to Previous Buffer (keyboard shortcut:Control -Page Up) switches to the
previous buffer in the list.

View>Go to Next Buffer (keyboard shortcut:Control -Page Down) switches to the next
buffer in the list.

View>Go to Recent Buffer (keyboard shortcut:Control -‘ ) switches to the buffer that
was being edited prior to the current one.

2.1.1. Memory Usage

The maximum number of open buffers depends on availableJava heap memory. When
stored in the Java heap, each buffer requires approximately two and a half times it’s size
on disk. This overhead is caused by the file being stored internally as Unicode (see
Section 3.5), and the fact that additional information, such as line numbers, also needs to
be stored.

The status bar at the bottom of the view displays used and total Java heap memory; see
Section 2.2.2for details. This can give you a rough idea of how much memory the
currently opened files are using. The Java heap grows if it runs out of room; but it only
grows to a certain maximum size, and attempts to allocate Java objects that would grow
the heap beyond this size fail with out-of-memory errors.

One side-effect of this is that if the maximum heap size is set too low, opening large files
or performing other memory-intensive operations can fail, even if you have a lot of
system memory free. The solution is to change the Java heap size.
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To change the heap size on Windows, run “Set jEdit Parameters” from the “jEdit” group
in the Programs menu. Then, in the resulting dialog box, under “Command line options
for Java executable”, change the option that looks like so:

-mx32m

(SeeSection G.2for more information about the “Set jEdit Parameters” dialog box.)

On Unix, edit thejedit shell script and change the line that looks like so:

JAVA_HEAP_SIZE=32

In both cases, replace “32” with the desired heap size, in megabytes.

2.2. Views
Each editor window is known as aview. It is possible to have multiple views open at
once, and each view can be split into multiple panes.

View>New View creates a new view.

View>Close View closes the current view. If only one view is open, closing it will exit
jEdit, unless background mode is on; seeChapter 1for information about starting jEdit
in background mode.

View>Split Horizontally (shortcut:Control -2) splits the view into two text areas, placed
above each other.

View>Split Vertically (shortcut:Control -3) splits the view into two text areas, placed
next to each other.

View>Unsplit (shortcut:Control -1) removes all but the current text area from the view.

When a view is split, editing commands operate on the text area that has keyboard focus.
To give a text area keyboard focus, click in it with the mouse, or use the following
commands.

View>Go to Previous Text Area (shortcut:Alt -Page Up) shifts keyboard focus to the
previous text area.

View>Go to Next Text Area (shortcut:Alt -Page Down) shifts keyboard focus to the
next text area.

20
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Clicking the text area with the right mouse button displays a popup menu. Both this
menu and the tool bar at the top of the view offer quick mouse-based access to
frequently-used commands. The contents of the tool bar and right-click menu can be
changed in theUtilities>Global Options dialog box.

2.2.1. Window Docking

The file system browser, HyperSearch results window, and many plugin windows can
optionally be docked into the view. This can be configured in theDocking pane of the
Utilities>Global Options dialog box; seeSection 6.3.

When windows are docked into the view, strips of buttons are shown in the left, right,
top, and bottom sides of the text area. Each strip contains buttons for the windows
docked in that location, as well as a close box. Clicking a window’s button shows that
dockable window; clicking the close box hides the window again.

The commands in theView>Docking menu (shortcuts:Control -E 1, 2, 3, 4) provide
keyboard equivalents for the close boxes.

2.2.2. The Status Bar

Thestatus barat the bottom of the view consists of the following components, from left
to right:

• The line number containing the caret

• The column position of the caret, with the leftmost column being 1.

If the line contains tabs, thefile position (where a hard tab is counted as one
column) is shown first, followed by thescreenposition (where each tab counts for
the number of columns until the next tab stop).

Double-clicking on the caret location indicator displays theEdit>Go to Line dialog
box; seeSection 4.6.

• Prompts displayed by commands such as those dealing with registers and markers
(seeSection 4.10andSection 4.11), also I/O progress messages (seeSection 3.8)

21



Chapter 2. jEdit Basics

• The current buffer’s edit mode. Double-clicking this displays theUtilities>Buffer
Options dialog box. SeeSection 5.1andSection 6.1.

• The current buffer’s character encoding. Double-clicking this displays the
Utilities>Buffer Options dialog box. SeeSection 3.5andSection 6.1.

• The current buffer’s fold mode; this is either “none”, “indent” or “explicit”.
Clicking here toggles between the three modes. SeeSection 5.6.

• If multiple selection is enabled, the stringmulti; otherwisesingle. Clicking here or
pressingControl -\ turns multiple selection on and off. SeeSection 4.2.2.

• If overwrite mode is enabled, the stringovr; otherwiseins. Clicking here or
pressingInsert turns overwrite mode on and off. SeeSection 4.3.

• A Java heap memory usage indicator, that shows used versus total heap memory, in
megabytes. Double-clicking here opens theUtilities>Memory Status dialog box.

2.3. The Text Area
Text editing takes place in the text area. It behaves in a similar manner to many Windows
and MacOS editors; the few unique features will be described in this section.

The text area will automatically scroll up or down if text editing is performed closer than
three lines from the top or bottom of the text area. This feature is calledelectric scrolling
and can be disabled in theText Area pane of theUtilities>Global Options dialog box;
seeSection 6.3.

To aid in locating the caret, the current line is drawn with a different background color.
To make it clear which lines end with white space, end of line markers are drawn at the
end of each line. Both these features can be disabled in theText Area pane of the
Utilities>Global Options dialog box.

The strip on the left of the text area is called agutter. The gutter displays marker and
register locations; it will also display line numbers if theView>Line Numbers
(shortcut:Control -E Control -T) command is invoked.
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2.4. Command Repetition
There is one other jEdit feature that needs to be discussed before we continue further. To
repeat a command any number of times, invokeUtilities>Repeat Next Command
(shortcut:Control -Enter) and enter the desired repeat count, followed by the command
to repeat (either a keystroke or menu item selection). For example, “Control -Enter 1 4
Control -D” will delete 14 lines, and “Control -Enter 8 #” will insert “########” in the
buffer.

If you specify a repeat count greater than 20, a confirmation dialog box will be
displayed, asking if you really want to perform the action. This prevents you from
hanging jEdit by executing a command too many times.
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3.1. Creating New Files
File>New (shortcut:Control -N) opens a new untitled buffer. When it is saved, a file will
be created on disk. Another way to create a new file is to specify a non-existent file name
when starting jEdit from your operating system’s command line.

3.2. Opening Files
File>Open (shortcut:Control -O) displays a file selector dialog box and loads the
specified file into a new buffer. Multiple files can be opened at once by holding down
Control while clicking on them in the file system browser.

Files that you do not have write access to are opened in read-only mode, and editing will
not be permitted.

File>Insert displays a file selector dialog box and inserts the specified file into the
current buffer.

TheFile>Current Directory menu lists all files in the current buffer’s directory.

TheFile>Recent Files menu lists recent files. When a recent file is opened, the caret is
automatically moved to its previous location in that file. The number of recent files to
remember can be changed and caret position saving can be disabled in theGeneral pane
of theUtilities>Global Options dialog box; seeSection 6.3.

Tip: jEdit supports transparent editing of GZipped files; if a file begins with the
GZip “magic number”, it is automatically decompressed before loading, and
compressed when saving. To compress an existing file, you need to change a
setting in the Utilities>Buffer Options dialog box; see Section 6.1 for details.
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3.3. Saving Files
Changed made to a buffer do not affect the file on disk until the buffer issaved.

File>Save (shortcut:Control -S) saves the current buffer to disk.

File>Save All (shortcut:Control -E Control -S) saves all open buffers to disk, asking for
confirmation first.

File>Save As saves the buffer to a different specified file on disk. The buffer is then
renamed, and subsequent saves also save to the specified file. Note that using this
command to save over an already open buffer will close that buffer, to avoid having two
buffers open with the same path name.

File>Save a Copy As saves the buffer to a different specified file on disk, but doesn’t
rename the buffer, and doesn’t clear the “modified” flag. Note that using this command
to save over an already open buffer will automatically reload that buffer.

How files are saved

To prevent data loss in the unlikely case that jEdit should crash in the middle of
saving a file, files are first saved to#filename #save# . If this operation is
successful, the original file is replaced with the temporary file.

However, in some situations, this behavior is undesirable. For example, on Unix
saving files this way will result in the owner and group of the file being reset. If this
bothers you, you can disable this so-called “two-stage save” in theLoading and
Saving pane of theUtilities>Global Options dialog box.

3.3.1. Autosave and Crash Recovery

The autosave feature protects your work from computer crashes and such. Every 30
seconds, all buffers with unsaved changes are written out to their respective file names,
enclosed in hash (“#”) characters. For example,program.c will be autosaved to
#program.c# .

Saving a buffer using one of the commands in the previous section automatically deletes
the autosave file, so they will only ever be visible in the unlikely event of a jEdit (or
operating system) crash.
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If an autosave file is found while a buffer is being loaded, jEdit will offer to recover the
autosaved data.

The autosave feature can be configured in theLoading and Saving pane of the
Utilities>Global Options dialog box; seeSection 6.3.

3.3.2. Backups

The backup feature can be used to roll back to the previous version of a file after changes
were made. When a buffer is saved for the first time after being opened, its original
contents are “backed up” under a different file name.

The default behavior is to back up the original contents to the buffer’s file name suffixed
with a tilde (“~”). For example,paper.tex will be backed up topaper.tex~ .

The backup feature can also be configured in theLoading and Saving pane of the
Utilities>Global Options dialog box. It can be customized to do any of the following:

• Save numbered backups, namedfilename ~number ~

• Add a prefix to the backed-up file name

• Adds a suffix to the backed-up file name (the default is “~”)

• Backups can optionally be saved in a specified backup directory, instead of the
directory of the original file. This can reduce clutter

• Backups can also optionally be created every time a buffer is saved; as mentioned
above, the default is to only create a backup the first time a buffer is saved after
being opened.

3.4. Line Separators
The three major operating systems use different conventions to mark line endings in text
files. The MacOS uses Carriage-Return characters (\r in Java-speak) for that purpose.
Unix uses Newline characters (\n ). Windows uses both (\r\n ). jEdit can read and write
files in all three formats.
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When loading a file, the line separator used within is automatically detected, and will be
used when saving a file back to disk. The line separator used when saving the current
buffer can be changed in theUtilities>Buffer Options dialog box; seeSection 6.1.

By default, new files are saved with your operating system’s native line separator. This
can be changed in theLoading and Saving pane of theUtilities>Global Options
dialog box; seeSection 6.3. Note that changing this setting has no effect on existing files.

3.5. Character Encodings
If you edit files in different human languages, you will most likely be familiar with the
concept of a “character encoding”. The simplest explanation of this is that there are
several ways in which a character can be stored on disk; different programs must be set
to the same encoding to be able to exchange text. The current buffer’s encoding is shown
in the status bar.

jEdit can use any encoding supported by the Java platform. The default encoding, used to
load and save files for which no other encoding is specified, can be set in theLoading
and Saving pane of theUtilities>Global Options dialog box; seeSection 6.3. The
setting is presented as an editable combo box; the combo box contains a few of the more
frequently used encodings, but the Java platform defines practically hundreds more you
can use.

Unfortunately, there is no way to obtain a list of all supported encodings in Java, and the
set is constantly changing with each Java version. So to play it safe, jEdit has a few
pre-defined defaults, but allows you to use any other supported encoding, assuming you
know its name.

Unless you change the default encoding, jEdit will use your operating system’s native
default;MacRomanon the MacOS,Cp1252 on Windows, and8859_1 on Unix.

TheFile>Open With Encoding lets you open a file with an encoding other than the
default. The menu contains a set of items, one for each common encoding, along with
System Default andjEdit Default commands. Invoking a menu item displays the usual
file dialog box, and opens the selected file with the chosen encoding.

TheOpen With Other Encoding command in the same menu lets you enter an arbitrary
encoding name, assuming it is supported by your Java implementation.
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Once a file has been opened, the encoding to use when saving it can be set in the
Utilities>Buffer Options dialog box.

If a file is opened without an explicit encoding specified and it appears in the recent file
list, jEdit will use the encoding last used when working with that file; otherwise the
default encoding will be used.

3.5.1. Commonly Used Encodings

The most frequently-used character encoding is ASCII, or “American Standard Code for
Information Interchange”. ASCII encodes Latin letters used in English, in addition to
numbers and a range of punctuation characters. The ASCII character set consists of 127
characters, and it is unsuitable for anything but English text (and other file types which
only use English characters, like most program source). jEdit will load and save files as
ASCII if the ASCII encoding is used.

Because ASCII is unsuitable for international use, most operating systems use an 8-bit
extension of ASCII, with the first 127 characters remaining the same, and the rest used to
encode accents, umlauts, and various less frequently used typographical marks.
Unfortunately, the three major operating systems all extend ASCII in a different way.
Files written by Macintosh programs can be read using theMacRomanencoding;
Windows text files are usually stored asCp1252. In the Unix world, the8859_1

(otherwise known asLatin1 ) character encoding has found widespread usage.

Windows users are accustomed to dealing with files in a wide range of character sets,
known ascode pages. Java supports a large number of code pages; the encoding name
consists of the text “Cp”, followed by a number.

Raw Unicode files are quite rare, but can be read and written with theUnicode encoding.
One reason raw Unicode has not found widespread usage for storing files on disk is that
each character takes up 16 bits. Most other character sets devote 8 bits per character,
which saves space. TheUTF8 encoding encodes frequently-used Unicode characters as 8
bits, with less-frequent ones stretching up to 24 bits. This saves space but allows the full
range of Unicode characters to be represented.

Many common cross-platform international character sets are supported;KOI8_R for
Russian text,Big5 andGBKfor Chinese, andSJIS for Japanese.
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3.6. The File System Browser
Utilities>File System Browser displays a file system browser. By default, the file
system browser is shown in a floating window; it can be set to dock into the view in the
Docking pane of theUtilities>Global Options dialog box; seeSection 2.2.1.

The file system browser can be customized in theUtilities>Global Options dialog box.

3.6.1. Navigating the File System

The directory to browse is specified in thePath text field. Clicking the mouse in the text
field automatically selects its contents allowing a new path to be quickly typed in. If a
relative path is entered, it will be resolved relative to the current path. This text field
remembers previously entered strings; seeAppendix C. Previously browsed directories
are also listed in theFile>Recent Directories menu; selecting one opens it in the file
system browser.

To browse higher up in the directory hierarchy, click one of the parent directories in the
parent directory list.

Files and directories in the file list are shown in different colors depending on what glob
patterns their names match. The patterns and colors can be customized in theFile
System Browser>Colors pane of theUtilities>Global Options dialog box.

To browse a listed directory, double-click it (or if you have a three-button mouse, you
can click the middle mouse button as well). Alternatively, click the disclosure widget
next to a directory to list its contents in place.

Open files in the file list are shown with their file names underlined. Single-clicking an
open file will select the appropriate buffer in the current view. Unopened files can be
opened for editing by double-clicking (or by clicking the middle mouse button). If you
hold downShift while double-clicking (or middle-clicking), the file will be opened in a
new view.

Clicking a file or directory with the right mouse button displays a popup menu
containing file manipulation commands. Note that attempting to delete a directory
containing files will give an error; only empty directories can be deleted.

If you only want to see a specific set of files (for example, those whose names end with
.java ), enter a glob pattern in theFilter text field. SeeAppendix Dfor information about
glob patterns. This text fields remembers previously entered strings; seeAppendix C.
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Tip: The file list sorting algorithm used in jEdit handles numbers in file names in an
intelligent manner. For example, a file named section10.xml will be placed after a
file named section5.xml . A conventional letter-by-letter sort would have placed
these two files in the wrong order.

3.6.2. The Tool Bar

The file system browser has a tool bar containing a number of icons. These buttons
correspond to the items in theCommands menu described below; the only menu item
that does not have a corresponding tool bar button isShow Hidden Files.

3.6.3. The Commands Menu

Clicking theCommands button displays a menu containing the following items:

• Parent Directory - moves up in the directory hierarchy.

• Reload Directory - reloads the file list from disk.

• Local Drives - displays all local drives. On Windows, this will be a list of drive
letters; on Unix, the list will only contain one entry, the root directory.

• Home Directory - displays your home directory.

• Directory of Current Buffer - displays the directory containing the currently
active buffer.

• New File - opens anUntitled file in the current directory. The file will not
actually be created on disk until it is saved.

• New Directory - creates a new directory after prompting for the desired name.

• Search in Directory - displays the search and replace dialog box for searching in
all files in the current directory. If a file is selected, its extension becomes the file
name filter for the search; otherwise, the file name filter entered in the browser is
used. SeeSection 4.12for details.

• Show Hidden Files - toggles if hidden files are to be shown in the file list.
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3.6.4. The Plugins Menu

Clicking thePlugins button displays a menu containing commands for browsing plugin
file systems. For information about plugins, seeChapter 8.

3.6.5. The Favorites Menu

Clicking theFavorites button displays a menu showing all directories in the favorites
list, along with anAdd to Favorites command that adds the current directory to the
favorites, and anEdit Favorites command that shows the favorites list in the file system
view, allowing items to be removed by right-clicking on them and selectingDelete from
the resulting popup menu.

3.6.6. Keyboard Shortcuts

The file system browser can be navigated from the keyboard:

• Enter - opens the currently selected file or directory.

• Left - goes to the current directory’s parent.

• Up - selects previous file in list.

• Down - selects next file in list.

• / - displays all local drives.

• ~ - displays your home directory.

• - - displays the directory containing the current buffer.

• Typing the first few characters of a file’s name will select that file.

The file system view, and not thePath or Filter text fields must have keyboard focus for
these shortcuts to work.
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3.7. Reloading Files
If an open buffer is modified on disk by another application, a warning dialog box is
displayed, offering to either continue editing (and lose changes made by the other
application) or reload the buffer from disk (and lose any unsaved changes in jEdit). This
feature can be disabled in theGeneral pane of theUtilities>Global Options dialog box;
seeSection 6.3.

File>Reload can be used to reload the current buffer from disk at any other time; a
confirmation dialog box will be displayed first if the buffer has unsaved changes.

File>Reload All discards unsaved changes in all open buffers and reload them from
disk, asking for confirmation first.

3.8. Multi-Threaded I/O
To improve responsiveness and perceived performance, jEdit executes all input/output
operations asynchronously. While I/O is in progress, the status bar displays the number
of remaining I/O operations. TheUtilities>I/O Progress Monitor command displays a
window with more detailed status information and progress meters. Requests can also be
aborted in this window. Note that aborting a buffer save can result in data loss.

By default, four I/O threads are created, which means that up to four buffers can be
loaded or saved simultaneously. The number of threads can be changed in theLoading
and Saving pane of theUtilities>Global Options dialog box; seeSection 6.3. Setting
the number to zero disables multi-threaded I/O completely; doing this is not
recommended.

3.9. Printing Files
File>Print (shortcut:Control -P) will print the current buffer. By default, the printed
output will have syntax highlighting, and each page will have a header with the file
name, and a footer with the current date/time and page number. The appearance of
printed output can be customized in thePrinting pane of theUtilities>Global Options
dialog box. The following settings can be changed:

• The font to use when printing
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• If a header with the file name should be printed on each page.

• If a footer with the page number and current date should be printed on each page.

• If line numbers should be printed.

• If the output should be colored according to the current mode’s syntax highlighting
rules (might look bad on gray-scale printers); otherwise, only syntax styles will be
applied.

• The tab size to use when printing - this will usually be less than the text area tab
size, to conserve space in the printed output.

3.10. Closing Files and Exiting jEdit
File>Close (shortcut:Control -W) closes the current buffer. If it has unsaved changes,
jEdit will ask if they should be saved first.

File>Close All (shortcut:Control -E Control -W) closes all buffers. If any buffers have
unsaved changes, they will be listed in a dialog box where they can be saved or
discarded. In the dialog box, multiple buffers to operate on at once can be selected by
clicking on them in the list while holding downControl .

File>Exit (shortcut:Control -Q) will completely exit jEdit.

34



Chapter 4. Editing Text

4.1. Moving The Caret
The most direct way to move the caret is to click the mouse at the desired location in the
text area. It can also be moved using the keyboard.

TheLeft , Right, Up andDown keys move the caret in the respective direction, and the
Page UpandPage Downkeys move the caret up and down one screenful, respectively.

When pressed once, theHomekey moves the caret to the first non-whitespace character
of the current line. Pressing it a second time moves the caret to the beginning of the
current line. Pressing it a third time moves the caret to the first visible line.

TheEnd key behaves in a similar manner, going to the last non-whitespace character, the
end of the line, and finally to the last visible line.

If there is a selection,HomeandEnd behave the same as above, except that instead of
operating on the current line, they move the caret to the first and last lines of the
selection, respectively.

If soft wrap is enabled (seeSection 4.8), the first time they are pressedHomeandEnd
only go to the start and end of the current screen line; the second press moves to the start
and end of the physical line.

Control -HomeandControl -End move the caret to the beginning and end of the buffer.

More advanced caret movement is covered inSection 4.5, Section 4.6andSection 4.7.

4.2. Selecting Text
A selectionis a a block of text marked for further manipulation. Unlike many other
applications, jEdit supports both range and rectangular selections, and several chunks of
text can be selected simultaneously.

Dragging the mouse creates a range selection from where the mouse was pressed to
where it was released. Holding downShift while clicking a location in the buffer will
create a selection from the caret position to the clicked location.
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Holding downShift in addition to a caret movement key (Left , Up, Home, etc) will
extend the selection in the specified direction. If no selection exists, one will be created.

Edit>Select All (shortcut:Control -A) selects the entire buffer.

Edit>Select None (shortcut:Escape) deactivates the selection.

4.2.1. Rectangular Selection

Dragging with theControl key held down will create a rectangular selection. Holding
downShift andControl while clicking a location in the buffer will create a rectangular
selection from the caret position to the clicked location.

It is possible to select a rectangle with zero width but non-zero height. This can be used
to insert a new column between two existing columns, for example. Such zero-width
selections are shown as a thin vertical line.

Rectangles can be deleted, copied, pasted, and operated on using ordinary editing
commands.

Note: Rectangular selections are implemented using character offsets, not
absolute screen positions, so they might not behave as you might expect if a
proportional-width font is being used, hard tabs are enabled, or soft wrap is
enabled. For information about changing the font used in the text area, see Section
6.3. For information about tabs and wrapping, see Section 5.4.1 and Section 4.8.

4.2.2. Multiple Selection

PressingControl -\ turns multiple selection mode on and off. In multiple selection mode,
multiple fragments of text can be selected and operated on simultaneously, and the text
multi is shown in the status bar.

While multiple selection mode is active, you can click and drag the mouse to reposition
the caret and create new selections.

Various jEdit commands behave differently with multiple selections:
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• Commands that copy text place the contents of each selection, separated by line
breaks, in the specified register.

• Commands that insert (or paste) text replace each selection with the entire text that
is being inserted.

• Commands that filter text (such asSpaces to Tabs, Range Comment, and even
Replace in Selection) operate on each selection, in turn.

• Line-based commands (such asShift Indent Left, Shift Indent Right, andLine
Comment) operate on each line that contains at least one selection.

• Caret movement commands that would normally deactivate the selection (such as
the arrow keys, whileShift is not being held down), move the caret, leaving the
selection as-is.

• Some older plugins may not support multiple selection at all.

Edit>Invert Selection (shortcut:Control -E I ) selects a set of text chunks such that all
text that was formerly part of a selection is now unselected, and all text that wasn’t, is
selected.

Tip: Deactivating multiple selection mode while a fragmented selection exists will
leave the selection in place, but it will prevent you from making further fragmented
selections.

4.3. Inserting and Deleting Text
Text entered at the keyboard is inserted into the buffer. If overwrite mode is on, one
character is deleted from in front of the caret position for every character that is inserted.
To activate overwrite mode, pressInsert. The caret is drawn as horizontal line while in
overwrite mode; the textovr also appears in the status bar.

Inserting text while there is a selection will replace the selection with the inserted text.

When inserting text, keep in mind that theTab andEnter keys might not behave entirely
like you expect because of various indentation features; seeSection 5.4for details.
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The simplest way to delete text is with theBackspaceandDeletekeys. If nothing is
selected, they delete the character before or after the caret, respectively. If a selection
exists, both delete the selection.

More advanced deletion commands are described inSection 4.5, Section 4.6andSection
4.7.

4.4. Undo and Redo
Edit>Undo (shortcut:Control -Z) undoes the effects of the most recent text editing
command. For example, this can be used to restore unintentionally deleted text. More
complicated operations, such as a search and replace, can also be undone. By default, the
undo queue remembers the last 100 edits; older edits are discarded. The undo queue size
can be changed in theEditing pane of theUtilities>Global Options dialog box.

Edit>Redo (shortcut:Control -R) goes forward in the undo queue, redoing changes
which were undone. For example, if some text was inserted,Undo will remove it from
the buffer.Redo will insert it again.

4.5. Working With Words
Holding downControl in addition toLeft or Right moves the caret a word at a time.
Holding downShift andControl in addition toLeft or Right extends the selection a
word at a time.

A single word can be selected by double-clicking with the mouse, or using the
Edit>Text>Select Word command (shortcut:Control -E W). A selection that begins
and ends on word boundaries can be created by double-clicking and dragging.

PressingControl in addition toBackspaceor Deletedeletes the word before or after the
caret, respectively.

Edit>Word Count displays a dialog box with the number of characters, words and lines
in the current buffer.

Edit>Complete Word (shortcut:Control -B) locates possible completions for the word
at the caret, first by looking in the current edit mode’s keyword list, and then searching
the current buffer.
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If there is only one completion, it will be inserted into the buffer immediately. If multiple
completions were found, they will be listed in a popup below the caret position. To insert
a completion from the list, either click it with the mouse, or select it using theUp and
Down keys and pressEnter. To close the popup without inserting a completion, press
Escape. Typing while the popup is visible will automatically update the popup and
narrow the set of completions as necessary.

This feature be used to avoid retyping previously entered identifiers in program source,
for example.

4.6. Working With Lines
An entire line can be selected by triple-clicking with the mouse, or using the
Edit>Text>Select Line command (shortcut:Control -E L ). A selection that begins and
ends on line boundaries can be created by triple-clicking and dragging.

Edit>Go to Line (shortcut:Control -L ) displays an input dialog box and moves the caret
to the specified line number.

Edit>Select Line Range (shortcutControl -E Control -L ) selects all text between
between two specified line numbers, inclusive.

Edit>Text>Join Lines (shortcut:Control -J) removes any whitespace from the start of
the next line and joins it with the current line. For example, invokingJoin Lines on the
first line of the following Java code:

new Widget(Foo
.createDefaultFoo());

Will change it to:

new Widget(Foo.createDefaultFoo());

Edit>Text>Delete Line (shortcut:Control -D) deletes the current line.

Edit>Text>Delete to Start Of Line (shortcut:Control -Shift-Backspace) deletes all
text from the start of the current line to the caret.

Edit>Text>Delete to End Of Line (shortcut:Control -Shift-Delete) deletes all text
from the caret to the end of the current line.
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Edit>Text>Remove Trailing Whitespace (shortcut:Control -E R) removes all
whitespace from the end of each selected line, or the current line if there is no selection.

4.7. Working With Paragraphs
As far as jEdit is concerned, “paragraphs” are delimited by double newlines. This is also
how TeX defines a paragraph. Note that jEdit doesn’t parse HTML files for “<P>” tags,
nor does it support paragraphs delimited only by a leading indent.

Holding downControl in addition toUp or Down moves the caret to the previous and
next paragraph, respectively. As with other caret movement commands, holding down
Shift in addition to the above extends the selection, a paragraph at a time.

Edit>Text>Select Paragraph (shortcut:Control -E P) selects the paragraph containing
the caret.

Edit>Text>Delete Paragraph (shortcut:Control -E D) deletes the paragraph containing
the caret.

Edit>Text>Format Paragraph (shortcut:Control -E F) splits and joins lines in the
current paragraph to make them fit within the wrap column position. SeeSection 4.3for
information and word wrap and changing the wrap column.

4.8. Word Wrap
Theword wrapfeature splits lines of text at word boundaries in order for the text to fit
inside a specified wrap margin. Two wrap modes are available; "soft" and "hard". These
two modes are described below. The wrap margin position is indicated in the text are as a
faint blue vertical line. The wrap mode and wrap column location can be changed in one
of several ways:

• On a global or mode-specific basis in theEditing andMode-Specific panes of the
Utilities>Global Options dialog box; seeSection 6.3.

• In the current buffer for the duration of the editing session in theUtilities>Buffer
Options dialog box; seeSection 6.1.
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• In the current buffer for future editing sessions by placing the following in one of
the first or last 10 lines of the buffer, wheremode is either “soft” or “hard”, and
column is the desired wrap margin position:

:wrap= mode:maxLineLen= column :

4.8.1. Soft Wrap

In soft wrap mode, lines are automatically wrapped when being displayed. No newlines
are inserted, and the wrapping is automatically updated when text is inserted or removed.
If you set the wrap column to zero while soft wrap is enabled, text will be wrapped to the
width of the text area.

If end of line markers are enabled in theText Area pane of theUtilities>Global Options
dialog box, a colon (“:”) is painted at the end of wrapped lines.

4.8.2. Hard Wrap

In hard wrap mode, inserting text at the end of a line beyond the wrap column will
automatically insert a line break at the appropriate word boundary. Existing text is not
changed in any way.

Hard wrap is implemented using character offsets, not screen positions, so it might not
behave like you expect if a proportional-width font is being used. For information about
changing the font used in the text area, seeSection 6.3.

4.9. Scrolling
View>Scrolling>Scroll to Current Line (shortcut:Control -E Control -J) centers the
line containing the caret on the screen.

View>Scrolling>Center Caret on Screen (shortcut:Control -E Control -I ) moves the
caret to the line in the middle of the screen.

View>Scrolling>Line Scroll Up (shortcut:Control -’ ) scrolls the text area up by one
line.
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View>Scrolling>Line Scroll Down (shortcut:Control -/) scrolls the text area down by
one line.

View>Scrolling>Page Scroll Up (shortcut:Alt -’ ) scrolls the text area up by one
screenful.

View>Scrolling>Page Scroll Down (shortcut:Alt -/) scrolls the text area down by one
screenful.

The above scrolling commands differ from the caret movement commands in that they
don’t actually move the caret; they just change the scroll bar position.

View>Scrolling>Synchronized Scrolling is a check box menu item, that if selected,
forces scrolling performed in one text area to be propagated to all other text areas in the
current view. Invoking the command a second time disables the feature.

4.10. Transferring Text
jEdit provides a rich set of commands for moving and copying text. Internally, jEdit
stores text in so-calledregisters. A register is a holding area with a single-character name
that can hold once piece of text at a time. Registers are global to the editor; all buffers
share the same set.

The system clipboard is mapped to a register named$. For convenience, jEdit offers
clipboard-manipulation commands similar to those found in other applications, in
addition to a more flexible set of commands for working with registers directly.

4.10.1. The System Clipboard

Edit>Cut (shortcut:Control -X) places the selected text in the clipboard and removes it
from the buffer.

Edit>Copy (shortcut:Control -C) places the selected text in the clipboard and leaves it
in the buffer.

Edit>Cut Append (shortcut:Control -E Control -U) appends the selected text to the
clipboard, then removes it from the buffer. After this command has been invoked, the
clipboard will consist of the former clipboard contents, followed by a newline, followed
by the selected text.
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Edit>Copy Append (shortcut:Control -E Control -A) appends the selected text to the
clipboard, and leaves it in the buffer. After this command has been invoked, the clipboard
will consist of the former clipboard contents, followed by a newline, followed by the
selected text.

Edit>Paste (shortcut:Control -V) inserts the clipboard contents in place of the selection
(or at the caret position, if there is no selection).

4.10.2. Quick Copy

Quick copy is disabled by default, but it can be enabled in theText Area pane of the
Utilities>Global Options dialog box. When quick copy is enabled:

• Clicking the middle mouse button in the text area inserts the most recently selected
text at the clicked location. If you only have a two-button mouse, you can click the
left mouse button while holding downAlt instead of middle-clicking.

Internally, this is implemented by storing the most recently selected text in the%

register (recall that registers have single-character names).

If jEdit is being run under Java 2 version 1.4 on Unix, you will be able to transfer
text with other X Windows applications using the quick copy feature. On other
platforms and Java versions, the contents of the quick copy register are only
accessible from within jEdit.

• Dragging with the middle mouse button creates a selection without moving the
caret. As soon as the mouse button is released, the selected text is inserted at the
caret position and the selection is deactivated. A message is shown in the status bar
while text is being selected to remind you that this is not an ordinary selection.

4.10.3. General Register Commands

These commands are slightly less convenient to use than the two methods of transferring
text described above, but are more powerful.

These commands all expect a single-character register name to be typed at the keyboard
after the command is invoked, and subsequently operate on that register. Pressing

43



Chapter 4. Editing Text

Escapeinstead of specifying a register name will cancel the operation.

Edit>Registers>Cut to Register (shortcut:Control -R Control -X key ) stores the
selected text in the specified register, removing it from the buffer.

Edit>Registers>Copy to Register (shortcut:Control -R Control -C key ) stores the
selected text in the specified register, leaving it in the buffer.

Edit>Registers>Cut Append to Register (shortcut:Control -R Control -U key ) adds
the selected text to the existing contents of the specified register, and removes it from the
buffer.

Edit>Registers>Copy Append to Register (shortcut:Control -R Control -A key )
adds the selected text to the existing contents of the specified register, without removing
it from the buffer.

Edit>Registers>Paste from Register (shortcut:Control -R Control -V key ) replaces
the selection with the contents of the specified register.

Edit>Paste Previous (shortcut:Control -E Control -V) displays a dialog box listing
recently copied and pasted text. By default, the last 20 strings are remembered; this can
be changed in theGeneral pane of theUtilities>Global Options dialog box; seeSection
6.3.

Edit>Registers>View Registers displays a dialog box for viewing the contents of
registers (including the clipboard).

4.11. Markers
Each buffer can have any number ofmarkersdefined, pointing to specific locations
within that buffer. Each line in a buffer can have at most one marker set pointing to it.
Markers are persistent; they are saved to. filename .marks , wherefilename is the file
name. (The dot prefix makes the markers file hidden on Unix systems.) Marker saving
can be disabled in theLoading and Saving pane of theUtilities>Global Options
dialog box; seeSection 6.3.

Markers are listed in theMarkers menu; selecting a marker from this menu is the
simplest way to return to its location. Each marker can optionally have a single-character
shortcut; markers without a shortcut can only be returned to using the menu, markers
with a shortcut can be accessed more quickly from the keyboard.
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Lines which contain markers are indicated in the gutter with a highlight. Moving the
mouse over the highlight displays a tool tip showing the marker’s shortcut, if it has one.
SeeSection 2.3for information about the gutter.

Markers>Add/Remove Marker (shortcut:Control -E Control -M ) adds a marker
without a shortcut pointing to the current line. If a marker is already set on the current
line, the marker is removed instead. If text is selected, markers are added to the first and
last line of each selection.

Markers>Add Marker With Shortcut (shortcut:Control -T key ) reads the next
character entered at the keyboard, and adds a marker with that shortcut pointing to the
current line. If a previously-defined marker already has that shortcut, it will no longer
have that shortcut, but will remain in the buffer. PressingEscapeinstead of specifying a
marker shortcut after invoking the command will cancel the operation.

Markers>Go to Marker (shortcut:Control -Y key ) reads the next character entered at
the keyboard, and moves the caret to the location of the marker with that shortcut.
PressingEscapeinstead of specifying a marker shortcut after invoking the command
will cancel the operation.

Markers>Select to Marker (shortcut:Control -U key ) reads the next character entered
at the keyboard, and extends the selection to the location of the marker with that shortcut.
PressingEscapeinstead of specifying a marker shortcut after invoking the command
will cancel the operation.

Markers>Swap Caret and Marker (shortcut:Control -U key ) reads the next character
entered at the keyboard, and swaps the position of the caret with the location of the
marker with that shortcut. PressingEscapeinstead of specifying a marker shortcut after
invoking the command will cancel the operation.

Markers>Go to Previous Marker (shortcut:Control -E Control -,) goes to the marker
immediately before the caret position.

Markers>Go to Next Marker (shortcut:Control -E Control -.) goes to the marker
immediately after the caret position.

Markers>Remove All Markers removes all markers set in the current buffer.
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4.12. Search and Replace

4.12.1. Searching For Text

Search>Find (shortcut:Control -F) displays the search and replace dialog box.

The search string can be entered in theSearch for text field. This text field remembers
previously entered strings; seeAppendix Cfor details.

If text was selected in the text area and the selection does not span a line break, the
selected text becomes the default search string.

If the selection consists of multiple lines, theSearch in Selection andHyperSearch
buttons will be pre-selected, and the search string field will be blank.

The search can be made case insensitive (for example, searching for “Hello” will match
“hello”, “HELLO” and “HeLlO”) by selecting theIgnore case check box.

Regular expressions may be used to match inexact sequences of text if theRegular
expressions check box is selected; seeAppendix Efor more information about regular
expressions. Note that regular expressions can only be used when searching forward.

Clicking Find will locate the next (or previous, if searching backwards) occurrence of
the search string after the caret position. If theKeep dialog check box is selected, the
dialog box will remain open; otherwise, it will be closed after the search string is located.

If no occurrences could be found and theAuto wrap check box is selected, the search
will automatically be restarted and a message will be shown in the status bar to indicate
that. If the check box is not selected, a dialog box will be displayed, offering to restart
the search.

Search>Find Next (shortcut:Control -G) locates the next occurrence of the most recent
search string without displaying the search and replace dialog box.

Search>Find Previous (shortcut:Control -H) locates the previous occurrence of the
most recent search string without displaying the search and replace dialog box.

4.12.2. Replacing Text

The replace string text field remembers previously entered strings; seeAppendix Cfor
details.
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Clicking Replace & Find will perform a replacement in the current selection and locate
the next occurrence of the search string. ClickingReplace All will replace all
occurrences of the search string with the replacement string in the current search scope
(which is either the selection, the current buffer, or a set of buffers, as specified in the
search and replace dialog box).

Occurrences of the search string can be replaced with either a replacement string, or the
result of a BeanShell script snippet. Two radio buttons in the search and replace dialog
box can be used to choose between these behaviors, which are described below in more
detail.

4.12.2.1. Text Replace

If the Text radio button is selected, the search string is replaced with the replacement
string.

If regular expressions are enabled, positional parameters ($0, $1, $2, and so on) can be
used to insert the contents of matched subexpressions in the replacement string; see
Appendix Efor more information.

If the search is case-insensitive, jEdit attempts to modify the case of the replacement
string to match that of the particular instance of the search string being replaced. For
example, if you are searching for “label” and replacing it with “text”, then the following
replacements could be made:

• “String label” would become “String text”

• “setLabel” would become “setText”

• “DEFAULT_LABEL” would become “DEFAULT_TEXT”

4.12.2.2. BeanShell Replace

In BeanShell replacement mode, the search string is replaced with the return value of a
BeanShell snippet. The following predefined variables can be referenced in the snippet:

• _0 -- the text to be replaced

• _1 - _9 -- if regular expressions are enabled, these contain the values of matched
subexpressions.
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BeanShell syntax and features are covered in great detail inPart III in jEdit 4.0 User’s
Guide, but here are some examples:

To convert all HTML tags to lower case, search for the following regular expression:

<(.*?)>

Replacing it with the following BeanShell snippet:

"<" + _1.toLowerCase() + ">"

To replace arithmetic expressions between curly braces with their result, search for the
following regular expression:

\{(.+?)\}

Replacing it with the following BeanShell snippet:

eval(_1)

These two examples only scratch the surface; the possibilities are endless.

4.12.3. HyperSearch

If the HyperSearch check box in the search and replace dialog box is selected, clicking
Find will list all occurrences of the search string in the current search scope, instead of
locating them one by one as an ordinary search would.

By default, HyperSearch results are shown in a floating window; the window can be set
to dock into the view in theDocking pane of theUtilities>Global Options dialog box;
seeSection 2.2.1.

Running searches can be stopped in theUtilities>I/O Progress Monitor dialog box.

4.12.4. Multiple File Search

Search and replace commands can be performed in more than one file at a time.

If the All buffers radio button in the search and replace dialog box is selected, all open
buffers whose names match the glob pattern entered in theFilter text field will be
searched. SeeAppendix Dfor more information about glob patterns.
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If the Directory radio button is selected, all files in the directory whose names match the
glob will be searched. The directory to search in can either be entered in theDirectory
text field, or chosen in a file selector dialog box by clickingChoose. If the Search
subdirectories check box is selected, all subdirectories of the specified directory will
also be searched. Keep in mind that searching through directories with many files can
take a long time and consume a large amount of memory.

TheDirectory andFilter text fields remember previously entered strings; seeAppendix
C for details.

Two convenience commands are provided for performing multiple file searches.

Search>Search in Open Buffers (shortcut:Control -E Control -B) displays the search
and replace dialog box, and selects theAll buffers radio button.

Search>Search in Directory (shortcut:Control -E Control -D) displays the search and
replace dialog box, and selects theDirectory radio button.

4.12.5. The Search Bar

The search bar at the top of the view provides a convenient way to perform simple
searches without opening the search and replace dialog box first. Neither multiple file
search nor replacement can be done from the search bar. The search bar remembers
previously entered strings; seeAppendix Cfor details.

Unless theHyperSearch check box is selected, the search bar will perform an
incremental search. In incremental search mode, the first occurrence of the search string
is located in the current buffer as it is being typed. PressingEnter andShift-Enter
searches for the next and previous occurrence, respectively. Once the desired occurrence
has been found, pressEscapeto return keyboard focus to the text area.

If the HyperSearch check box is selected, entering a search string and pressingEnter
will perform a HyperSearch in the current buffer.

Search>Incremental Search (shortcut:Control -,) moves keyboard focus to the search
bar. If text is selected when this command is invoked, the selection is inserted into the
search bar automatically.

Search>Quick HyperSearch (shortcut:Control -.) moves keyboard focus to the search
bar and pre-selects theHyperSearch check box. If text is selected when this command
is invoked, a HyperSearch for that text is performed immediately.
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TheSearch>Incremental Search for Word (shortcut:Alt -,) andSearch>Quick
HyperSearch for Word (shortcut:Alt -.) commands perform an incremental search and
HyperSearch, respectively, for the word under the caret.

The search bar can be disabled in theGeneral pane of theUtilities>Global Options
dialog box.

Note: Incremental searches cannot be not recorded in macros. Use the search and
replace dialog box instead. See Chapter 7 for information about macros.
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5.1. Edit Modes
An edit modespecifies syntax highlighting rules, auto indent behavior, and various other
customizations for editing a certain file type. This section only covers using and
selecting edit modes; information about writing your own can be found inPart II in jEdit
4.0 User’s Guide.

5.1.1. Mode Selection

When a file is opened, jEdit first checks the file name against a list of known patterns.
For example, files whose names end with “.c” are edited in C mode, and files named
Makefile are edited in Makefile mode. If a suitable match based on file name cannot be
found, jEdit checks the first line of the file. For example, files whose first line is
“#!/bin/sh” are edited in shell script mode.

File name and first line globs can be changed in theMode-Specific pane of the
Utilities>Global Options dialog box (seeSection 6.3).

If automatic mode selection is not appropriate, the edit mode can be specified manually.
The current buffer’s edit mode can be set on a one-time basis in theUtilities>Buffer
Options dialog box; seeSection 6.1. To set a buffer’s edit mode for future editing
sessions, place the following in one of the first or last 10 lines of the buffer, whereedit
mode is the name of the desired edit mode:

:mode= edit mode :

A list of edit modes can be found in theUtilities>Buffer Options dialog box.

5.1.2. Syntax Highlighting

Syntax highlighting is the display of programming language tokens using different fonts
and colors. This makes code easier to follow and errors such as misplaced quotes easier
to spot. All edit modes except for the plain text mode perform syntax highlighting.
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The colors and styles used to highlight syntax tokens can be changed in theStyles pane
of theUtilities>Global Options dialog box; seeSection 6.3.

5.2. Abbreviations
Using abbreviations reduces the time spent typing long but commonly used strings. For
example, in Java mode, the abbreviation “sout” is defined to expand to
“System.out.println()”, so to insert “System.out.println()” in a Java buffer, you only need
to type “sout” followed byControl -;. Each abbreviation can either be global, in which
case it will expand in all edit modes, or mode-specific. Abbreviations can be edited in the
Abbreviations pane of theUtilities>Global Options dialog box; seeSection 6.3. The
Java, VHDL and XSL edit modes include some pre-defined abbreviations you might find
useful.

Edit>Expand Abbreviation (keyboard shortcut:Control -;) attempts to expand the word
before the caret. If no expansion could be found, it will offer to define one.

Automatic abbreviation expansion can be enabled in theAbbreviations pane of the
Utilities>Global Options dialog box; seeSection 6.3. If enabled, pressing the space bar
after entering an abbreviation will automatically expand it.

If automatic expansion is enabled, a space can be inserted without expanding the word
before the caret by pressingControl -E V Space.

5.2.1. Positional Parameters

Positional parameters are an advanced feature that make abbreviations much more
useful. The best way to describe them is with an example.

Suppose you have an abbreviation “F” that is set to expand to the following:

for(int $1 = 0; $1 < $2; $1++)

Now, simply entering “F” in the buffer and expanding it will insert the above text as-is.
However, if you expandF#j#array.length# , the following will be inserted:

for(int j = 0; j < array.length; j++)
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Expansions can contain up to nine positional parameters. Note that a trailing hash
character (“#”) must be entered when expanding an abbreviation with parameters.

5.3. Bracket Matching
Misplaced and unmatched brackets are one of the most common syntax errors
encountered when writing code. jEdit has several features to make brackets easier to deal
with.

Positioning the caret immediately after a bracket will highlight the corresponding closing
or opening bracket (assuming it is visible) and draw a scope indicator in the gutter. If the
highlighted bracket is not visible, the text of the matching line will be shown in the status
bar. If the matching line consists of only whitespace and the bracket itself, theline before
is shown instead. This feature is very useful for code with brackets indented like so:

public void someMethod()
{

if(isOK)
{

doSomething();
}

}

InvokingEdit>Source Code>Go to Matching Bracket (shortcut:Control -]), or
clicking the scope indicator in the gutter moves the caret to the highlighted bracket.

Edit>Source Code>Select Code Block (shortcut:Control -[) selects all text between
the two brackets surrounding the caret.

Holding downControl while clicking the scope indicator or a bracket in the text area
will select all text between the two matching brackets.

Edit>Source Code>Go to Previous Bracket (shortcut:Control -E [) moves the caret
to the previous opening bracket.

Edit>Source Code>Go to Next Bracket (shortcut:Control -E ]) moves the caret to the
next closing bracket.

Bracket highlighting for the text area and gutter, respectively, can be disabled in theText
Area andGutter panes of theUtilities>Global Options dialog box; seeSection 6.3.
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Note: jEdit’s bracket matching algorithm only checks syntax tokens with the same
type as the original bracket for matches. So brackets inside string literals and
comments will not cause problems, as they will be skipped.

5.4. Tabbing and Indentation
jEdit makes a distinction between thetab width, which is is used when displaying tab
characters, and theindent width, which is used when a level of indent is to be added or
removed, for example by mode-specific smart indent routines. Both can be changed in
one of several ways:

• On a global or mode-specific basis inEditing andMode-Specific panes of the the
Utilities>Global Options dialog box.

• In the current buffer for the duration of the editing session in theUtilities>Buffer
Options dialog box; seeSection 6.1.

• In the current buffer for future editing sessions by placing the following in one of
the first or last 10 lines of the buffer, wheren is the desired tab width, andmis the
desired indent width:

:tabSize= n:indentSize= m:

Edit>Source Code>Shift Indent Left (shortcut:Shift-Tab or Alt -Left ) adds one level
of indent to each selected line, or the current line if there is no selection.

Edit>Source Code>Shift Indent Right (shortcut:Alt -Right) removes one level of
indent from each selected line, or the current line if there is no selection. PressingTab
while a multi-line selection is active has the same effect.

5.4.1. Soft Tabs

Because files indented using tab characters may look less than ideal when viewed on a
system with a different default tab size, it is sometimes desirable to use multiple spaces,
known assoft tabs, instead of real tab characters, to indent code.

Soft tabs can be enabled or disabled in one of several ways:
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• On a global or edit mode-specific basis in theEditing andMode-Specific panes of
theUtilities>Global Options dialog box.

• In the current buffer for the duration of the editing session in theUtilities>Buffer
Options dialog box; seeSection 6.1.

• In the current buffer for future editing sessions by placing the following in one of
the first or last 10 lines of the buffer, whereflag is either “true” or “false”:

:noTabs= flag :

Changing the soft tabs setting has no effect on existing tab characters; it only affects
subsequently-inserted tabs.

Edit>Source>Spaces to Tabs converts soft tabs to hard tabs in the current selection, or
the entire buffer if nothing is selected.

Edit>Source>Tabs to Spaces converts hard tabs to soft tabs in the current selection, or
the entire buffer if nothing is selected.

5.4.2. Automatic Indent

The auto indent feature inserts the appropriate number of tabs or spaces at the beginning
of a line.

If indent on enter is enabled, pressingEnter will create a new line with the appropriate
amount of indent automatically. If indent on tab is enabled, pressingTab at the
beginning of, or inside the leading whitespace of, a line will insert the appropriate
amount of indentation. Pressing it again will insert a tab character.

By default, both indent on enter and indent on tab is enabled. This can be changed in one
of several ways:

• On a global or mode-specific basis in theEditing andMode-Specific panes of the
Utilities>Global Options dialog box.

• In the current buffer for the duration of the editing session in theUtilities>Buffer
Options dialog box; seeSection 6.1.

• In the current buffer for future editing sessions by placing the following in the first
or last 10 lines of a buffer, whereflag is either “true” or “false”:
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:indentOnEnter= flag :indentOnTab= flag :

Auto indent behavior is mode-specific. In most edit modes, the indent of the previous
line is simply copied over. However, in C-like languages (C, C++, Java, JavaScript),
curly brackets and language statements are taken into account and indent is added and
removed as necessary.

Edit>Source Code>Indent Selected Lines (shortcut:Control -I ) indents all selected
lines, or the current line if there is no selection.

To insert a literal tab or newline without performing indentation, prefix the tab or
newline withControl -E V. For example, to create a new line without any indentation,
typeControl -E V Enter .

5.5. Commenting Out Code
Most programming and markup languages support “comments”, or regions of code
which are ignored by the compiler/interpreter. jEdit has commands which make inserting
comments more convenient.

Comment strings are mode-specific, and modes such as HTML where different parts of a
buffer can have different comment strings (for example, in HTML text and inline
JavaScript) are handled correctly.

Edit>Source Code>Range Comment (shortcut:Control -E Control -C) encloses the
selection with comment start and end strings, for example/* and*/ in Java mode.

Edit>Source Code>Line Comment (shortcut:Control -E Control -K ) inserts the line
comment string, for example// in Java mode, at the start of each selected line.

5.6. Folding
Program source code and other structured text files can be thought of as a hierarchy of
sections, which themselves might contain sub-sections. The folding feature lets you
selectively hide and show these sections, replacing hidden ones with a single line that
serves as an “overview” of that section.
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Folding is disabled by default. To enable it, you must choose one of the two available
“folding modes”. “Indent” mode creates folds based on a line’s leading whitespace; the
more leading whitespace a block of text has, the further down it is in the hierarchy. For
example:

This is a section
This is a sub-section
This is another sub-section

This is a sub-sub-section
Another top-level section

“Explicit” mode folds away blocks of text surrounded with “{{{” and “}}}”. For
example:

{{{ The first line of a fold.
When this fold is collapsed, only the above line will be visible.

{{{ A sub-section.
With text inside it.
}}}

{{{ Another sub-section.
}}}

}}}

Both modes have distinct advantages and disadvantages; indent folding requires no
changes to be made to a buffer’s text and does a decent job with most program source.
Explicit folding requires “fold markers” to be inserted into the text, but is more flexible
in exactly what to fold away.

Folding can be enabled in one of several ways:

• On a global or mode-specific basis in theEditing andMode-Specific panes of the
Utilities>Global Options dialog box.

• In the current buffer for the duration of the editing session in theUtilities>Buffer
Options dialog box; seeSection 6.1.

• In the current buffer for future editing sessions by placing the following in the first
or last 10 lines of a buffer, wheremode is either “indent” or “explicit”:

:folding= mode:
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Warning
When using indent folding, portions of the buffer may become
inaccessible if you change the leading indent of the first line of a
collapsed fold. If you experience this, you will need to use the Expand
All Folds command to make the text visible again.

5.6.1. Collapsing and Expanding Folds

The first line of each fold has a triangle drawn next to it in the gutter (seeSection 2.3for
more information about the gutter). The triangle points toward the line when the fold is
collapsed, and downward when the fold is expanded. Clicking the triangle collapses and
expands the fold. To expand all sub-folds as well, hold down theShift while clicking.

The first line of a collapsed fold is also drawn with a different background color, and the
number of lines in the fold is shown to the right of the line’s text.

Folds can also be collapsed and expanded using menu item commands and keyboard
shortcuts.

Folding>Collapse Fold (keyboard shortcut:Alt -Backspace) collapses the fold
containing the caret position.

Folding>Expand Fold One Level (keyboard shortcut:Alt -Enter) expands the fold
containing the caret position. Nested folds will remain collapsed, and the caret is
positioned on the first nested fold (if any).

Folding>Expand Fold Fully (keyboard shortcut:Alt -Shift-Enter) expands the fold
containing the caret position, also expanding any nested folds.

Folding>Collapse All Folds (keyboard shortcut:Control -E C) collapses all folds in the
buffer.

Folding>Expand All Folds (keyboard shortcut:Control -E X) expands all folds, thus
making all lines in the buffer visible.
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5.6.2. Navigating Around With Folds

Folding>Go to Parent Fold (keyboard shortcut:Alt -Up) moves the caret to the fold
containing the one at the caret position.

Folding>Go to Previous Fold (keyboard shortcut:Alt -Up) moves the caret to the fold
immediately before the caret position.

Folding>Go to Next Fold (keyboard shortcut:Alt -Up) moves the caret to the fold
immediately after the caret position.

5.6.3. Miscellaneous Folding Commands

Folding>Add Explicit Fold (keyboard shortcut:Control -E A) is a convenience
command that surrounds the selection with “{{{” and “}}}”. If the current buffer’s edit
mode defines comment strings (seeSection 5.5) the explicit fold markers will
automatically be commented out as well.

Folding>Select Fold (keyboard shortcut:Control -E S) selects all lines within the fold
containing the caret position.Control -clicking a fold expansion triangle in the gutter has
the same effect.

Folding>Expand Folds With Level (keyboard shortcut:Control -E Enter key ) reads
the next character entered at the keyboard, and expands folds in the buffer with a fold
level less than that specified, while collapsing all others.

You can have all folds with a fold level higher than that specified be collapsed
automatically when a buffer is loaded. This can be configured as follows:

• On a global or mode-specific basis in theEditing andMode-Specific panes of the
Utilities>Global Options dialog box.

• In the current buffer for future editing sessions by placing the following in the first
or last 10 lines of a buffer, wherelevel is the desired fold level:

:collapseFolds= level :
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5.6.4. Narrowing

The narrowing feature temporarily “narrows” the display of a buffer to a specified
region. Text outside the region is not shown, but is still present in the buffer. Both folding
and narrowing are implemented using the same code internally.

Folding>Narrow Buffer to Fold (keyboard shortcut:Control -E N N) hides all lines the
buffer except those in the fold containing the caret. When this command is invoked, a
message is shown in the status bar reminding you that you need to invokeExpand All
Folds to make the rest of the buffer visible again.

Folding>Narrow Buffer to Selection (keyboard shortcut:Control -E N S) hides all
lines the buffer except those in the selection.

Folding>Expand All Folds (keyboard shortcut:Control -E X) will make visible any
lines hidden by narrowing.
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6.1. The Buffer Options Dialog Box
Utilities>Buffer Options displays a dialog box for changing editor settings on a
per-buffer basis. Any changes made in this dialog box are lost after the buffer is closed.

The following settings may be changed here:

• The line separator (seeSection 3.4)

• The character encoding (seeSection 3.5)

• If the file should be GZipped on disk (seeSection 3.2)

• If the file should be saved with a trailing line break

• The edit mode (seeSection 5.1)

• The fold mode (seeSection 5.6)

• The wrap mode and margin (seeSection 4.8)

• The tab width (seeSection 5.4)

• The indent width

• If auto indent and soft tabs should be enabled (seeSection 5.4)

6.2. Buffer-Local Properties
Buffer-local properties provide an alternate way to change editor settings on a per-buffer
basis. While changes made in the Buffer Options dialog box are lost after the buffer is
closed, buffer-local properties take effect each time the file is opened, because they are
embedded in the file itself.

When jEdit loads a file, it checks the first and last 10 lines for colon-enclosed name/value
pairs. The following example changes the indent width to 4 characters, enables soft tabs,
and sets the buffer’s edit mode to Perl:

:indentSize=4:noTabs=true:mode=perl:
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Note that adding buffer-local properties to a buffer only takes effect after the next time
the buffer is loaded.

The following table describes each buffer-local property in detail.

Property name Description
collapseFolds Folds with a level of this or higher will be collapsed when the

buffer is opened. If set to zero, all folds will be expanded
initially. SeeSection 5.6.

folding The fold mode; one of “none”, “indent”, or “explicit”. See
Section 5.6.

indentOnEnter If set to “true”, pressingEnter will insert a line break and
automatically indent the new line. SeeSection 5.4.

indentOnTab If set to “true”, indentation will be performed when theTab
key is pressed. SeeSection 5.4.

indentSize The width, in characters, of one indent. Must be an integer
greater than 0. SeeSection 5.4.

maxLineLen The maximum line length and wrap column position. Inserting
text beyond this column will automatically insert a line break
at the appropriate position. SeeSection 4.3.

mode The default edit mode for the buffer. SeeSection 5.1.

noTabs If set to “true”, soft tabs (multiple space characters) will be
used instead of “real” tabs. SeeSection 5.4.

noWordSep A list of non-alphanumeric characters that arenot to be treated
as word separators. Global default is “_”.

tabSize The tab width. Must be an integer greater than 0. SeeSection
5.4.

wordBreakChars Characters, in addition to spaces and tabs, at which lines may
be split when word wrapping. SeeSection 4.3.

wrap The word wrap mode; one of “none”, “soft”, or “hard”. See
Section 4.8.

6.3. The Global Options Dialog Box
Utilities>Global Options displays the global options dialog box. The dialog box is
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divided into several panes, each pane containing a set of related options. Use the list on
the left of the dialog box to switch between panes. Only panes created by jEdit are
described here; some plugins add their own option panes, and information about them
can be found in the documentation for the plugins in question.

The General Pane

TheGeneral option pane lets you change various miscellaneous settings, such as the
number of recent files to remember, if the buffer list should be sorted, and so on.

The Appearance Pane

TheAppearance option pane lets you change the Swing look and feel, as well as the
fonts used to display user interface controls such as buttons, labels and menus.

The Loading and Saving Pane

TheLoading and Saving option pane lets you change settings such as the autosave
frequency, backup settings, file encoding, and so on.

The Editing Pane

TheEditing option pane lets you change settings such as the tab size, syntax highlighting
and soft tabs on a global basis.

Due to the design of jEdit’s properties implementation, changes to some settings in this
option pane only take effect in subsequently opened files.

The Mode-Specific Pane

TheMode-Specific option pane lets you change settings such as the tab size, syntax
highlighting and soft tabs on a mode-specific basis.

TheFile name glob andFirst line glob text fields let you specify a glob pattern that
names and first lines of buffers will be matched against to determine the edit mode.

This option pane does not change XML mode definition files on disk; it merely writes
values to the user properties file which override those in mode files. To find out how to
edit mode files directly, seePart II in jEdit 4.0 User’s Guide.

The Text Area Pane

TheText Area option pane lets you customize the appearance of the text area.
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The Gutter Pane

TheGutter option pane lets you customize the appearance of the gutter.

The Colors Pane

TheColors option pane lets you change the text area’s color scheme.

The Styles Pane

TheStyles option pane lets you change the text styles and colors used for syntax
highlighting.

The Docking Pane

TheDocking option pane lets you specify which dockable windows should be floating,
and which should be docked in the view.

The Context Menu Pane

TheContext Menu option pane lets you edit the text area’s right-click context menu.

The Tool Bar Pane

TheTool Bar option pane lets you edit the tool bar, or disable it completely.

The Shortcuts Pane

TheShortcuts option pane let you change keyboard shortcuts. Each command can have
up to two shortcuts associated with it.

The combo box at the top of the option pane selects the shortcut set to edit (command,
plugin or macro shortcuts).

To change a shortcut, click the appropriate table entry and press the keys you want
associated with that command in the resulting dialog box. The dialog box will warn you
if the shortcut is already assigned.

The Abbreviations Pane

TheAbbreviations option pane lets you enable or disable automatic abbreviation
expansion, and edit currently defined abbreviations.

The combo box labeled “Abbrev set” selects the abbreviation set to edit. The first entry,
“global”, contains abbreviations available in all edit modes. The subsequent entries
contain mode-specific abbreviations.
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To change an abbreviation or its expansion, either double-click the appropriate table
entry, or click a table entry and then click theEdit button. This will display a dialog box
for modifying the abbreviation.

TheAdd button displays a dialog box where you can define a new abbreviation. The
Remove button removes the currently selected abbreviation from the list.

SeeSection 5.2.1for information about positional parameters in abbreviations.

The Printing Pane

ThePrinting option pane lets you customize the appearance of printed output.

The File System Browser Panes

TheFile System Browser branch contains two option panes,General andColors.
Both of these option panes should be self-explanatory. SeeSection 3.6for more
information.

6.4. The jEdit Settings Directory
jEdit stores all settings, macros, and so on as files inside itssettings directory. In most
cases, editing these files is not necessary, since graphical tools and commands can do the
job. However, being familiar with the structure of the settings directory still comes in
handy in certain situations, for example when you want to copy jEdit settings between
computers.

The location of the settings directory is system-specific; it is printed to the activity log
(Utilities>Activity Log). For example:

[message] jEdit: Settings directory is /home/slava/.jedit

Specifying the-settingsswitch on the command line instructs jEdit to store settings in a
different directory. For example, the following command will instruct jEdit to store all
settings in thejedit subdirectory of theC: drive:

C:\jedit> jedit -settings=C:\jedit

The-nosettingsswitch will force jEdit to not look for or create a settings directory.
Default settings will be used instead.
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If you are using jEditLauncher to start jEdit on Windows, these parameters cannot be
specified on the MS-DOS prompt command line when starting jEdit; they must be set as
described inSection G.2.

jEdit creates the following files and directories inside the settings directory; plugins may
add more:

• abbrevs - a plain text file which stores all defined abbreviations. SeeSection 5.2.

• activity.log - a plain text file which contains the full activity log. SeeAppendix
B.

• history - a plain text file which stores history lists, used by history text fields and
theEdit>Paste Previous command. SeeSection 4.10andAppendix C.

• jars - this directory contains plugins. SeeChapter 8.

• macros - this directory contains macros. SeeChapter 7.

• modes - this directory contains custom edit modes. SeePart II in jEdit 4.0 User’s
Guide.

• PluginManager.download - this directory is usually empty. It only contains files
while the plugin manager is downloading a plugin. For information about the plugin
manager, seeChapter 8.

• properties - a plain text file which stores the majority of jEdit’s settings.

• recent.xml - an XML file which stores the list of recently opened files. jEdit
remembers the caret position, selection state and character encoding of each recent
file, and automatically restores those values when one of the files in the list is
opened.

• server - a plain text file that only exists while jEdit is running. The edit server’s
port number and authorization key is stored here. SeeChapter 1.

• session - a list of files, used when restoring previously open files on startup.

• settings-backups - this directory contains numbered backups of all
automatically-written settings files (abbrevs , activity.log , history ,
properties , recent.xml , andsession ).
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Macros in jEdit are short scripts written in a scripting language calledBeanShell. They
provide an easy way to automate repetitive keyboard and menu procedures, as well as
access to the objects and methods created by jEdit. Macros also provide a powerful
facility for customizing jEdit and automating complex text processing and programming
tasks. In this section we describe how to record and run macros. A detailed guide on
writing macros appears later in a separate part of the user’s guide; seePart III in jEdit 4.0
User’s Guide.

7.1. Recording Macros
The simplest use of macros is to record a series of key strokes and menu commands as a
BeanShell script, and play them back at a later time. While this doesn’t let you take
advantage of the full power of BeanShell, it is still a great time saver and can even be
used to “prototype” more complicated macros.

Macros>Record Macro (shortcut:Control -M Control -R) prompts for a macro name
and begins recording.

While recording is in progress, the string “Macro recording” is displayed in the status
bar. jEdit records the following:

• Key strokes

• Menu item commands

• Tool bar clicks

• All search and replace operations except incremental search

Mouse clicks in the text area arenot recorded; to record the equivalent of mouse
operations, use the text selection commands or arrow keys.

Macros>Stop Recording (shortcut:Control -M Control -S) stops recording. It also
switches to the buffer containing the recorded macro, giving you a chance to check over
the recorded commands and make any necessary changes. The file name extension.bsh

is automatically appended to the macro name, and all spaces are converted to underscore
characters, in order to make the macro name a valid file name. These two operations are
reversed when macros are displayed in theMacros menu. SeeSection 7.3for details.
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When you are happy with the macro, save the buffer and it will appear in theMacros
menu. To discard the macro, close the buffer without saving it.

If a complicated operation only needs to be repeated a few times, using the temporary
macro feature is quicker than saving a new macro file.

Macros>Record Temporary Macro (shortcut:Control -M Control -M ) begins
recording to a buffer namedTemporary_Macro.bsh . Once recording of a temporary
macro is complete, jEdit does not display the buffer containing the recorded commands,
but the nameTemporary_Macro.bsh will be visible on any list of open buffers. By
switching to that buffer, you can view the commands, edit them, and save them if you
wish to a permanent macro file. Whether or not you look at or save the temporary macro
contents, it is immediately available for playback.

Macros>Run Temporary Macro (shortcut:Control -M Control -P) plays the macro
recorded to theTemporary_Macro.bsh buffer.

Only one temporary macro is available at a time. If you begin recording a second
temporary macro, the first is erased and cannot be recovered unless you have saved the
contents to a file with a name other thanTemporary_Macro.bsh . If you do not save the
temporary macro, you must keep the buffer containing the macro script open during your
jEdit session. To have the macro available for your next jEdit session, save the buffer
Temporary_Macro.bsh as an ordinary macro with a descriptive name of your choice.
The new name will then be displayed in theMacros menu.

7.2. Running Macros
Macros supplied with jEdit, as well as macros that you record or write, are displayed
under theMacros menu in a hierarchical structure. The jEdit installation includes about
30 macros divided into several major categories. Each category corresponds to a nested
submenu under theMacros menu. An index of these macros containing short
descriptions and usage notes is found inAppendix F.

There is a very large collection of additional macros available at the jEdit community
(http://community.jedit.org) web site in the “Downloads” section. The collection
includes macros distributed with earlier versions of jEdit as well as many macros
contributed by members of the jEdit development team and other users. There are
detailed descriptions for each entry as well as a search facility.
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To run a macro, choose theMacros menu, navigate through the hierarchy of submenus,
and select the name of the macro to execute. You can also assign execution of a
particular macro to a keyboard shortcut, toolbar button or context menu using theMacro
Shortcuts, Tool Bar or Context Menu panes of theUtilities>Global Options dialog;
seeSection 6.3.

Macros>Run Last Macro (shortcut:Control -M Control -L ) runs the last macro run by
jEdit again.

XInsert plugin

The XInsert plugin has a feature that lists the title of macros, organized by
subdirectories, as part of its tree list display. Clicking on the leaf of the tree
corresponding to a macro name causes jEdit to execute the macro immediately.
The plugin allows you to keep a list of macros and cut-and-paste text fragments
available while editing without opening menus. For information about installing
plugins, seeChapter 8.

7.3. How jEdit Organizes Macros
Every macro, whether or not you originally recorded it, is stored on disk and can be
edited as a text file. The file name of a macro must have a.bsh extension in order for
jEdit to be aware of it. By default, jEdit associates a.bsh file with the BeanShell edit
mode for purposes of syntax highlighting, indentation and other formatting. However,
BeanShell syntax does not impose any indentation or line break requirements.

TheMacros menu lists all macros stored in two places: themacros subdirectory of the
jEdit install directory, and themacros subdirectory of the user-specific settings directory
(seeSection 6.4for information about the settings directory). Any macros you record
will be stored in the user-specific directory.

Macros stored elsewhere can be run using theMacros>Run Other Macro command,
which displays a file chooser dialog box, and runs the specified file.

The listing of individual macros in theMacros menu can be organized in a hierarchy
using subdirectories in the general or user-specific macro directories; each subdirectory
appears as a submenu. You will find such a hierarchy in the default macro set included
with jEdit.
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When jEdit first loads, it scans the designated macro directories and assembles a listing
of individual macros in theMacros menu. When scanning the names, jEdit will delete
underscore characters and the.bsh extension for menu labels, so that
List_Useful_Information.bsh , for example, will be displayed in theMacros menu
asList Useful Information.

Macros>Browse System Macros displays themacros subdirectory of the directory in
which jEdit is installed in the file system browser.

Macros>Browse User Macros displays themacros subdirectory of the user settings
directory in the file system browser.

Macros can be opened and edited much like ordinary files from the file system browser.
Editing macros from within jEdit will automatically update the macros menu; however,
if you modify macros from another program or add macro files to the macro directories,
you should run theMacros>Rescan Macros command to update the macro list.
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A plugin is an application which is loaded and runs as part of another, host application.
Plugins respond to user commands and perform tasks that supplement the host
application’s features.

This chapter covers installing, updating and removing plugins. Documentation for the
plugins themselves can be found inHelp>jEdit Help, and information about writing
plugins can be found inPart IV in jEdit 4.0 User’s Guide.

8.1. The Plugin Manager
Plugins>Plugin Manager displays the plugin manager window. The plugin manager
lists all installed plugins; clicking on a plugin in the list will display information about it.

To remove plugins, select them (multiple plugins can be selected by holding down
Control ) and clickRemove Plugins. This will display a confirmation dialog box first.

8.2. Installing Plugins
Plugins can be installed in two ways; manually, and from the plugin manager. In most
cases, plugins should be installed from the plugin manager. It is easier and more
convenient.

To install plugins manually, go to http://plugins.jedit.org in a web browser and follow the
directions on that page.

To install plugins from the plugin manager, make sure you are connected to the Internet
and click theInstall Plugins button in the plugin manager window. The plugin manager
will then download information about available plugins from the jEdit web site, and
present a list of plugins compatible with your jEdit release which may be installed.

Click on a plugin in the list to see some information about it. To select plugins for
installation, click the check box next to their names in the list.
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TheTotal download size field shows the total size of all plugins chosen for installation,
along with any plugins that will be automatically downloaded in order to fulfill
dependencies. TheDownload size field in the plugin information area only shows the
size of the currently selected plugin.

TheInstall source code check box controls if source code for the plugins should be
downloaded and installed. Unless you are a developer, you probably don’t need the
source.

The two radio buttons select the location where the plugins are to be installed. Plugins
can be installed in either thejars subdirectory of the jEdit installation directory, or the
jars subdirectory of the user-specific settings directory. For information about the
settings directory,Section 6.4.

Once you have specified plugins to install, clickInstall Plugins to begin the download
process. Once all plugins have been downloaded and installed, a dialog box is shown
advising that jEdit must be restarted before plugins can be used.

Firewalls

If you are connected to the Internet through a firewall or proxy, you will need to
enter the proxy host (and username and password, if necessary) in theFirewall
pane of theUtilities>Global Options dialog box.

8.3. Updating Plugins
Clicking Update Plugins in the plugin manager will show a dialog box very similar to
the one for installing plugins. It will list plugins for which updated versions are available.
It will also offer to delete any obsolete plugins.
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This appendix documents the default set of keyboard shortcuts. They can be customized
to suit your taste in theShortcuts pane of theUtilities>Global Options dialog box; see
Section 6.3.

Files
For details, seeSection 2.1, Section 2.2andChapter 3.

Control -N New file.

Control -O Open file.

Control -W Close buffer.

Control -E Control -W Close all buffers.

Control -S Save buffer.

Control -E Control -S Save all buffers.

Control -P Print buffer.

Control -Page Up Go to previous buffer.

Control -Page Down Go to next buffer.

Control -‘ Go to recent buffer.

Control -Q Exit jEdit.

Views
For details, seeSection 2.2.

Control -E Control -T Turn gutter (line numbering) on and off.

Control -2 Split view horizontally.

Control -3 Split view vertically.

Control -1 Unsplit.

Alt -Page Up Go to previous text area.

Alt -Page Down Go to next text area.

Control -E 1; 2; 3; 4 Close top; bottom; left; right docking area.
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Repeating
For details, seeSection 2.4.

Control -Enter number
command

Repeat the command (it can be a keystroke, menu
item selection or tool bar click) the specified
number of times.

Moving the Caret
For details, seeSection 4.1, Section 4.5, Section 4.6, Section 4.7andSection 5.3.

Arrow Move caret one character or line.

Control -Arrow Move caret one word or paragraph.

Page Up; Page Down Move caret one screenful.

Home First non-whitespace character of line, beginning of
line, first visible line (repeated presses).

End Last non-whitespace character of line, end of line,
last visible line (repeated presses).

Control -Home Beginning of buffer.

Control -End End of buffer.

Control -] Go to matching bracket.

Control -E Control -[;
Control -]

Go to previous; next bracket.

Control -L Go to line.

Selecting Text
For details, seeSection 4.2, Section 4.5, Section 4.6, Section 4.7andSection 5.3.

Shift-Arrow Extend selection by one character or line.

Control -Shift-Arrow Extend selection by one word or paragraph.

Shift-Page Up; Shift-Page
Down

Extend selection by one screenful.
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Shift-Home Extend selection to first non-whitespace character
of line, beginning of line, first visible line (repeated
presses).

Shift-End Extend selection to last non-whitespace character of
line, end of line, last visible line (repeated presses).

Control -Shift-Home Extend selection to beginning of buffer.

Control -Shift-End Extend selection to end of buffer.

Control -[ Select code block.

Control -E W; L ; P Select word; line; paragraph.

Control -E Control -L Select line range.

Control -\ Switch between single and multiple selection mode.

Scrolling
For details, seeSection 2.2.

Control -E Control -J Center current line on screen.

Control -E Control -I Center caret on screen.

Control -’ ; Control -/ Scroll up; down one line.

Alt -’ ; Alt -/ Scroll up; down one page.

Text Editing
For details, seeSection 4.4, Section 4.3, Section 4.5, Section 4.6andSection 4.7.

Control -Z Undo.

Control -E Control -Z Redo.

Backspace; Delete Delete character before; after caret.

Control -Backspace;
Control -Delete

Delete word before; after caret.

Control -D; Control -E D Delete line; paragraph.

Control -Shift-Backspace;
Control -Shift-Delete

Delete from caret to beginning; end of line.

Control -E R Remove trailing whitespace from the current line
(or all selected lines).
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Control -J Join lines.

Control -B Complete word.

Control -E F Format paragraph (or selection).

Clipboard and Registers
For details, seeSection 4.10.

Control -X Cut selected text to clipboard.

Control -C Copy selected text to clipboard.

Control -E Control -U Append selected text to clipboard, removing it from
the buffer.

Control -E Control -A Append selected text to clipboard, leaving it in the
buffer.

Control -V Paste clipboard contents.

Control -R Control -X key Cut selected text to registerkey .

Control -R Control -C key Copy selected text to registerkey .

Control -R Control -U key Append selected text to registerkey , removing it
from the buffer.

Control -R Control -A key Append selected text to registerkey , leaving it in
the buffer.

Control -R Control -V key Paste contents of registerkey .

Control -E Control -V Paste previous.

Markers
For details, seeSection 4.11.

Control -E Control -M If current line doesn’t contain a marker, one will be
added. Otherwise, the existing marker will be
removed. Use theMarkers menu to return to
markers added in this manner.

Control -T key Add marker with shortcutkey .

Control -Y key Go to marker with shortcutkey .

Control -U key Select to marker with shortcutkey .
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Control -K key Go to marker with shortcutkey , and move the
marker to the previous caret position.

Control -E Control -,;
Control -.

Move caret to previous; next marker.

Search and Replace
For details, seeSection 4.12.

Control -F Open search and replace dialog box.

Control -G Find next.

Control -H Find previous.

Control -E Control -B Search in open buffers.

Control -E Control -D Search in directory.

Control -E Control -R Replace in selection.

Control -E Control -G Replace in selection and find next.

Control -, Incremental search.

Control -. Quick HyperSearch.

Alt -, Incremental search for word under the caret.

Alt -. Quick HyperSearch for word under the caret.

Source Code Editing
For details, seeSection 5.2, Section 5.4andSection 5.5.

Control -; Expand abbreviation.

Alt -Left ; Alt -Right Shift current line (or all selected lines) left; right.

Shift-Tab; Tab Shift selected lines left; right. Note that pressing
Tab with no selection active will insert a tab
character at the caret position.

Control -I Indent current line (or all selected lines).

Control -E Control -C Wing comment selection.

Control -E Control -B Box comment selection.
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Folding and Narrowing
For details, seeSection 5.6andSection 5.6.4.

Alt -Backspace Collapse fold containing caret.

Alt -Enter Expand fold containing caret one level only.

Alt -Shift-Enter Expand fold containing caret fully.

Control -E X Expand all folds.

Control -E A Add explicit fold.

Control -E S Select fold.

Control -E Enter key Expand folds with level less thankey , collapse all
others.

Control -E N N Narrow to fold.

Control -E N S Narrow to selection.

Alt -Up Alt -Down Moves caret to previous; next fold.

Control -E U Moves caret to the fold containing the one at the
caret position.

Macros
For details, seeChapter 7.

Control -M Control -R Record macro.

Control -M Control -M Record temporary macro.

Control -M Control -S Stop recording.

Control -M Control -P Run temporary macro.

Control -M Control -L Run most recently played or recorded macro.

Alternative Shortcuts
A few frequently-used commands have alternative shortcuts intended to help you keep
your hands from moving all over the keyboard.

Alt -J; Alt -L Move caret to previous, next character.

Alt -I ; Alt -K Move caret up, down one line.
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Alt -Q; Alt -A Move caret up, down one screenful.

Alt -Z First non-whitespace character of line, beginning of
line, first visible line (repeated presses).

Alt -X Last non-whitespace character of line, end of line,
last visible line (repeated presses).
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Appendix B. The Activity Log
Theactivity log is very useful for troubleshooting problems, and helps when developing
plugins.

Utilities>Activity Log displays the last 500 lines of the activity log. By default, the
activity is shown in a floating window. It can be set to dock into the view in theDocking
pane of theUtilities>Global Options dialog box; seeSection 2.2.1. The complete log
can be found in theactivity.log file inside the jEdit settings directory, the path of
which is shown inside the activity log window.

jEdit writes the following information to the activity log:

• Information about your Java implementation (version, operating system,
architecture, etc)

• All error messages and runtime exceptions (most errors are shown in dialog boxes
as well; but the activity log usually contains more detailed and technical
information)

• All sorts of debugging information that can be helpful when tracking down bugs

• Information about loaded plugins

While jEdit is running, the log file on disk may not always accurately reflect what has
been logged, due to buffering being done for performance reasons. To ensure the file on
disk is up to date, invoke theUtilities>Update Activity Log on Disk command. The log
file is also automatically updated on disk when jEdit exits.
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Appendix C. History Text Fields
The text fields in the search and replace dialog box and file system browser remember
the last 20 entered strings by default. The number of strings to remember can be changed
in theGeneral pane of theUtilities>Global Options dialog box; seeSection 6.3.

PressingUp recalls previous strings. PressingDown after recalling previous strings
recalls later strings.

PressingShift-Up or Shift-Down will search backwards or forwards, respectively, for
strings beginning with the text already entered in the text field.

Clicking the triangle to the right of the text field, or clicking with the right-mouse button
anywhere else will display a pop-up menu of all previously entered strings; selecting one
will input it into the text field. Holding downShift while clicking will display a menu of
all previously entered strings that begin with the text already entered.
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jEdit uses glob patterns similar to those in the various Unix shells to implement file name
filters in the file system browser. Glob patterns resemble regular expressions somewhat,
but have a much simpler syntax. The following character sequences have special
meaning within a glob pattern:

• ? matches any one character

• * matches any number of characters

• {! glob } Matches anything thatdoes notmatchglob

• { a, b, c } matches any one ofa, b or c

• [ abc ] matches any character in the seta, b or c

• [^ abc ] matches any character not in the seta, b or c

• [ a-z ] matches any character in the rangea to z , inclusive. A leading or trailing
dash will be interpreted literally

In addition to the above, a number of “character class expressions” may be used as well:

• [[:alnum:]] matches any alphanumeric character

• [[:alpha:]] matches any alphabetical character

• [[:blank:]] matches a space or horizontal tab

• [[:cntrl:]] matches a control character

• [[:digit:]] matches a decimal digit

• [[:graph:]] matches a non-space, non-control character

• [[:lower:]] matches a lowercase letter

• [[:print:]] same as[:graph:] , but also space and tab

• [[:punct:]] matches a punctuation character

• [[:space:]] matches any whitespace character, including newlines

• [[:upper:]] matches an uppercase letter

• [[:xdigit:]] matches a valid hexadecimal digit
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Here are some examples of glob patterns:

• * - all files

• *.java - all files whose names end with “.java”

• *.{c,h} - all files whose names end with either “.c” or “.h”

• *[^~] - all files whose names do not end with “~”
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jEdit uses regular expressions to implement inexact search and replace. A regular
expression consists of a string where some characters are given special meaning with
regard to pattern matching.

Within a regular expression, the following characters have special meaning:

Positional Operators

• ^ matches at the beginning of a line

• $ matches at the end of a line

• \b matches at a word break

• \B matches at a non-word break

• \< matches at the start of a word

• \> matches at the end of a word

One-Character Operators

• . matches any single character

• \d matches any decimal digit

• \D matches any non-digit

• \n matches the newline character

• \s matches any whitespace character

• \S matches any non-whitespace character

• \t matches a horizontal tab character

• \w matches any word (alphanumeric) character

• \W matches any non-word (alphanumeric) character

• \\ matches the backslash (“\”) character
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Character Class Operator

• [ abc ] matches any character in the seta, b or c

• [^ abc ] matches any character not in the seta, b or c

• [ a-z ] matches any character in the rangea to z , inclusive. A leading or trailing
dash will be interpreted literally

• [[:alnum:]] matches any alphanumeric character

• [[:alpha:]] matches any alphabetical character

• [[:blank:]] matches a space or horizontal tab

• [[:cntrl:]] matches a control character

• [[:digit:]] matches a decimal digit

• [[:graph:]] matches a non-space, non-control character

• [[:lower:]] matches a lowercase letter

• [[:print:]] same as[:graph:] , but also space and tab

• [[:punct:]] matches a punctuation character

• [[:space:]] matches any whitespace character, including newlines

• [[:upper:]] matches an uppercase letter

• [[:xdigit:]] matches a valid hexadecimal digit

Subexpressions and Backreferences

• ( abc ) matches whatever the expressionabc would match, and saves it as a
subexpression. Also used for grouping

• (?: ... ) pure grouping operator, does not save contents

• (?# ... ) embedded comment, ignored by engine

• (?= ... ) positive lookahead; the regular expression will match if the text in the
brackets matches, but that text will not be considered part of the match

• (?! ... ) negative lookahead; the regular expression will match if the text in the
brackets does not match, and that text will not be considered part of the match
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• \ n where 0 <n < 10, matches the same thing thenth subexpression matched. Can
only be used in the search string

• $n where 0 <n < 10, substituted with the text matched by thenth subexpression.
Can only be used in the replacement string

Branching (Alternation) Operator

• a| b matches whatever the expressiona would match, or whatever the expressionb
would match.

Repeating Operators

These symbols operate on the previous atomic expression.

• ? matches the preceding expression or the null string

• * matches the null string or any number of repetitions of the preceding expression

• + matches one or more repetitions of the preceding expression

• { m} matches exactlymrepetitions of the one-character expression

• { m, n} matches betweenmandn repetitions of the preceding expression, inclusive

• { m,} matchesmor more repetitions of the preceding expression

Stingy (Minimal) Matching

If a repeating operator (above) is immediately followed by a?, the repeating operator
will stop at the smallest number of repetitions that can complete the rest of the match.

89



Appendix E. Regular Expressions

90



Appendix F. Macros Included With
jEdit

jEdit comes with a large number of sample macros that perform a variety of tasks. The
following index provides short descriptions of each macro, in some cases accompanied
by usage notes.

Macros from earlier versions of jEdit can be found, as well as a large number of macros
contributed by users, can be found in the “Downloads” section of the jEdit Community
(http://community.jedit.org) web site.

F.1. File Management Macros
These macros automate the opening and closing of files.

• Browse_Directory.bsh

Opens a directory supplied by the user in the file system browser.

• Close_All_Except_Active.bsh

Closes all files except the current buffer.

Prompts the user to save any buffer containing unsaved changes.

• Open_Path.bsh

Opens the file supplied by the user in an input dialog.

• Open_Selection.bsh

Opens the file named by the current buffer’s selected text.
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F.2. Text Macros
These macros generate various forms of formatted text.

• Add_Prefix_and_Suffix.bsh

Adds user-supplied “prefix” and “suffix” text to each line in a group of selected
lines.

Text is added after leading whitespace and before trailing whitespace. A dialog
window receives input and “remembers” past entries.

• Color_Picker.bsh

Displays a color picker and inserts the selected color in hexadecimal format,
prefixed with a “#”.

• Duplicate_Line.bsh

Duplicates the line on which the caret lies immediately beneath it and moves the
caret to the new line.

• Insert_Date.bsh

Inserts the current date and time in the current buffer.

The inserted text includes a representation of the time in the “Internet Time” format.

• Insert_Tag.bsh

Inserts a balanced pair of HTML/SGML/XML markup tags as supplied in a input
dialog. The tags will surround any selected text.

• Next_Char.bsh

Finds next occurrence of character on current line.
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The macro takes the next character typed after macro execution as the character
being searched. That character is not displayed. If the character does not appear in
the balance of the current line, no action occurs.

This macro illustrates the use ofInputHandler.readNextChar() as a means of
obtaining user input. SeeSection 14.1.4.

• Toggle_Line_Comment.bsh

Toggles line comments, alternately inserting and deleting them at the beginning of
each selected line. If there is no selection, the macro operates on the current line.

A “line comment” is a token that designates the entire contents of a line as
commented text; it does not use or require a closing token. If the editing mode does
not provide for line comments (for example, text or XML modes), the macro will
display an error message.

• Vertical_Paste.bsh

Pastes the content of the clipboard vertically and fills empty areas if necessary.

F.3. Java Code Macros
These macros handle text formatting and generation tasks that are particularly useful in
writing Java code.

• Get_Class_Name.bsh

Inserts a Java class name based upon the buffer’s file name.

• Get_Package_Name.bsh

Inserts a plausible Java package name for the current buffer.

The macro compares the buffer’s path name with the elements of the classpath
being used by the jEdit session. An error message will be displayed if no suitable
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package name is found. This macro will not work if jEdit is being run as a JAR file
without specifying a classpath; in that case the classpath seen by the macro consists
solely of the JAR file.

• Make_Get_and_Set_Methods.bsh

CreatesgetXXX() or setXXX() methods that can be pasted into the buffer text.

This macro presents a dialog that will “grab” the names of instance variables from
the caret line of the current buffer and paste a correspondinggetXXX() or
setXXX() method to one of two text areas in the dialog. The text can be edited in
the dialog and then pasted into the current buffer using theInsert... buttons. If the
caret is set to a line containing something other than an instance variable, the text
grabbing routine is likely to generate nonsense.

As explained in the notes accompanying the source code, the macro uses a global
variable which can be set to configure the macro to work with either Java or C++
code. When set for use with C++ code, the macro will also write (in commented
text) definitions ofgetXXX() or setXXX() suitable for inclusion in a header file.

• Preview_Javadoc_of_Buffer.bsh

Creates and displays javadoc for current buffer.

The macro includes configuration variables for using different doclets for generating
javadocs and for generating javadocs of the package of which the current buffer is a
part. Details for use are included in the note accompanying the macro’s source code.

F.4. Macros for Listing Properties
These macros produce lists or tables containing properties used by the Java platform or
jEdit itself.

• jEdit_Properties.bsh

Writes an unsorted list of jEdit properties in a new buffer.

94



Appendix F. Macros Included With jEdit

• System_Properties.bsh

Writes an unsorted list of all Java system properties in a new buffer.

• Look_and_Feel_Properties.bsh

Writes an unsorted list of the names of Java Look and Feel properties in a new
buffer.

F.5. Miscellaneous Macros
While these macros do not fit easily into the other categories, they all provide interesting
and useful functions.

• Cascade_jEdit_Windows.bsh

Rearranges view and floating plugin windows.

The windows are arranged in an overlapping “cascade” pattern beginning near the
upper left corner of the display.

• Display_Abbreviations.bsh

Displays the abbreviations registered for each of jEdit’s editing modes.

The macro provides a read-only view of the abbreviations contained in the
“Abbreviations” option pane. Pressing a letter key will scroll the table to the first
entry beginning with that letter. A further option is provided to write a selected
mode’s abbreviations or all abbreviations in a text buffer for printing as a reference.
Notes in the source code listing point out some display options that are configured
by modifying global variables.

• Display_Shortcuts.bsh

Displays a sorted list of the keyboard shortcuts currently in effect.
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The macro provides a combined read-only view of command, macro and plugin
shortcuts. Pressing a letter key will scroll the table to the first entry beginning with
that letter. A further option is provided to write the shortcut assignments in a text
buffer for printing as a reference. Notes in the source code listing point out some
display options that are configured by modifying global variables.

• Evaluate_Buffer_in_BeanShell.bsh

Evaluates contents of current buffer as a BeanShell script, and opens a new buffer to
receive any text output.

This is a quick way to test a macro script even before its text is saved to a file.
Opening a new buffer for output is a precaution to prevent the macro from
inadvertently erasing or overwriting itself. BeanShell scripts that operate on the
contents of the current buffer will not work meaningfully when tested using this
macro.

• Hex_Convert.bsh

Converts byte characters to their hex equivalent, and vice versa.

• Include_Guard.bsh

Intended for C/C++ header files, this macro inserts a preprocessor directive in the
current buffer to ensure that the header is included only once per compilation unit.

To use the macro, first place the caret at the beginning of the header file before any
uncommented text. The macro will return to this position upon completion. The
defined term that triggers the “include guard” is taken from the buffer’s name.

• Make_Bug_Report.bsh

Creates a new buffer with installation and error information extracted from the
activity log.

The macro extracts initial messages written to the activity log describing the user’s
operating system, JDK, jEdit version and installed plugins. It then appends the last
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set of error messages written to the activity log. The new text buffer can be saved
and attached to an email message or a bug report made on SourceForge.

• Run_Script.bsh

Runs script using interpreter based upon buffer’s editing mode (by default,
determined using file extension). You must have the appropriate interpreter (such as
Perl, Python, or Windows Script Host) installed on your system.

• Show_Threads.bsh

Displays in a tree format all running Java threads of the current Java Virtual
Machine.

• Write_HyperSearch_Results.bsh

This macro writes the contents of the “HyperSearch Results” window to a new text
buffer.

The macro employs a simple text report format. Since the HyperSearch window’s
object does not maintain the search settings that produced the displayed results, the
macro examines the current settings in theSearchAndReplace object. It confirms
that the HyperSearch option is selected before writing the report. However, the only
way to be sure that the report’s contents are completely accurate is to run the macro
immediately after a HyperSearch.
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Appendix G. jEditLauncher for
Windows

G.1. Introduction
The jEditLauncher package is a set of lightweight components for running jEdit under
the Windows group of operating systems. The package is designed to run on Windows
95, Windows 98, Windows Me, Windows NT (versions 4.0 and greater), Windows 2000
and Windows XP.

While jEdit does not make available a component-type interface, it does contains an
“EditServer” that listens on a socket for requests to load scripts written in the BeanShell
scripting language. When the server activates, it writes the server port number and a
pseudo-random, numeric authorization key to a text file. By default, the file is named
server and is located in the settings directory (seeSection 6.4).

The jEditLauncher component locates and reads this file, opens a socket and attempts to
connect to the indicated port. If successful, it transmits the appropriate BeanShell script
to the server. If unsuccessful, it attempts to start jEdit and repeats the socket transmission
once it can obtain the port and key information. The component will abandon the effort
to connect roughly twenty seconds after it launches the application.

G.2. Starting jEdit
The main component of the jEditLauncher package is a client application entitled
jedit.exe. It may be executed either from either Windows Explorer, a shortcut icon or the
command line. It uses the jEditLauncher COM component to open files in jEdit that are
listed as command line parameters. It supports Windows and UNC file specifications as
well as wild cards. If called without parameters, it will launch jEdit. If jEdit is already
running, it will simply open a new, empty buffer.

jedit.exesupports five command-line options. Except for the/1 option, if any of these
options are invoked correctly, the application will not load files or execute jEdit.
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• The option/h causes a window to be displayed with a brief description of the
application and its various options.

• The option/p will activate a dialog window displaying the command-line
parameters to be used when calling jEdit. This option can also be triggered by
selectingSet jEdit Parameters from thejEdit section of the Windows Programs
menu, or by running the utility programjedinit.exe

Using the dialog, you can change parameters specifying the executable for the Java
application loader (eitherjava.exe or javaw.exe ), the location of the jEdit
archive file,jedit.jar , and command line options for both.

• The input fields for Java options and jEdit options are separate. If you insert
an option in the wrong place it will not be properly executed.

• If the -jar option is not used with the Java application loader the principal
jEdit class oforg.gjt.sp.jedit.jEdit is set as fixed data.

• The working directory for the Java interpreter’s process can also be specified.

A read-only window at the bottom of the dialog displays the full command line that
jEditLauncher will invoke.

Before committing changes to the command line parameters,jedit.exevalidates the
paths for the Java and jEdit targets as well as the working directory. It will complain
if the paths are invalid. It will not validate command line options, but it will warn
you if it finds the-noserver option used for jEdit, since this will deactivate the
edit server and make it impossible for jEditLauncher to open files.

Note that due to the design of jEditLauncher, platform-independent command line
options handled by jEdit itself (such as-background and-norestore) must be
entered in the “Set jEdit Parameters” dialog box, and cannot be specified on the
jedit.execommand line directly. For information about platform-independent
command line options, seeSection 1.4.

• The option/1 is intended for use in circumstances where a single file name is
passed to jEdit for opening, and quotation marks cannot be used to delimit file
names containing whitespace. The launcher reads the entire command line
following the/1 options as a single file path, regardless of the presence of
whitespace, and passes the resulting string as a single file name parameter to jEdit.
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This option allows jEdit to be used with version 5 or greater of Internet Explorer as
an alternate text editor or as the target of theView Source command. Included with
the jEditLauncher distribution is a file namedjEdit_IE.reg.txt containing an
example of a Window registry file that you can use to register jEdit as a HTML
editor with Internet Explorer. Instructions for the file’s use are included in the text.

The use of the/1 option with multiple file names or other parameters will lead to
program errors or unpredictable results.

• The option/i is not mentioned in the help window forjedit.exe . It is intended
primarily to be used in conjunction with jEdit’s Java installer, but it can also be used
to install or reinstall jEditLauncher manually. When accompanied by a second
parameter specifying the directory where your preferred Java interpreter is located,
jEditLauncher will install itself and set a reasonable initial set of command line
parameters for executing jEdit. You can change these parameters later by running
jedinit.exe or jedit.exe with the/p option.

• The option/u will cause jEditLauncher to be uninstalled by removing its registry
entries. This option does not delete any jEditLauncher or jEdit files.

G.3. The Context Menu Handler
The jEditLauncher package also implements a context menu handler for the Windows
shell. It is intended to be be installed as a handler available for any file. When you
right-click on a file or shortcut icon, the context menu that appears will include an item
displaying the jEdit icon and captionedOpen with jEdit. If the file has an extension,
another item will appear captionedOpen *.XXX with jEdit, where XXX is the extension
of the selected file. Clicking this item will cause jEdit to load all files with the same
extension in the same directory as the selected file. Multiple file selections are also
supported; in this circumstance only theOpen with jEdit item appears.

If a single file with a.bsh extension is selected, the menu will also contain an item
captionedRun script in jEdit. Selecting this item will cause jEditLauncher to run the
selected file as a BeanShell script.

If exactly two files are selected, the menu will contain an entry forShow diff in jEdit.
Selecting this item will load the two files in jEdit and have them displayed side-by-side
with their differences highlighted by the JDiff plugin. The file selected first will be
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treated as the base for comparison purposes. If the plugin is not installed, an error
message will be displayed in jEdit. SeeChapter 8for more information about installing
plugins.

G.4. Using jEdit and jEditLauncher as a Diff Utility
As noted above, you can create a graphical diff display comparing the contents of two
text files by selecting the two files in an Explorer window, right-clicking to produce a
context menu, and selecting theShow diff in jEdit menu item. The utility
jedidiff.exe allows you to perform this operation from a command line. The
command takes the two files to be compared as parameters; they should be delimited by
quotation marks if their paths contain whitespace.

G.5. Uninstalling jEdit and jEditLauncher

There are three ways to uninstall jEdit and jEditLauncher.

• First, you can rununlaunch.exe in the jEdit installation directory.

• Second, you can chooseUninstall jEdit from thejEdit section of the Programs
menu.

• Third, you can choose the uninstall option for jEdit in the Control Panel’s
Add/Remove Programs applet.

Each of these options will deactivate jEditLauncher and delete all files in jEdit’s
installation directory. As a safeguard, jEditLauncher displays a warning window and
requires the user to confirm an uninstall operation. Because the user’s settings directory
can be set and changed from one jEdit session to another, user settings files must be
deleted manually.

To deactivate jEditLauncher without deleting any files, runjedit /u from any
command prompt where the jEdit installation directory is in the search path. This will
remove the entries for jEditLauncher from the Windows registry. It will also disable the
context menu handler and the automatic launching and scripting capabilities. The
package can reactivated by executingjedit.exeagain, and jEdit can be started in the
same manner as any other Java application on your system.
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G.6. The jEditLauncher Interface
The core of the jEditLauncher package is a COM component that can communicate with
the EditServer, or open jEdit if it is not running or is otherwise refusing a connection. The
component supports both Windows and UNC file specifications, including wild cards. It
will resolve shortcut links to identify and transmit the name of the underlying file.

Because it is implemented with a “dual interface”, the functions of jEditLauncher are
available to scripting languages in the Windows environment such as VBScript, JScript,
Perl (using the Win32::OLE package) and Python (using the win32com.client package).

The scriptable interface consists of two read-only properties and six functions:

Properties

• ServerPort - a read-only property that returns the port number found in jEdit’s
server file; the value is not tested for authenticity. It returns zero if the server
information file cannot be located.

• ServerKey - a read-only property that returns the numeric authorization key found
in jEdit’s server file; the value is not tested for authenticity. It returns zero if the
server information file cannot be located.

Functions

• OpenFile - a method that takes a single file name (with or without wild card
characters) as a parameter.

• OpenFiles - this method takes a array of file names (with or without wild card
characters) as a parameter. The form of the array is that which is used for arrays in
the scripting environment. In JScript, for example the data type of theVARIANT

holding the array isVT_DISPATCH; in VBScript, it isVT_ARRAY | VT_VARIANT,
with array members having data typeVT_BSTR.

• Launch - this method with no parameters attempts to open jEdit without loading
additional files.

• RunScript - this method takes a file name or full file path as a parameter and runs
the referenced file as a BeanShell script in jEdit. The predefined variablesview ,
editPane , textArea andbuffer are available to the script. If more than one view
is open, the variable are initialized with reference to the earliest opened view. If no
path is given for the file it will use the working directory of the calling process.
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• EvalScript - this method takes a string as a parameter containing one or more
BeanShell statements and runs the script in jEdit’s BeanShell interpreter. The
predefined variables are available on the same basis as inRunScript .

• RunDiff - this method takes two strings representing file names as parameters. If
the JDiff plugin is installed, this method will activate the JDiff plugin and display
the two files in the plugin’s graphical “dual diff” format. The first parameter is
treated as the base for display purposes. If the JDiff plugin is not installed, a error
message box will be displayed in jEdit.

G.7. Scripting Examples
Here are some brief examples of scripts using jEditLauncher. The first two will run under
Windows Script Host, which is either installed or available for download for 32-bit
Windows operating systems. The next example is written in Perl and requires the
Win32::OLE package. The last is written in Python and requires the win32gui and
win32com.client extensions.

If Windows Script Host is installed, you can run the first two scripts by typing the name
of the file containing the script at a command prompt. In jEdit’s Console plugin, you can
typecmd /c script_path or wscript script_path .

’ Example VBScript using jEditLauncher interface
dim launcher
set launcher = CreateObject("JEdit.JEditLauncher")
a = Array("I:\Source Code Files\shellext\jeditshell\*.h", _

"I:\Source Code Files\shellext\jeditshell\*.cpp")
MsgBox "The server authorization code is " + _

FormatNumber(launcher.ServerKey, 0, 0, 0, 0) + ".", _
vbOKOnly + vbInformation, "jEditLauncher"

launcher.openFiles(a)
myScript = "jEdit.newFile(view); textArea.setSelectedText(" _

& CHR(34) _
& "Welcome to jEditLauncher." _
& CHR(34) & ");"

launcher.evalScript(myScript)

/* Example JScript using jEditLauncher interface
* Note: in contrast to VBScript, JScript does not
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* directly support message boxes outside a browser window
*/

var launcher = WScript.createObject("JEdit.JEditLauncher");
var a = new Array("I:\\weather.html", "I:\\test.txt");
b = "I:\\*.pl";
launcher.openFiles(a);
launcher.openFile(b);
c = "G:\\Program Files\\jEdit\\macros\\Misc"

+ "\\Properties\\System_properties.bsh";
launcher.runScript(c);

# Example Perl script using jEditLauncher interface
use Win32::OLE;
$launcher = Win32::OLE->new(’JEdit.JEditLauncher’) ||

die "JEditLauncher: not found !\n";
@files = ();
foreach $entry (@ARGV) {

@new = glob($entry);
push(@files,@new);

}
$launcher->openFiles(\@files);
my($script) = "Macros.message(view, \"I found "

.(scalar @files)." files.\");";
$launcher->evalScript($script);

# Example Python script using jEditLauncher interface
import win32gui
import win32com.client
o = win32com.client.Dispatch("JEdit.JEditLauncher")
port = o.ServerPort
if port == 0:

port = "inactive. We will now launch jEdit"
win32gui.MessageBox(0, "The server port is %s." % port,

"jEditLauncher", 0)
path = "C:\\WINNT\\Profiles\\Administrator\\Desktop\\"
o.RunDiff(path + "Search.bsh", path + "Search2.bsh")
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G.8. jEditLauncher Logging
The jEditLauncher package has a logging facility that is separate from jEdit’s Activity
Log to provide a record of events occurring outside the Java virtual machine environment
in which jEdit operates. The logging facility maintains two log files:jelaunch.log for
events relating to starting jEdit, loading files and running scripts, andinstall.log for
jEditLauncher installation activity. Both files are maintained in the directory in which
jEdit is installed. They are cumulative from session to session, but may be manually
deleted at any time without affecting program execution.

G.9. Legal Notice
All source code and software distributed as the jEditLauncher package in which the
author holds the copyright is made available under the GNU General Public License
(“GPL”). A copy of the GPL is included in the fileCOPYING.txt included with jEdit.

Notwithstanding the terms of the General Public License, the author grants permission to
compile and link object code generated by the compilation of this program with object
code and libraries that are not subject to the GNU General Public License, provided that
the executable output of such compilation shall be distributed with source code on
substantially the same basis as the jEditLauncher package of which this source code and
software is a part. By way of example, a distribution would satisfy this condition if it
included a working Makefile for any freely available make utility that runs on the
Windows family of operating systems. This condition does not require a licensee of this
software to distribute any proprietary software (including header files and libraries) that
is licensed under terms prohibiting or limiting redistribution to third parties.

The purpose of this specific permission is to allow a user to link files contained or
generated by the source code with library and other files licensed to the user by
Microsoft or other parties, whether or not that license conforms to the requirements of
the GPL. This permission should not be construed to expand the terms of any license for
any source code or other materials used in the creation of jEditLauncher.
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II. Writing Edit Modes
This part of the user’s guide covers writing edit modes for jEdit.

Edit modes specify syntax highlighting rules, auto indent behavior, and various other
customizations for editing different file types. For general information about edit modes,
seeSection 5.1.

This part of the user’s guide was written by Slava Pestov <slava@jedit.org >.





Chapter 9. Writing Edit Modes
Edit modes are defined using XML, theextensible markup language; mode files have the
extension.xml . XML is a very simple language, and as a result edit modes are easy to
create and modify. This section will start with a short XML primer, followed by detailed
information about each supported tag and highlighting rule.

Note that changes to mode files take effect immediately; editing a mode or a mode
catalog file within jEdit will cause the file to be re-parsed as soon it is saved.

TheUtilities>Reload Edit Modes command can be used to reload edit modes after
changes to mode files are made outside jEdit.

9.1. An XML Primer
A very simple edit mode looks like so:

<?xml version="1.0"?>

<!DOCTYPE MODE SYSTEM "xmode.dtd">

<MODE>
<PROPS>

<PROPERTY NAME="commentStart" VALUE="/*" />
<PROPERTY NAME="commentEnd" VALUE="*/" />

</PROPS>

<RULES>
<SPAN TYPE="COMMENT1">

<BEGIN>/*</BEGIN>
<END>*/</END>

</SPAN>
</RULES>

</MODE>

Note that each opening tag must have a corresponding closing tag. If there is nothing
between the opening and closing tags, for example<TAG></TAG>, the shorthand notation
<TAG /> may be used. An example of this shorthand can be seen in the<PROPERTY>tags
above.
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XML is case sensitive.Span or span is not the same asSPAN.

To insert a special character such as < or > literally in XML (for example, inside an
attribute value), you must write it as anentity. An entity consists of the character’s
symbolic name enclosed with “&” and “;”. The most frequently used entities are:

• &lt; - The less-than (<) character

• &gt; - The greater-than (>) character

• &amp; - The ampersand (&) character

For example, the following will cause a syntax error:

<SEQ TYPE="OPERATOR">&</SEQ>

Instead, you must write:

<SEQ TYPE="OPERATOR">&amp;</SEQ>

Now that the basics of XML have been covered, the rest of this section will cover each
construct in detail.

9.2. The Preamble and MODE tag
Each mode definition must begin with the following:

<?xml version="1.0"?>
<!DOCTYPE MODE SYSTEM "xmode.dtd">

Each mode definition must also contain exactly oneMODEtag. All other tags (PROPS,
RULES) must be placed inside theMODEtag. TheMODEtag does not have any defined
attributes. Here is an example:

<MODE>
... mode definition goes here ...

</MODE>
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9.3. The PROPS Tag
ThePROPStag and thePROPERTYtags inside it are used to define mode-specific
properties. EachPROPERTYtag must have aNAMEattribute set to the property’s name, and
a VALUEattribute with the property’s value.

All buffer-local properties listed inSection 6.2may be given values in edit modes. In
addition, the following mode properties have no buffer-local equivalent:

• commentEnd - the comment end string, used by theRange Comment command.

• commentStart - the comment start string, used by theRange Comment
command.

• lineComment - the line comment string, used by theLine Comment command.

• doubleBracketIndent - If a line matches theindentPrevLine regular expression
and the next line contains an opening bracket, a level of indent will not be added to
the next line, unless this property is set to “true”. For example, with this property set
to “false”, Java code will be indented like so:

while(objects.hasMoreElements())
{

((Drawable)objects.nextElement()).draw();
}

On the other hand, settings this property to “true” will give the following result:

while(objects.hasMoreElements())
{

((Drawable)objects.nextElement()).draw();
}

• indentCloseBrackets - A list of characters (usually brackets) that subtract indent
from thecurrent line. For example, in Java mode this property is set to “}”.

• indentOpenBrackets - A list of characters (usually brackets) that add indent to the
nextline. For example, in Java mode this property is set to “{”.

• indentPrevLine - When indenting a line, jEdit checks if the previous line matches
the regular expression stored in this property. If it does, a level of indent is added.
For example, in Java mode this regular expression matches language constructs
such as “if”, “else”, “while”, etc.
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Here is the complete<PROPS>tag for Java mode:

<PROPS>
<PROPERTY NAME="indentOpenBrackets" VALUE="{" />
<PROPERTY NAME="indentCloseBrackets" VALUE="}" />
<PROPERTY NAME="indentPrevLine" VALUE="\s*(((if|while)

\s*\(|else|case|default)[^;]*|for\s*\(.*)" />
<PROPERTY NAME="doubleBracketIndent" VALUE="false" />
<PROPERTY NAME="commentStart" VALUE="/*" />
<PROPERTY NAME="commentEnd" VALUE="*/" />
<PROPERTY NAME="blockComment" VALUE="//" />
<PROPERTY NAME="wordBreakChars" VALUE=",+-=<>/?^&*" />

</PROPS>

9.4. The RULES Tag
RULEStags must be placed inside theMODEtag. EachRULEStag defines aruleset. A
ruleset consists of a number ofparser rules, with each parser rule specifying how to
highlight a specific syntax token. There must be at least one ruleset in each edit mode.
There can also be more than one, with different rulesets being used to highlight different
parts of a buffer (for example, in HTML mode, one rule set highlights HTML tags, and
another highlights inline JavaScript). For information about using more than one ruleset,
seeSection 9.4.5.

TheRULEStag supports the following attributes, all of which are optional:

• SET - the name of this ruleset. All rulesets other than the first must have a name.

• HIGHLIGHT_DIGITS - if set toTRUE, digits (0-9, as well as hexadecimal literals
prefixed with “0x”) will be highlighted with theDIGIT token type. Default isFALSE.

• IGNORE_CASE- if set toFALSE, matches will be case sensitive. Otherwise, case will
not matter. Default isTRUE.

• DEFAULT- the token type for text which doesn’t match any specific rule. Default is
NULL. SeeSection 9.4.11for a list of token types.

Here is an exampleRULEStag:

<RULES IGNORE_CASE="FALSE" HIGHLIGHT_DIGITS="TRUE">
... parser rules go here ...
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</RULES>

9.4.1. Rule Ordering Requirements

You might encounter this very common pitfall when writing your own modes.

Since jEdit checks buffer text against parser rules in the order they appear in the ruleset,
more specific rules must be placed before generalized ones, otherwise the generalized
rules will catch everything.

This is best demonstrated with an example. The following is incorrect rule ordering:

<SPAN TYPE="MARKUP">
<BEGIN>[</BEGIN>
<END>]</END>

</SPAN>

<SPAN TYPE="KEYWORD1">
<BEGIN>[!</BEGIN>
<END>]</END>

</SPAN>

If you write the above in a rule set, any occurrence of “[” (even things like “[!DEFINE”,
etc) will be highlighted using the first rule, because it will be the first to match. This is
most likely not the intended behavior.

The problem can be solved by placing the more specific rule before the general one:

<SPAN TYPE="KEYWORD1">
<BEGIN>[!</BEGIN>
<END>]</END>

</SPAN>

<SPAN TYPE="MARKUP">
<BEGIN>[</BEGIN>
<END>]</END>

</SPAN>

Now, if the buffer contains the text “[!SPECIAL]”, the rules will be checked in order,
and the first rule will be the first to match. However, if you write “[FOO]”, it will be
highlighted using the second rule, which is exactly what you would expect.
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9.4.2. Per-Ruleset Properties

ThePROPStag (described inSection 9.3) can also be placed inside theRULEStag to
define ruleset-specific properties. Only the following properties can be set on a
per-ruleset basis:

• commentEnd - the comment end string.

• commentStart - the comment start string.

• lineComment - the line comment string.

These properties are used by the commenting commands to implement context-sensitive
comments; seeSection 5.5.

9.4.3. The TERMINATE Rule

TheTERMINATErule specifies that parsing should stop after the specified number of
characters have been read from a line. The number of characters to terminate after should
be specified with theAT_CHARattribute. Here is an example:

<TERMINATE AT_CHAR="1" />

This rule is used in Patch mode, for example, because only the first character of each line
affects highlighting.

9.4.4. The WHITESPACE Rule

TheWHITESPACErule specifies characters which are to be treated as keyword delimiters.
Most rulesets will haveWHITESPACEtags for spaces and tabs. Here is an example:

<WHITESPACE> </WHITESPACE>
<WHITESPACE> </WHITESPACE>

9.4.5. The SPAN Rule

TheSPANrule highlights text between a start and end string. The start and end strings are
specified inside child elements of theSPANtag. The following attributes are supported:
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• TYPE- The token type to highlight the span with. SeeSection 9.4.11for a list of
token types

• AT_LINE_START - If set toTRUE, the span will only be highlighted if the start
sequence occurs at the beginning of a line

• EXCLUDE_MATCH- If set toTRUE, the start and end sequences will not be
highlighted, only the text between them will

• NO_LINE_BREAK- If set toTRUE, the span will be highlighted with theINVALID

token type if it spans more than one line

• NO_WORD_BREAK- If set toTRUE, the span will be highlighted with theINVALID

token type if it includes whitespace

• DELEGATE- text inside the span will be highlighted with the specified ruleset. To
delegate to a ruleset defined in the current mode, just specify its name. To delegate
to a ruleset defined in another mode, specify a name of the formmode:: ruleset .
Note that the first (unnamed) ruleset in a mode is called “MAIN”.

Note: Do not delegate to rulesets that define a TERMINATErule (examples of such
rulesets include text::MAIN and patch::MAIN ). It won’t work.

Here is aSPANthat highlights Java string literals, which cannot include line breaks:

<SPAN TYPE="LITERAL1" NO_LINE_BREAK="TRUE">
<BEGIN>"</BEGIN>
<END>"</END>

</SPAN>

Here is aSPANthat highlights Java documentation comments by delegating to the
“JAVADOC” ruleset defined elsewhere in the current mode:

<SPAN TYPE="COMMENT2" DELEGATE="JAVADOC">
<BEGIN>/**</BEGIN>
<END>*/</END>

</SPAN>

Here is aSPANthat highlights HTML cascading stylesheets inside<STYLE> tags by
delegating to the main ruleset in the CSS edit mode:
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<SPAN TYPE="MARKUP" DELEGATE="css::MAIN">
<BEGIN>&lt;style&gt;</BEGIN>
<END>&lt;/style&gt;</END>

</SPAN>

Tip: The <END>tag is optional. If it is not specified, any occurrence of the start
string will cause the remainder of the buffer to be highlighted with this rule.

This can be very useful when combined with delegation.

9.4.6. The EOL_SPAN Rule

An EOL_SPANis similar to aSPANexcept that highlighting stops at the end of the line, not
after the end sequence is found. The text to match is specified between the opening and
closingEOL_SPANtags. The following attributes are supported:

• TYPE- The token type to highlight the span with. SeeSection 9.4.11for a list of
token types

• AT_LINE_START - If set toTRUE, the span will only be highlighted if the start
sequence occurs at the beginning of a line

• EXCLUDE_MATCH- If set toTRUE, the start sequence will not be highlighted, only the
text after it will

Here is anEOL_SPANthat highlights C++ comments:

<EOL_SPAN TYPE="COMMENT1">//</EOL_SPAN>

9.4.7. The MARK_PREVIOUS Rule

TheMARK_PREVIOUSrule highlights from the end of the previous syntax token to the
matched text. The text to match is specified between opening and closing
MARK_PREVIOUStags. The following attributes are supported:
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• TYPE- The token type to highlight the text with. SeeSection 9.4.11for a list of
token types

• AT_LINE_START - If set toTRUE, the text will only be highlighted if it occurs at the
beginning of the line

• EXCLUDE_MATCH- If set toTRUE, the match will not be highlighted, only the text
before it will

Here is a rule that highlights labels in Java mode (for example, “XXX:”):

<MARK_PREVIOUS AT_LINE_START="TRUE"
EXCLUDE_MATCH="TRUE">:</MARK_PREVIOUS>

9.4.8. The MARK_FOLLOWING Rule

TheMARK_FOLLOWINGrule highlights from the start of the match to the next syntax
token. The text to match is specified between opening and closingMARK_FOLLOWING

tags. The following attributes are supported:

• TYPE- The token type to highlight the text with. SeeSection 9.4.11for a list of
token types

• AT_LINE_START - If set toTRUE, the text will only be highlighted if the start
sequence occurs at the beginning of a line

• EXCLUDE_MATCH- If set toTRUE, the match will not be highlighted, only the text
after it will

Here is a rule that highlights variables in Unix shell scripts (“$CLASSPATH”, “$IFS”,
etc):

<MARK_FOLLOWING TYPE="KEYWORD2">$</MARK_FOLLOWING>

9.4.9. The SEQ Rule

TheSEQrule highlights fixed sequences of text. The text to highlight is specified between
opening and closingSEQtags. The following attributes are supported:
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• TYPE- the token type to highlight the sequence with. SeeSection 9.4.11for a list of
token types

• AT_LINE_START - If set toTRUE, the sequence will only be highlighted if it occurs
at the beginning of a line

The following rules highlight a few Java operators:

<SEQ TYPE="OPERATOR">+</SEQ>
<SEQ TYPE="OPERATOR">-</SEQ>
<SEQ TYPE="OPERATOR">*</SEQ>
<SEQ TYPE="OPERATOR">/</SEQ>

9.4.10. The KEYWORDS Rule

There can only be oneKEYWORDStag per ruleset. TheKEYWORDSrule defines keywords to
highlight. Keywords are similar toSEQs, except thatSEQs match anywhere in the text,
whereas keywords only match whole words.

TheKEYWORDStag supports only one attribute,IGNORE_CASE. If set toFALSE, keywords
will be case sensitive. Otherwise, case will not matter. Default isTRUE.

Each child element of theKEYWORDStag should be named after the desired token type,
with the keyword text between the start and end tags. For example, the following rule
highlights the most common Java keywords:

<KEYWORDS IGNORE_CASE="FALSE">
<KEYWORD1>if</KEYWORD1>
<KEYWORD1>else</KEYWORD1>
<KEYWORD3>int</KEYWORD3>
<KEYWORD3>void</KEYWORD3>

</KEYWORDS>

9.4.11. Token Types

Parser rules can highlight tokens using any of the following token types:

• NULL - no special highlighting is performed on tokens of typeNULL

• COMMENT1
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• COMMENT2

• FUNCTION

• INVALID - tokens of this type are automatically added if aNO_WORD_BREAKor
NO_LINE_BREAK SPANspans more than one word or line, respectively.

• KEYWORD1

• KEYWORD2

• KEYWORD3

• LABEL

• LITERAL1

• LITERAL2

• MARKUP

• OPERATOR
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Chapter 10. Installing Edit Modes
jEdit looks for edit modes in two locations; themodes subdirectory of the jEdit settings
directory, and themodes subdirectory of the jEdit install directory. The location of the
settings directory is system-specific; seeSection 6.4.

Each mode directory contains acatalog file. All edit modes contained in that directory
must be listed in the catalog, otherwise they will not be available to jEdit.

Catalogs, like modes themselves, are written in XML. They consist of a singleMODES

tag, with a number ofMODEtags inside. Each mode tag associates a mode name with an
XML file, and specifies the file name and first line pattern for the mode. A sample mode
catalog looks like follows:

<?xml version="1.0"?>
<!DOCTYPE CATALOG SYSTEM "catalog.dtd">

<MODES>
<MODE NAME="shellscript" FILE="shellscript.xml"

FILE_NAME_GLOB="*.sh"
FIRST_LINE_GLOB="#!/*sh*" />

</MODES>

In the above example, a mode named “shellscript” is defined, and is used for files whose
names end with.sh , or whose first line starts with “#!/” and contains “sh”.

TheMODEtag supports the following attributes:

• NAME- the name of the edit mode, as it will appear in theBuffer Options dialog
box, the status bar, and so on

• FILE - the name of the XML file containing the mode definition

• FILE_NAME_GLOB- files whose names match this glob pattern will be opened in this
edit mode. SeeAppendix Dfor information about glob patterns

• FIRST_LINE_GLOB - files whose first line matches this glob pattern will be opened
in this edit mode. SeeAppendix Dfor information about glob patterns

If an edit mode is defined in the user-specific catalog with the same name as an edit
mode in the global catalog, the version in the user-specific catalog will be used instead of
the other version.
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III. Writing Macros
This part of the user’s guide covers writing macros for jEdit.

First, we will tell you a little about BeanShell, jEdit’s macro scripting language. Next,
we will walk through a few simple macros. We then present and analyze a dialog-based
macro to illustrate additional macro writing techniques. Finally, we discuss several tips
and techniques for writing and debugging macros.

This part of the user’s guide was written by John Gellene <jgellene@nyc.rr.com >.





Chapter 11. Introducing BeanShell
Here is how BeanShell’s author, Pat Niemeyer, describes his creation:

“BeanShell is a small, free, embeddable, Java source interpreter with object scripting
language features, written in Java. BeanShell executes standard Java statements and
expressions, in addition to obvious scripting commands and syntax. BeanShell supports
scripted objects as simple method closures like those in Perl and JavaScript.”

You do not have to know anything about Java to begin writing your own jEdit macros.
But if you know how to program in Java, you already know how to write BeanShell
scripts. The major strength of using BeanShell with a program written in Java is that it
allows the user to customize the program’s behavior using the same interfaces designed
and used by the program itself. BeanShell can turn a well-designed application into a
powerful, extensible toolkit.

This guide focuses on using BeanShell in macros. If you are interested in learning more
about BeanShell generally, consult the BeanShell web site (http://www.beanshell.org).
Information on how to run and organize macros, whether included with the jEdit
installation or written by you, can be found inChapter 7.
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Chapter 12. A Few Simple Macros

12.1. The Mandatory First Example

Macros.message(view, "Hello world!");

Running this one line script causes jEdit to display a message box (more precisely, a
JOptionPane object) with the traditional beginner’s message and anOK button. Let’s
see what is happening here.

This statement calls a static method (or function) namedmessage in jEdit’s Macros

class. If you don’t know anything about classes or static methods or Java (or C++, which
employs the same concept), you will need to gain some understanding of a few terms.
Obviously this is not the place for academic precision, but if you are entirely new to
object-oriented programming, here are a few skeleton ideas to help you with BeanShell.

• An objectis a collection of data that can be initialized, accessed and manipulated in
certain defined ways.

• A classis a specification of what data an object contains and what methods can be
used to work with the data. A Java application consists of one or more classes (in
the case of jEdit ,over 500 classes) written by the programmer that defines the
application’s behavior. A BeanShell macro uses these classes, along with built-in
classes that are supplied with the Java platform, to define its own behavior.

• A subclass(or child class) is a class which uses (or “inherits”) the data and
methods of its parent class along with additions or modifications that alter the
subclass’s behavior. Classes are typically organized in hierarchies of parent and
child classes to organize program code, to define common behavior in shared parent
class code, and to specify the types of similar behavior that child classes will
perform in their own specific ways.

• A method(or function) is a procedure that works with data in a particular object,
other data (including other objects) supplied asparameters, or both. Methods
typically are applied to a particular object which is aninstanceof the class to which
the method belongs.
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• A static methoddiffers from other methods in that it does not deal with the data in
a particular object but is included within a class for the sake of convenience.

Java has a rich set of classes defined as part of the Java platform. Like all Java
applications, jEdit is organized as a set of classes that are themselves derived from the
Java platform’s classes. We will refer toJava classesandjEdit classesto make this
distinction. Some of jEdit’s classes (such as those dealing with regular expressions and
XML) are derived from or make use of classes in other open-source Java packages.
Except for BeanShell itself, we won’t be discussing them in this guide.

In our one line script, the static methodMacros.message() has two parameters because
that is the way the method is defined in theMacros class. You must specify both
parameters when you call the function. The first parameter,view , is a a variable naming
a View object - an instance of jEdit’sView class. AView represents a “parent” or
top-level frame window that contains the various visible components of the program,
including the text area, menu bar, toolbar, and any docked windows. It is a subclass of
Java’sJFrame class. With jEdit, you can create and display multiple views
simultaneously. The variableview is predefined for purposes of BeanShell scripts as the
current, activeView object. This is in fact the variable you want to specify as the first
parameter. Normally you would not want to associate a message box with anything other
than the currentView .

The second parameter, which appears to be quoted text, is astring literal - a sequence of
characters of fixed length and content. Behind the scenes, BeanShell and Java take this
string literal and use it to create aString object. Normally, if you want to create an
object in Java or BeanShell, you must construct the object using thenew keyword and a
constructormethod that is part of the object’s class. We’ll show an example of that later.
However, both Java and BeanShell let you use a string literal anytime a method’s
parameter calls for aString .

If you are a Java programmer, you might wonder about a few things missing from this
one line program. There is no class definition, for example. You can think of a BeanShell
script as an implicit definition of amain() method in an anonymous class. That is in fact
how BeanShell is implemented; the class is derived from a BeanShell class calledXThis .
If you don’t find that helpful, just think of a script as one or more blocks of procedural
statements conforming to Java syntax rules. You will also get along fine (for the most
part) with C or C++ syntax if you leave out anything to do with pointers or memory
management - Java and BeanShell do not have pointers and deal with memory
management automatically.
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Another missing item from a Java perspective is apackage statement. In Java, such a
statement is used to bundle together a number of files so that their classes become visible
to one another. Packages are not part of BeanShell, and you don’t need to know anything
about them to write BeanShell macros.

Finally, there are noimport statements in this script. In Java, animport statement
makes public classes from other packages visible within the file in which the statement
occurs without having to specify a fully qualified class name. Without an import
statement or a fully qualified name, Java cannot identify most classes using a single
name as an identifier.

jEdit automatically imports a number of commonly-used packages into the namespace of
every BeanShell script. Because of this, the script output of a recorded macro does not
containimport statements. For the same reason, most BeanShell scripts you write will
not requireimport statements.

Java requiresimport statement at the beginning of a source file. BeanShell allows you to
placeimport statements anywhere in a script, including inside a block of statements.
The import statement will cover all names used following the statement in the enclosing
block.

If you try to use a class that is not imported without its fully-qualified name, the
BeanShell interpreter will complain with an error message relating to the offending line
of code.
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Here is the full list of packages automatically imported by jEdit:

java.awt
java.awt.event
java.net
java.util
java.io
java.lang
javax.swing
javax.swing.event
org.gjt.sp.jedit
org.gjt.sp.jedit.browser
org.gjt.sp.jedit.buffer
org.gjt.sp.jedit.gui
org.gjt.sp.jedit.io
org.gjt.sp.jedit.msg
org.gjt.sp.jedit.options
org.gjt.sp.jedit.pluginmgr
org.gjt.sp.jedit.search
org.gjt.sp.jedit.syntax
org.gjt.sp.jedit.textarea
org.gjt.sp.util

12.2. Helpful Methods in the Macros Class
Includingmessage() , there are five static methods in theMacros class that allow you to
converse easily with your macros. They all encapsulate calls to methods of the Java
platform’sJOptionPane class.

• public static void message (Component comp, String message );

• public static void error (Component comp, String message );

• public static String input (Component comp, String prompt );

• public static String input (Component comp, String prompt , String

defaultValue );
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• public static int confirm (Component comp, String prompt , int

buttons );

The format of these fourdeclarationsprovides a concise reference to the way in which
the methods may be used. The keywordpublic means that the method can be used
outside theMacros class. The alternatives areprivate andprotected . For purposes of
BeanShell, you just have to know that BeanShell can only use public methods of other
Java classes. The keywordstatic we have already discussed. It means that the method
does not operate on a particular object. You call a static function using the name of the
class (likeMacros ) rather than the name of a particular object (likeview ). The third
word is the type of the value returned by the method. The keywordvoid is Java’s way of
saying the the method does not have a return value.

Theerror() method works just likemessage() but displays an error icon in the
message box. Theinput() method furnishes a text field for input, anOK button and a
Cancel button. IfCancel is pressed, the method returnsnull . If OK is pressed, a
String containing the contents of the text field is returned. Note that there are two forms
of the input() method; the first form with two parameters displays an empty input field,
the other forms lets you specify an initial, default input value.

For those without Java experience, it is important to know thatnull is not the same as an
empty, “zero-length”String . It is Java’s way of saying that there is no object associated
with this variable. Whenever you seek to use a return value frominput() in your macro,
you should test it to see if it isnull . In most cases, you will want to exit gracefully from
the script with areturn statement, because the presence of a null value for an input
variable usually means that the user intended to cancel macro execution. BeanShell will
complain if you call any methods on anull object.

Theconfirm() method in theMacros class is a little more complex. Thebuttons

parameter has anint type, and the usual way to supply a value is to use one of the
predefined values taken from Java’sJOptionPane class. You can choose among
JOptionPane.YES_NO_OPTION , JOptionPane.YES_NO_CANCEL_OPTION, or
JOptionPane.OK_CANCEL_OPTION . The return value of the method is also anint , and
should be tested against the value of other predefined constants:
JOptionPane.YES_OPTION , JOptionPane.NO_OPTION , JOptionPane.OK_OPTION or
JOptionPane.CANCEL_OPTION .

We’ve looked at usingMacros.message() . To use the other methods, you would write
something like the following:

131



Chapter 12. A Few Simple Macros

Macros.error(view, "Goodbye, cruel world!");

String result = Macros.input(view, "Type something here.");

String result = Macros.input(view, "When were you born?",
"I don’t remember, I was very young at the time");

int result = Macros.confirm("Do you really want to learn"
+ " about BeanShell?",JOptionPane.YES_NO_OPTION);

In the last three examples, placing the wordString or int before the variable name
result tells BeanShell that the variable refers to an integer or aString object, even
before a particular value is assigned to the variable. In BeanShell, thisdeclarationof the
typeof result is not necessary; BeanShell can figure it out when the macro runs. This
can be helpful if you are not comfortable with specifying types and classes; just use your
variables and let BeanShell worry about it.

Without an explicittype declarationlike String result , BeanShell variables can
change their type at runtime depending on the object or data assigned to it. This dynamic
typing allows you to write code like this (if you really wanted to):

// note: no type declaration
result = Macros.input(view, “Type something here.”);

// this is our predefined, current View
result = view;

// this is an “int” (for integer);
// in Java and BeanShell, int is one of a small number
// of “primitive” data types which are not classes
result = 14;

However, if you first declaredresult to be typeString and and then tried these
reassignments, BeanShell would complain. While avoiding explicit type declaration
makes writing macro code simpler, using them can act as a check to make sure you are
not using the wrong variable type of object at a later point in your script. It also makes it
easier (if you are so inclined) to take a BeanShell “prototype” and incorporate it in a Java
program.
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One last thing before we bury our first macro. The double slashes in the examples just
above signify that everything following them on that line should be ignored by
BeanShell as a comment. As in Java and C/C++, you can also embed comments in your
BeanShell code by setting them off with pairs of/* */ , as in the following example:

/* This is a long comment that covers several lines
and will be totally ignored by BeanShell regardless of how
many lines it covers */

12.3. Now For Something Useful
Here is a macro that inserts the path of the current buffer in the text:

String newText = buffer.getPath();
textArea.setSelectedText(newText);

Two of the new names we see here,buffer andtextArea , are predefined variables like
view . The variablebuffer represents a jEditBuffer object, andtextArea represents a
JEditTextArea object.

• A Buffer object represents the contents of an open text file. The variablebuffer

is predefined as the current, visible buffer being edited.

• A JEditTextArea is the visible component that displays the file being edited. It is
derived from theJComponent class. The variabletextArea represents the current
JEditTextArea object, which in turn displays the current buffer.

Unlike in our first macro example, here we are calling class methods on particular
objects. First, we callgetPath() on the currentBuffer object to get the full path of the
text file currently being edited. Next, we callsetSelectedText() on the current text
display component, specifying the text to be inserted as a parameter.

In precise terms, thesetSelectedText() method substitutes the contents of theString

parameter for a range of selected text that includes the current caret position. If no text is
selected at the caret position, the effect of this operation is simply to insert the new text
at that position.

Here’s a few alternatives to the full file path that you could use to insert various useful
things:
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// the file name (without full path)
String newText = buffer.getName();

// today’s date
import java.text.DateFormat;

String newText = DateFormat.getDateInstance()
.format(new Date());

// a line count for the current buffer
String newText = "This file contains "

+ textArea.getLineCount() + " lines.";

Here are brief comments on each:

• In the first, the call togetName() invokes another method of theBuffer class.

• The syntax of the second example chains the results of several methods. You could
write it this way:

import java.text.DateFormat;
Date d = new Date();
DateFormat df = DateFormat.getDateInstance();
String result = df.format(d);

Taking the pieces in order:

• A JavaDate object is created using thenew keyword. The empty parenthesis
afterDate signify a call on theconstructor methodof Date having no
parameters; here, aDate is created representing the current date and time.

• DateFormat.getDateInstance() is a static method that creates and returns
a DateFormat object. As the name implies,DateFormat is a Java class that
takesDate objects and produces readable text. The method
getDateInstance() returns aDateFormat object that parses and formats
dates. It will use the defaultlocaleor text format specified in the user’s Java
installation.

• Finally, DateFormat.format() is called on the newDateFormat object
using theDate object as a parameter. The result is aString containing the
date in the default locale.
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• Note that theDate class is contained in thejava.util package, so an explicit
import statement is not required. However,DateFormat is part of the
java.text package, which is not automatically imported, so an explicit
import statement must be used.

• The third example shows three items of note:

• getLineCount() is a method in jEdit’sJEditTextArea class. It returns an
int representing the number of lines in the current text buffer. We call it on
textArea , the pre-defined, currentJEditTextArea object.

• The use of the+ operator (which can be chained, as here) appends objects and
string literals to return a single, concatenatedString .

The other pre-defined variable

In addition toview , buffer andtextArea , there is one more pre-defined variable
available for use in macros --editPane . That variable is set to the current
EditPane instance. AnEditPane object contains a text area and buffer switcher.
A view can be split to display multiple buffers, each in its own edit pane. Among
other things, theEditPane class contains methods for selecting the buffer to edit.

Most of the time your macros will manipulate thebuffer or thetextArea .
Sometimes you will need to useview as a parameter in a method call. You will
probably only need to useeditPane if your macros work with split views.

12.4. Single Execution Macros
At this point, we have covered some basic techniques for writing one-line or other short
macros. As noted earlier, you can save a BeanShell script of any length as a text file with
the .bsh extension. There are three other ways jEdit lets you use BeanShell quickly,
without saving a script to storage, on a “one time only” basis. You will find them in the
Utilities menu.

Utilities>Evaluate BeanShell Expression displays a text input dialog that asks you to
type a single line of BeanShell commands. You can type more than one BeanShell
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statement so long as each of them ends with a semicolon. If BeanShell successfully
interprets your input, a message box will appear with the return value of the last
statement. You can do the same thing using the BeanShell interpreter provided with the
Console plugin; the return value will appear in the output window.

Utilities>Evaluate For Selected Lines displays a text input dialog that asks you to type
a single line of BeanShell commands. The commands are evaluated for each line of the
selection. In addition to the standard set of variables, this command defines the
following:

• line - the line number, from the start of the buffer. The first line is numbered 0.

• index - the line number, from the start of the selection. The first line is numbered 0.

• text - the text of the line.

Try typing an expression like(line + 1) + ": " + text in theEvaluate For
Selected Lines dialog box. This will add a line number to each selected line
beginning with the number1.

The BeanShell expression you enter will be evaluated and substituted in place of the
entire text of a selected line. If you want to leave the line’s current text as an element of
the modified line, you must include the defined variabletext as part of the BeanShell
expression that you enter.

Utilities>Evaluate Selection evaluates the selected text as a BeanShell script and
replaces it with the return value of the statement.

UsingEvaluate Selection is an easy way to do arithmetic calculations inline while
editing. BeanShell uses numbers and arithmetic operations in an ordinary, intuitive way.

Try typing an expression like(3745*856)+74 in the buffer, select it, and choose
Utilities>Evaluate Selection. The selected text will be replaced by the answer,
3205794 .
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Now we will look at a more complicated macro which will demonstrate some useful
techniques and BeanShell features.

13.1. Use of the Macro
Our new example adds prefix and suffix text to a series of selected lines. This macro can
be used to reduce typing for a series of text items that must be preceded and following by
identical text. In Java, for example, if we are interested in making a series of calls to
StringBuffer.append() to construct a lengthy, formatted string, we could type the
parameter for each call on successive lines as follows:

profileString_1
secretThing.toString()
name
address
addressSupp
city
“state/province”
country

Our macro would ask for input for the common “prefix” and “suffix” to be applied to
each line; in this case, the prefix isourStringBuffer.append( and the suffix is
); . After selecting these lines and running the macro, the resulting text would look like
this:

ourStringBuffer.append(profileString_1);
ourStringBuffer.append(secretThing.toString());
ourStringBuffer.append(name);
ourStringBuffer.append(address);
ourStringBuffer.append(addressSupp);
ourStringBuffer.append(city);
ourStringBuffer.append(“state/province”);
ourStringBuffer.append(country);
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13.2. Listing of the Macro
The macro script follows. You can find it in the jEdit distribution in theText

subdirectory of themacros directory. You can also try it out by invoking
Macros>Text>Add Prefix and Suffix.

// beginning of Add_Prefix_and_Suffix.bsh

// import statement (see Section 13.3.1 )
import javax.swing.border.*;

// main routine
void prefixSuffixDialog()
{

// create dialog object (see Section 13.3.2 )
title = “Add prefix and suffix to selected lines”;
dialog = new JDialog(view, title, false);
content = new JPanel(new BorderLayout());
content.setBorder(new EmptyBorder(12, 12, 12, 12));
content.setPreferredSize(new Dimension(320, 160));
dialog.setContentPane(content);

// add the text fields (see Section 13.3.3 )
fieldPanel = new JPanel(new GridLayout(4, 1, 0, 6));
prefixField = new HistoryTextField(“macro.add-prefix”);
prefixLabel = new JLabel(“Prefix to add:”);
suffixField = new HistoryTextField(“macro.add-suffix”);
suffixLabel = new JLabel(“Suffix to add:”);
fieldPanel.add(prefixLabel);
fieldPanel.add(prefixField);
fieldPanel.add(suffixLabel);
fieldPanel.add(suffixField);
content.add(fieldPanel, “Center”);

// add a panel containing the buttons (see Section 13.3.4 )
buttonPanel = new JPanel();
buttonPanel.setLayout(new BoxLayout(buttonPanel,

BoxLayout.X_AXIS));
buttonPanel.setBorder(new EmptyBorder(12, 50, 0, 50));
buttonPanel.add(Box.createGlue());
ok = new JButton(“OK”);
cancel = new JButton(“Cancel”);
ok.setPreferredSize(cancel.getPreferredSize());
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dialog.getRootPane().setDefaultButton(ok);
buttonPanel.add(ok);
buttonPanel.add(Box.createHorizontalStrut(6));
buttonPanel.add(cancel);
buttonPanel.add(Box.createGlue());
content.add(buttonPanel, “South”);

// register this method as an ActionListener for
// the buttons and text fields (see Section 13.3.5 )
ok.addActionListener(this);
cancel.addActionListener(this);
prefixField.addActionListener(this);
suffixField.addActionListener(this);

// locate the dialog in the center of the
// editing pane and make it visible (see Section 13.3.6 )
dialog.pack();
dialog.setLocationRelativeTo(view);
dialog.setDefaultCloseOperation(JDialog.DISPOSE_ON_CLOSE);
dialog.setVisible(true);

// this method will be called when a button is clicked
// or when ENTER is pressed (see Section 13.3.7 )
void actionPerformed(e)
{

if(e.getSource() != cancel)
{

processText();
}
dialog.dispose();

}

// this is where the work gets done to insert
// the prefix and suffix (see Section 13.3.8 )
void processText()
{

prefix = prefixField.getText();
suffix = suffixField.getText();
if(prefix.length() == 0 && suffix.length() == 0)

return;
prefixField.addCurrentToHistory();
suffixField.addCurrentToHistory();
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// text manipulation begins here using calls
// to jEdit methods (see Section 13.3.9 )
buffer.beginCompoundEdit();
selectedLines = textArea.getSelectedLines();
for(i = 0; i < selectedLines.length; ++i)
{

offsetBOL = textArea.getLineStartOffset(
selectedLines[i]);

textArea.setCaretPosition(offsetBOL);
textArea.goToStartOfWhiteSpace(false);
textArea.goToEndOfWhiteSpace(true);
text = textArea.getSelectedText();
if(text == null) text = "";
textArea.setSelectedText(prefix + text + suffix);

}
buffer.endCompoundEdit();

}
}

// this single line of code is the script’s main routine
// (see Section 13.3.10 )
prefixSuffixDialog();

// end of Add_Prefix_and_Suffix.bsh

13.3. Analysis of the Macro

13.3.1. Import Statements

// import statement
import javax.swing.border.*;

This macro makes use of classes in thejavax.swing.border package, which is not
automatically imported. As we mentioned previously (seeSection 12.1), jEdit’s
implementation of BeanShell causes a number of classes to be automatically imported.
Classes that are not automatically imported must be identified by a full qualified name or
be the subject of animport statement.
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13.3.2. Create the Dialog

// create dialog object
title = “Add prefix and suffix to selected lines”;
dialog = new JDialog(view, title, false);
content = new JPanel(new BorderLayout());
content.setBorder(new EmptyBorder(12, 12, 12, 12));
dialog.setContentPane(content);

To get input for the macro, we need a dialog that provides for input of the prefix and
suffix strings, anOK button to perform text insertion, and aCancel button in case we
change our mind. We have decided to make the dialog window non-modal. This will
allow us to move around in the text buffer to find things we may need (including text to
cut and paste) while the macro is running and the dialog is visible.

The Java object we need is aJDialog object from the Swing package. To construct one,
we use thenew keyword and call aconstructorfunction. The constructor we use takes
three parameters: the owner of the new dialog, the title to be displayed in the dialog
frame, and aboolean parameter (true or false ) that specifies whether the dialog will
be modal or non-modal. We define the variabletitle using a string literal, then use it
immediately in theJDialog constructor.

A JDialog object is a window containing a single object called acontent pane. The
content pane in turn contains the various visible components of the dialog. AJDialog

creates an empty content pane for itself as during its construction. However, to control
the dialog’s appearance as much as possible, we will separately create our own content
pane and attach it to theJDialog . We do this by creating aJPanel object. AJPanel is a
lightweight container for other components that can be set to a given size and color. It
also contains alayoutscheme for arranging the size and position of its components. Here
we are constructing aJPanel as a content pane with aBorderLayout . We put a
EmptyBorder inside it to serve as a margin between the edge of the window and the
components inside. We then attach theJPanel as the dialog’s content pane, replacing the
dialog’s home-grown version.

A BorderLayout is one of the simpler layout schemes available for container objects
like JPanel . A BorderLayout divides the container into five sections: “North”, “South”,
“East”, “West” and “Center”. Components are added to the layout using the container’s
add method, specifying the component to be added and the section to which it is
assigned. Building a component like our dialog window involves building a set of nested
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containers and specifying the location of each of their member components. We have
taken the first step by creating aJPanel as the dialog’s content pane.

13.3.3. Create the Text Fields

// add the text fields
fieldPanel = new JPanel(new GridLayout(4, 1, 0, 6));
prefixField = new HistoryTextField("macro.add-prefix");
prefixLabel = new JLabel(“Prefix to add”:);
suffixField = new HistoryTextField(“macro.add-suffix”);
suffixLabel = new JLabel(“Suffix to add:”);
fieldPanel.add(prefixLabel);
fieldPanel.add(prefixField);
fieldPanel.add(suffixLabel);
fieldPanel.add(suffixField);
content.add(fieldPanel, “Center”);

Next we shall create a smaller panel containing two fields for entering the prefix and
suffix text and two labels identifying the input fields.

For the text fields, we will use jEdit’sHistoryTextField class. It is derived from the
Java Swing classJTextField . This class offers the enhancement of a stored list of prior
values used as text input. When the component has input focus, the up and down keys
scroll through the prior values for the variable.

To create theHistoryTextField objects we use a constructor method that takes a single
parameter: the name of the tag under which history values will be stored. Here we
choose names that are not likely to conflict with existing jEdit history items.

The labels that accompany the text fields areJLabel objects from the Java Swing
package. The constructor we use for both labels takes the label text as a singleString

parameter.

We wish to arrange these four components from top to bottom, one after the other. To
achieve that, we use aJPanel container object namedfieldPanel that will be nested
inside the dialog’s content pane that we have already created. In the constructor for
fieldPanel , we assign a newGridLayout with the indicated parameters: four rows,
one column, zero spacing between columns (a meaningless element of a grid with only
one column, but nevertheless a required parameter) and spacing of six pixels between
rows. The spacing between rows spreads out the four “grid” elements. After the
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components, the panel and the layout are specified, the components are added to
fieldPanel top to bottom, one “grid cell” at a time. Finally, the completefieldPanel

is added to the dialog’s content pane to occupy the “Center” section of the content pane.

13.3.4. Create the Buttons

// add the buttons
buttonPanel = new JPanel();
buttonPanel.setLayout(new BoxLayout(buttonPanel,

BoxLayout.X_AXIS));
buttonPanel.setBorder(new EmptyBorder(12, 50, 0, 50));
buttonPanel.add(Box.createGlue());
ok = new JButton(“OK”);
cancel = new JButton(“Cancel”);
ok.setPreferredSize(cancel.getPreferredSize());
dialog.getRootPane().setDefaultButton(ok);
buttonPanel.add(ok);
buttonPanel.add(Box.createHorizontalStrut(6));
buttonPanel.add(cancel);
buttonPanel.add(Box.createGlue());
content.add(buttonPanel, “South”);

To create the dialog’s buttons, we follow repeat the “nested container” pattern we used in
creating the text fields. First, we create a new, nested panel. This time we use a
BoxLayout that places components either in a single row or column, depending on the
parameter passed to its constructor. This layout object is more flexible than a
GridLayout in that variable spacing between elements can be specified easily. We put an
EmptyBorder in the new panel to set margins for placing the buttons. Then we create the
buttons, using aJButton constructor that specifies the button text. After setting the size
of theOK button to equal the size of theCancel button, we designate theOK button as
the default button in the dialog. This causes theOK button to be outlined when the dialog
if first displayed. Finally, we place the buttons side by side with a 6 pixel gap between
them (for aesthetic reasons), and place the completedbuttonPanel in the “South”
section of the dialog’s content pane.
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13.3.5. Register the Action Listeners

// register this method as an ActionListener for
// the buttons and text fields
ok.addActionListener(this);
cancel.addActionListener(this);
prefixField.addActionListener(this);
suffixField.addActionListener(this);

In order to specify the action to be taken upon clicking a button or pressing theEnter
key, we must register anActionListener for each of the four active components of the
dialog - the twoHistoryTextField components and the two buttons. In Java, an
ActionListener is aninterface- an abstract specification for a derived class to
implement. TheActionListener interface contains a single method to be implemented:

public void actionPerformed (ActionEvent e);

BeanShell does not permit a script to create derived classes. However, BeanShell offers a
useful substitute: a method can be used as a scripted object that can include nested
methods implementing a number of Java interfaces. The method
prefixSuffixDialog() that we are writing can thus be treated as anActionListener

object. To accomplish this, we calladdActionListener() on each of the four
components specifyingthis as theActionListener . We still need to implement the
interface. We will do that shortly.

13.3.6. Make the Dialog Visible

// locate the dialog in the center of the
// editing pane and make it visible
dialog.pack();
dialog.setLocationRelativeTo(view);
dialog.setDefaultCloseOperation(JDialog.DISPOSE_ON_CLOSE);
dialog.setVisible(true);

Here we do three things. First, we activate all the layout routines we have established by
calling thepack() method for the dialog as the top-level window. Next we center the
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dialog’s position in the active jEditview by callingsetLocationRelativeTo() on the
dialog. We also call thesetDefaultCloseOperation() function to specify that the
dialog box should be immediately disposed if the user clicks the close box. Finally, we
activate the dialog by callingsetVisible() with the state parameter set totrue .

At this point we have a decent looking dialog window that doesn’t do anything. Without
more code, it will not respond to user input and will not accomplish any text
manipulation. The remainder of the script deals with these two requirements.

13.3.7. The Action Listener

// this method will be called when a button is clicked
// or when ENTER is pressed
void actionPerformed(e)
{

if(e.getSource() != cancel)
{

processText();
}
dialog.dispose();

}

The methodactionPerformed() nested insideprefixSuffixDialog() implements
the implicit ActionListener interface. It looks at the source of theActionEvent ,
determined by a call togetSource() . What we do with this return value is
straightforward: if the source is not theCancel button, we call theprocessText()

method to insert the prefix and suffix text. Then the dialog is closed by calling its
dispose() method.

The ability to implement interfaces likeActionListener inside a BeanShell script is
one of the more powerful features of the BeanShell package. With anActionListener

interface, which has only a single method, implementation is simple. When using other
interfaces with multiple methods, however, there are some details to deal with that will
vary depending on the version of the Java platform that you are running. These
techniques are discussed in the next chapter; seeSection 14.4.3.
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13.3.8. Get the User’s Input

// this is where the work gets done to insert
// the prefix and suffix
void processText()
{

prefix = prefixField.getText();
suffix = suffixField.getText();
if(prefix.length() == 0 && suffix.length() == 0)

return;
prefixField.addCurrentToHistory();
suffixField.addCurrentToHistory();

The methodprocessText() does the work of our macro. First we obtain the input from
the two text fields with a call to theirgetText() methods. If they are both empty, there
is nothing to do, so the method returns. If there is input, any text in the field is added to
that field’s stored history list by callingaddCurrentToHistory() . We do not need to
test theprefixField or suffixField controls fornull or empty values because
addCurrentToHistory() does that internally.

13.3.9. Call jEdit Methods to Manipulate Text

// text manipulation begins here using calls
// to jEdit methods
buffer.beginCompoundEdit();
selectedLines = textArea.getSelectedLines();
for(i = 0; i < selectedLines.length; ++i)
{

offsetBOL = textArea.getLineStartOffset(
selectedLines[i]);

textArea.setCaretPosition(offsetBOL);
textArea.goToStartOfWhiteSpace(false);
textArea.goToEndOfWhiteSpace(true);
text = textArea.getSelectedText();
if(text == null) text = "";
textArea.setSelectedText(prefix + text + suffix);

}
buffer.endCompoundEdit();

}
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The text manipulation routine loops through each selected line in the text buffer. We get
the loop parameters by callingtextArea.getSelectedLines() , which returns an array
consisting of the line numbers of every selected line. The array includes the number of
the current line, whether or not it is selected, and the line numbers are sorted in
increasing order. We iterate through each member of theselectedLines array, which
represents the number of a selected line, and apply the following routine:

• Get the buffer position of the start of the line (expressed as a zero-based index from
the start of the buffer) by calling
textArea.getLineStartOffset(selectedLines[i]) ;

• Move the caret to that position by callingtextArea.setCaretPosition() ;

• Find the first and last non-whitespace characters on the line by calling
textArea.goToStartOfWhiteSpace() and
textArea.goToEndOfWhiteSpace() ;

ThegoTo... methods inJEditTextArea take a single parameter which tells jEdit
whether the text between the current caret position and the desired position should
be selected. Here, we calltextArea.goToStartOfWhiteSpace(false) so that no
text is selected, then calltextArea.goToEndOfWhiteSpace(true) so that all of
the text between the beginning and ending whitespace is selected.

• Retrieve the selected text by storing the return value of
textArea.getSelectedText() in a new variabletext .

If the line is empty,getSelectedText() will return null . In that case, we assign
an empty string totext to avoid calling methods on a null object.

• Change the selected text toprefix + text + suffix by calling
textArea.setSelectedText() . If there is no selected text (for example, if the line
is empty), the prefix and suffix will be inserted without any intervening characters.
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Compound edits

Note thebeginCompoundEdit() andendCompoundEdit() calls. These ensure
that all edits performed between the two calls can be undone in one step. Normally,
jEdit automatically wraps a macro call in these methods; however if the macro
shows a non-modal dialog box, as far as jEdit is concerned the macro has finished
executing by the time the dialog is shown, since control returns to the event
dispatch thread.

If you do not understand this, don’t worry; just keep it in mind if your macro needs
to show a non-modal dialog box for some reason; Most macros won’t.

13.3.10. The Main Routine

// this single line of code is the script’s main routine
prefixSuffixDialog();

The call toprefixSuffixDialog() is the only line in the macro that is not inside an
enclosing block. BeanShell treats such code as a top-levelmain method and begins
execution with it.

Our analysis ofAdd_Prefix_and_Suffix.bsh is now complete. In the next section, we
look at other ways in which a macro can obtain user input, as well as other macro writing
techniques.
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14.1. Getting Input for a Macro
The dialog-based macro discussed inChapter 13reflects a conventional approach to
obtaining input in a Java program. Nevertheless, it can be too lengthy or tedious for
someone trying to write a macro quickly. Not every macro needs a user interface
specified in such detail; some macros require only a single keystroke or no input at all. In
this section we outline some other techniques for obtaining input that will help you write
macros quickly.

14.1.1. Getting a Single Line of Text

As mentioned earlier inSection 12.2, the methodMacros.input() offers a convenient
way to obtain a single line of text input. Here is an example that inserts a pair of HTML
markup tags specified by the user.

// Insert_Tag.bsh

void insertTag()
{

caret = textArea.getCaretPosition();
tag = Macros.input(view, “Enter name of tag:”);
if( tag == null || tag.length() == 0) return;
text = textArea.getSelectedText();
if(text == null) text = “”;
sb = new StringBuffer();
sb.append(“<”).append(tag).append(“>”);
sb.append(text);
sb.append(“</”).append(tag).append(“>”);
textArea.setSelectedText(sb.toString());
if(text.length() == 0)

textArea.setCaretPosition(caret + tag.length() + 2);
}

insertTag();
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// end Insert_Tag.bsh

Here the call toMacros.input() seeks the name of the markup tag. This method sets
the message box title to a fixed string, “Macro input”, but the specific messageEnter
name of tag provides all the information necessary. The return valuetag must be tested
to see if it is null. This would occur if the user presses theCancel button or closes the
dialog window displayed byMacros.input() .

14.1.2. Getting Multiple Data Items

If more than one item of input is needed, a succession of calls toMacros.input() is a
possible, but awkward approach, because it would not be possible to correct early input
after the corresponding message box is dismissed. Where more is required, but a full
dialog layout is either unnecessary or too much work, the Java method
JOptionPane.showConfirmDialog() is available. The version to use has the following
prototype:

• public static int showConfirmDialog (Component parentComponent ,

Object message , String title , int optionType , int messageType );

The usefulness of this method arises from the fact that themessage parameter can be an
object of any Java class (since all classes are derived fromObject ), or any array of
objects. The following example shows how this feature can be used.

// excerpt from Write_File_Header.bsh

title = “Write file header”;

currentName = buffer.getName();

nameField = new JTextField(currentName);
authorField = new JTextField(“Your name here”);
descField = new JTextField(“”, 25);

namePanel = new JPanel(new GridLayout(1, 2));
nameLabel = new JLabel(“Name of file:”, SwingConstants.LEFT);
nameLabel.setForeground(Color.black);
saveField = new JCheckBox(“Save file when done”,
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!buffer.isNewFile());
namePanel.add(nameLabel);
namePanel.add(saveField);

message = new Object[9];
message[0] = namePanel;
message[1] = nameField;
message[2] = Box.createVerticalStrut(10);
message[3] = “Author’s name:”;
message[4] = authorField;
message[5] = Box.createVerticalStrut(10);
message[6] = “Enter description:”;
message[7] = descField;
message[8] = Box.createVerticalStrut(5);

if( JOptionPane.OK_OPTION !=
JOptionPane.showConfirmDialog(view, message, title,

JOptionPane.OK_CANCEL_OPTION,
JOptionPane.QUESTION_MESSAGE))

return null;

// *****remainder of macro script omitted*****

// end excerpt from Write_File_Header.bsh

This macro takes several items of user input and produces a formatted file header at the
beginning of the buffer. The full macro is included in the set of macros installed by jEdit.
There are a number of input features of this excerpt worth noting.

• The macro uses a total of seven visible components. Two of them are created
behind the scenes byshowConfirmDialog() , the rest are made by the macro. To
arrange them, the script creates an array ofObject objects and assigns components
to each location in the array. This translates to a fixed, top-to-bottom arrangement in
the message box created byshowConfirmDialog() .

• The macro usesJTextField objects to obtain most of the input data. The fields
nameField andauthorField are created with constructors that take the initial,
default text to be displayed in the field as a parameter. When the message box is
displayed, the default text will appear and can be altered or deleted by the user.
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• The text fielddescField uses an empty string for its initial value. The second
parameter in its constructor sets the width of the text field component, expressed as
the number of characters of “average” width. WhenshowConfirmDialog()

prepares the layout of the message box, it sets the width wide enough to
accommodate the designated with ofdescField . This technique produces a
message box and input text fields that are wide enough for your data with one line
of code.

• The displayed message box includes aJCheckBox component that determines
whether the buffer will be saved to disk immediately after the file header is written.
To conserve space in the message box, we want to display the check box to the right
of the labelName of file:. To do that, we create aJPanel object and populate it
with the label and the checkbox in a left-to-rightGridLayout . TheJPanel

containing the two components is then added to the beginning ofmessage array.

• The two visible components created byshowConfirmDialog() appear at positions
3 and 6 of themessage array. Only the text is required; they are rendered as text
labels. Note that the constructor sets the foreground colornameLabel to black. The
default text color ofJLabel objects is gray for Java’s default look-and-feel, so the
color was reset for consistency with the rest of the message box.

• There are three invisible components created byshowConfirmDialog() . Each of
them involves a call toBox.createVerticalStrut() . TheBox class is a
sophisticated layout class that gives the user great flexibility in sizing and
positioning components. Here we use astatic method of theBox class that
produces a verticalstruct. This is a transparent component whose width expands to
fill its parent component (in this case, the message box). The single parameter
indicates the fixed height of the spacing “strut” in pixels. The last call to
createVerticalStrut() separates the description text field from theOK and
Cancel buttons that are automatically added byshowConfirmDialog() .

• Finally, the call toshowConfirmDialog() uses defined constants for the option
type and the message type. The constants are the same as those used with the
Macros.confirm() method; seeSection 12.2. The option type signifies the use of
OK andCancel buttons. TheQUERY_MESSAGEmessage type causes the message
box to display a question mark icon.

The return value of the method is tested against the valueOK_OPTION. If the return
value is something else (because theCancel button was pressed or because the
message box window was closed without a button press), anull value is returned
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to a calling function, signaling that the user canceled macro execution. If the return
value isOK_OPTION, each of the input components can yield their contents for
further processing by calls toJTextField.getText() (or, in the case of the check
box,JCheckBox.isSelected() ).

14.1.3. Selecting Input From a List

Another useful way to get user input for a macro is to use a combo box containing a
number of pre-set options. If this is the only input required, one of the versions of
showInputDialog() in theJOptionPane class provides a shortcut. Here is its
prototype:

• public static Object showInputDialog (Component parentComponent ,

Object message , String title , int messageType , Icon icon ,

Object[] selectionValues , Object initialSelectionValue );

This method creates a message box containing a drop-down list of the options specified
in the method’s parameters, along withOK andCancel buttons. Compared to
showConfirmDialog() , this method lacks anoptionType parameter and has three
additional parameters: anicon to display in the dialog (which can be set tonull ), an
array ofselectionValues objects, and a reference to one of the options as the
initialSelectionValue to be displayed. In addition, instead of returning anint

representing the user’s action,showInputDialog() returns theObject corresponding to
the user’s selection, ornull if the selection is canceled.

The following macro fragment illustrates the use of this method.

// fragment illustrating use of showInputDialog()
options = new Object[5];
options[0] = "JLabel";
options[1] = "JTextField";
options[2] = "JCheckBox";
options[3] = "HistoryTextField";
options[4} = "-- other --";

result = JOptionPane.showInputDialog(view,
"Choose component class",
"Select class for input component",
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JOptionPane.QUESTION_MESSAGE,
null, options, options[0]);

The return valueresult will contain either theString object representing the selected
text item ornull representing no selection. Any further use of this fragment would have
to test the value ofresult and likely exit from the macro if the value equalednull .

A set of options can be similarly placed in aJComboBox component created as part of a
larger dialog orshowMessageDialog() layout. Here are some code fragments showing
this approach:

// fragments from Display_Abbreviations.bsh
// import statements and other code omitted

// from main routine, this method call returns an array
// of Strings representing the names of abbreviation sets

abbrevSets = getActiveSets();

...

// from showAbbrevs() method

combo = new JComboBox(abbrevSets);
// set width to uniform size regardless of combobox contents
Dimension dim = combo.getPreferredSize();
dim.width = Math.max(dim.width, 120);
combo.setPreferredSize(dim);
combo.setSelectedItem(STARTING_SET); // defined as "global"

// end fragments

14.1.4. Using a Single Keypress as Input

Some macros may choose to emulate the style of character-based text editors such as
emacs or vi. They will require only a single keypress as input that would be handled by
the macro but not displayed on the screen. If the keypress corresponds to a character
value, jEdit can pass that value as a parameter to a BeanShell script.
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The jEdit classInputHandler is an abstract class that that manages associations
between keyboard input and editing actions, along with the recording of macros.
Keyboard input in jEdit is normally managed by the derived class
DefaultInputHandler . One of the methods in theInputHandler class handles input
from a single keypress:

• public void readNextChar (String prompt , String code );

When this method is called, the contents of theprompt parameter is shown in the view’s
status bar. The method then waits for a key press, after which the contents of thecode

parameter will be run as a BeanShell script, with one important modification. Each time
the string__char__ appears in the parameter script, it will be substituted by the
character pressed. The key press is “consumed” byreadNextChar() . It will not be
displayed on the screen or otherwise processed by jEdit.

UsingreadNextChar() requires a macro within the macro, formatted as a single,
potentially lengthy string literal. The following macro illustrates this technique. It selects
a line of text from the current caret position to the first occurrence of the character next
typed by the user. If the character does not appear on the line, no new selection occurs
and the display remains unchanged.

// Next_Char.bsh

script = new StringBuffer(512);
script.append( "start = textArea.getCaretPosition();" );
script.append( "line = textArea.getCaretLine();" );
script.append( "end = textArea.getLineEndOffset(line) + 1;" );
script.append( "text = buffer.getText(start, end - start);" );
script.append( "match = text.indexOf(__char__, 1);" );
script.append( "if(match != -1) {" );
script.append( "if(__char__ != ’\\n’) ++match;" );
script.append( "textArea.select(start, start + match - 1);" );
script.append( "}" );

view.getInputHandler().readNextChar("Enter a character",
script.toString());

// end Next_Char.bsh

Once again, here are a few comments on the macro’s design.
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• A StringBuffer object is used for efficiency; it obviates multiple creation of
fixed-lengthString objects. The parameter to the constructor ofscript specifies
the initial size of the buffer that will receive the contents of the child script.

• Besides the quoting of the script code, the formatting of the macro is entirely
optional but (hopefully) makes it easier to read.

• It is important that the child script be self-contained. It does not run in the same
namespace as the “parent” macroNext_Char.bsh and therefore does not share
variables, methods, or scripted objects defined in the parent macro.

• Finally, access to theInputHandler object used by jEdit is available by calling
getInputHandler() on the current view.

14.2. Startup Scripts
On startup, jEdit runs any BeanShell scripts located in thestartup subdirectory of the
jEdit installation and user settings directories (seeSection 6.4). As with macros, the
scripts must have a.bsh file name extension. Startup scripts are run near the end of the
startup sequence, after plugins, properties and such have been initialized, but before the
first view is opened.

Startup scripts can perform initialization tasks that cannot be handled by command line
options or ordinary configuration options, such as customizing jEdit’s user interface by
changing entries in the Java platform’sUIManager class.

Startup scripts have an additional feature lacking in ordinary macros that can help you
further customize jEdit. Variables and methods defined in a startup script are available in
all instances of the BeanShell interpreter created in jEdit. This allows you to create a
personal library of methods and objects that can be accessed at any time during the
editing session in another macro, the BeanShell shell of the Console plugin, or menu
items such asUtilities>Evaluate BeanShell Expression.

The startup script routine will run script files in the installation directory first, followed
by scripts in the user settings directory. In each case, scripts will be executed in
alphabetical order, applied without regard to whether the file name contains upper or
lower case characters.

If a startup script throws an exception (because, for example, it attempts to call a method
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on anull object). jEdit will show an error dialog box and move on to the next startup
script. If script bugs are causing jEdit to crash or hang on startup, you can use the
-nostartupscripts command line option to disable them for that editing session.

Another important difference between startup scripts and ordinary macros is that startup
scripts cannot use the pre-defined variablesview , textArea , editPane andbuffer .
This is because they are executed before the initial view is created.

If you are writing a method in a startup script and wish to use one of the above variables,
pass parameters of the appropriate type to the method, so that a macro calling them after
startup can supply the appropriate values. For example, a startup script could include a
method

void doSomethingWithView(View v, String s) {
...

}

so that during the editing session another macro can call the method using

doSomethingWithView(view, "something");

Reloading startup scripts without restarting

It is actually possible to reload startup scripts or load other scripts without
restarting jEdit, using a BeanShell statement like the following:

BeanShell.runScript(view, path ,false,false);

For path , you can substitute any string, or a method call such as
buffer.getPath() .

14.3. Running Scripts from the Command Line
The-run command line switch specifies a BeanShell script to run on startup:

$ jedit -run=test.bsh
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Note that just like with startup scripts, theview , textArea , editPane andbuffer

variables are not defined.

If another instance is already running, the script will be run in that instance, and you will
be able to use thejEdit.getLastView() method to obtain a view. However, if a new
instance of jEdit is being started, the script will be run at the same time as all other
startup scripts; that is, before the first view is opened.

If your script needs a view instance to operate on, you can use the following code pattern
to obtain one, no matter how or when the script is being run:

void doSomethingUseful()
{

void run()
{

view = jEdit.getLastView();

// put actual script body here
}

if(jEdit.getLastView() == null)
VFSManager.runInAWTThread(this);

else
run();

}

doSomethingUseful();

If the script is being run in a loaded instance, it can be invoked to perform its work
immediately. However, if the script is running at startup, before an initial view exists, its
operation must be delayed to allow the view object first to be created and displayed. In
order to queue the macro’s operation, the scripted “closure” named
doSomethingUseful() implements theRunnable interface of the Java platform. That
interface contains only a singlerun() method that takes no parameters and has no return
value. The macro’s implementation of therun() method contains the “working” portion
of the macro. Then the scripted object, represented by a reference tothis , is passed to
therunInAWTThread() method. This schedules the macro’s operations for execution
after the startup routine is complete.

As this example illustrates, therunInAWTThread() method can be used to ensure that a
macro will perform operations after other operations have completed. If it is invoked
during startup, it schedules the specifiedRunnable object to run after startup is
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complete. If invoked when jEdit is fully loaded, theRunnable object will execute after
all pending input/output is complete, or immediately if there are no pending I/O
operations. This will delay operations on a new buffer, for example, until after the buffer
is loaded and displayed.

14.4. Advanced BeanShell Techniques
BeanShell has a few advanced features that we haven’t mentioned yet. They will be
discussed in this section.

14.4.1. BeanShell’s Convenience Syntax

We noted earlier that BeanShell syntax does not require that variables be declared or
defined with their type, and that variables that are not typed when first used can have
values of differing types assigned to them. In addition to this “loose” syntax, BeanShell
allows a “convenience” syntax for dealing with the properties of JavaBeans. They may
be accessed or set as if they were data members. They may also be accessed using the
name of the property enclosed in quotation marks and curly brackets. For example, the
following statement are all equivalent, assumingbtn is aJButton instance:

b.setText("Choose");
b.text = "Choose";
b{"text"} = "Choose";

The last form can also be used to access a key-value pair of aHashtable object. It can
even be used to obtain the values of buffer-local properties; the following two statements
are equivalent:

buffer.getProperty("tabSize")
buffer{"tabSize"}

14.4.2. Special BeanShell Keywords

BeanShell uses special keywords to refer to variables or methods defined in the current
or an enclosing block’s scope:
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• The keywordthis refers to the current scope.

• The keywordsuper refers to the immediately enclosing scope.

• The keywordglobal refers to the top-level scope of the macro script.

The following script illustrates the use of these keywords:

a = "top\n";
foo() {

a = "middle\n";
bar() {

a = "bottom\n";
textArea.setSelectedText(global.a);
textArea.setSelectedText(super.a);
// equivalent to textArea.setSelectedText(this.a):
textArea.setSelectedText(a);

}

bar();
}
foo();

When the script is run, the following text is inserted in the current buffer:

top
middle
bottom

14.4.3. Implementing Interfaces

As discussed in the macro example inChapter 13, scripted objects can implement Java
interfaces such asActionListener . Which interfaces may be implemented varies
depending upon the version of the Java runtime environment being used. If running
under Java 1.1 or 1.2, BeanShell objects can only implement the AWT or Swing event
listener interfaces contained in thejava.awt.event andjavax.swing.event

packages, along with thejava.lang.Runnable interface. If BeanShell is running under
Java 1.3 or 1.4, which jEdit 4.0 requires, any interface can be implemented.

Frequently it will not be necessary to implement all of the methods of a particular
interface in order to specify the behavior of a scripted object. Under Java 1.3 and above,
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the virtual machine’s reflection mechanism will throw an exception for any missing
interface methods. This will bring macro execution to a halt unless the exception is
trapped and handled. The better solution is to implement theinvoke() method, which is
called when an undefined method is invoked on a scripted object. Typically, the
implementation of this method will do nothing, as in the following example:

invoke(method, args) {}

14.4.4. BeanShell Commands

BeanShell comes with a large number of built-in scripted “commands” that are useful in
many circumstances. Documentation for commands that are helpful when writing
macros can be found inChapter 18.

14.5. Debugging Macros
Here are a few techniques that can prove helpful in debugging macros.

14.5.1. Identifying Exceptions

An exceptionis a condition reflecting an error or other unusual result of program
execution that requires interruption of normal program flow and some kind of special
handling. Java has a rich (and extensible) collection of exception classes which represent
such conditions.

jEdit catches exceptions thrown by BeanShell scripts and displays them in a dialog box.
In addition, the full traceback is written to the activity log (seeAppendix Bfor more
information about the activity log).

There are two broad categories of errors that will result in exceptions:

• Interpreter errors, which may arise from typing mistakes like mismatched brackets
or missing semicolons, or from BeanShell’s failure to find a class corresponding to
a particular variable.
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Interpreter errors are usually accompanied by the line number in the script, along
with the cause of the error.

• Execution errors, which result from runtime exceptions thrown by the Java
platform when macro code is executed.

Some exceptions thrown by the Java platform can often seem cryptic. Nevertheless,
examining the contents of the activity log may reveals clues as to the cause of the
error.

14.5.2. Using the Activity Log as a Tracing Tool

Sometimes exception tracebacks will say what kind of error occurred but not where it
arose in the script. In those cases, you can insert calls that log messages to the activity
log in your macro. If the logged messages appear when the macro is run, it means that up
to that point the macro is fine; but if an exception is logged first, it means the logging call
is located after the cause of the error.

To write a message to the activity log, use the following method of theLog class:

• public static void log (int urgency , Object source , Object

message );

The parameterurgency can take one of the following constant values:

• Log.DEBUG

• Log.MESSAGE

• Log.NOTICE

• Log.WARNING

• Log.ERROR

Note that theurgency parameter merely changes the string prefixed to the log message;
it does not change the logging behavior in any other way.
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The parametersource can be either an object or a class instance. When writing log
messages from macros, set this parameter toBeanShell.class to make macro errors
easier to spot in the activity log.

The following code sends a typical debugging message to the activity log:

Log.log(Log.DEBUG, BeanShell.class,
"counter = " + String.valueOf(counter));

The corresponding activity log entry might read as follows:

[debug] BeanShell: counter = 15

Using message dialog boxes as a tracing tool

If you would prefer not having to deal with the activity log, you can use the
Macros.message() method as a tracing tool. Just insert calls like the following in
the macro code:

Macros.message(view,"tracing");

Execution of the macro is halted until the message dialog box is closed. When you
have finished debugging the macro, you should delete or comment out the
debugging calls toMacros.message() in your final source code.
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IV. Writing Plugins
This part of the user’s guide covers writing plugins for jEdit.

Like jEdit itself, plugins are written primarily in Java. While this guide assumes some
working knowledge of the language, you are not required to be a Java wizard. If you can
write a useful application of any size in Java, you can write a plugin.

This part of the user’s guide was written by John Gellene <jgellene@nyc.rr.com >.





Chapter 15. Introducing the Plugin
API

The jEdit Plugin APIprovides a framework for hosting plugin applications without
imposing any requirements on the design or function of the plugin itself. You could write
a application that performs spell checking, displays a clock or plays chess and turn it into
a jEdit plugin. There are currently over 50 released plugins for jEdit. While none of them
play chess, they perform a wide variety of editing and file management tasks. A detailed
listing of available plugins is available at the jEdit Plugin Central
(http://plugins.jedit.org) web site. You can also find beta versions of new plugins in the
“Downloads” area of the jEdit Community (http://community.jedit.org) site.

Using the “Plugin Manager” feature of jEdit, users with an Internet connection can check
for new or updated plugins and install and remove them without leaving jEdit. See
Chapter 8for details.

In order to “plug in” to jEdit, a plugin must implement interfaces or data that deal with
the following matters:

• This plugin must supply information about itself, such as its name, version, author,
and compatibility with versions of jEdit.

• The plugin must provide for activating, displaying and deactivating itself upon
direction from jEdit, typically in response to user input.

• The plugin may, but need not, provide a user interface.

If the plugin has a visible interface, it can be shown in any object derived from one
of Java top-level container classes:JWindow , JDialog , or JFrame . jEdit also
provides a dockable window API, which allows plugin windows derived from the
JComponent to be docked into views or shown in top-level frames, at the user’s
request.

Plugins can also act directly upon jEdit’s text area. They can add graphical elements
to the text display (like error highlighting in the case of the ErrorList plugin) or
decorations surrounding the text area (like the JDiff plugin’s summary views).
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• Plugins may (and typically do) defineactionsthat jEdit will perform on behalf of
the plugin upon user request. Actions are small blocks of BeanShell code that
provide the “glue” between user input and specific plugin routines.

By convention, plugins display their available actions in submenus of jEdit’s
Plugins menu; each menu item corresponds to an action. The user can also assign
actions to keyboard shortcuts, toolbar buttons or entries in the text area’s right-click
menu.

• Plugins may provide a range of options that the user can modify to alter its
configuration.

If a plugin provides configuration options in accordance with the plugin API, jEdit
will make them available in theGlobal Options dialog. Each plugin with options is
listed in the tree view in that dialog underPlugin Options. Clicking on the tree
node for a plugin causes the corresponding set of options to be displayed.

As noted, many of these features are optional; it is possible to write a plugin that does
not provide actions, configuration options, or dockable windows. The majority of
plugins, however, provide most of these services.

In the following chapters, we will begin by briefly describing jEdit’s host capabilities,
which includes the loading and display of plugins. Next we will describe the principal
classes and data structures that a plugin must implement. Finally, we will outline the
building of a modest plugin, “QuickNotepad”, that illustrates the requirements and some
of the techniques of jEdit plugin design.
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Plugins and different jEdit versions

As jEdit continues to evolve and improve, elements of the plugin API or jEdit’s
general API may change with a new jEdit release. For example, version 4.0 of jEdit
has simplified the design of a plugin by placing code for the activation of a plugin’s
docking window in an XML file rather than in a Java class. The use of a Java
interface for docking windows has been deprecated. We will explain this and other
changes in the plugin API for jEdit 4.0 when discussing the model QuickNotepad
plugin.

On occasion an API change will break code used by plugins, although efforts are
made to maintain or deprecate plugin-related code on a transitional basis. possible.
While the majority of plugins are unaffected by most changes and will continue
working, it is a good idea to monitor the jEdit change log, the mailing lists or jEdit
Community (http://community.jedit.org) for API changes and update your plugin
as necessary.

169



Chapter 15. Introducing the Plugin API

170



Chapter 16. jEdit as a Plugin Host
A good way to start learning what a plugin requires is to look at what the host
application does with one. We start our discussion of plugins by outlining how jEdit
loads and displays them. This section only provides a broad overview of the more
important components that make up jEdit; specifics of the API will be documented in
subsequent chapters.

16.1. Loading Plugins
As part of its startup routine, jEdit’smain method calls various methods to load and
initialize plugins. This occurs after the application has done the following:

• parsed command line options;

• started the edit server (unless instructed not to do so by a command line option)
and;

• loaded application properties, any user-supplied properties, and the application’s
set of actions that will be available from jEdit’s menu bar (as well as the toolbar and
keyboard shortcuts);

Plugin loading occurs before jEdit creates any windows or loads any files for editing. It
also occurs before jEdit runs any startup scripts.

16.1.1. The JARClassLoader

Plugins are loaded from files with the.jar filename extension located in thejars

subdirectories of the jEdit installation and user settings directories (seeSection 6.4).

For each JAR archive file it finds, jEdit creates an instance of theJARClassLoader class.
This is a jEdit-specific class that implements the Java platform’s abstract class
ClassLoader . The constructor for theJARClassLoader object does the following:

• Reads action definitions from any file namedactions.xml in the archive (the file
need not be at the top level). SeeSection 16.2.2.
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• Parses and loads the contents of any file nameddockables.xml in the archive (the
file need not be at the top level). This file contains BeanShell code for creating
docking or floating windows that will contain the visible components of the plugin.
Not all plugins define dockable windows, but those that do need adockables.xml

file. SeeSection 16.2.3.

• Loads any properties defined in files ending with the extension.props that are
contained in the archive. SeeSection 16.2.1.

• Adds any class file with a name ending withPlugin.class to an internal
collection of plugin class names maintained by theJARClassLoader . SeeSection
16.1.3.

• Adds to a collection maintained by jEdit a new object of typeEditPlugin.JAR .
This is a data structure holding the name of the JAR archive file, a reference to the
JARClassLoader and a collection, initially empty, of plugins found in the archive
file.

Once all JAR files have been examined for the above resources, jEdit initializes all class
files whose names end inPlugin.class , as identified in the first pass through the JAR
archive. We will call these classesplugin core classes. They provide the principal point
of contact between jEdit and the plugin. A plugin core class must extend jEdit’s abstract
EditPlugin class. Use of a class name ending inPlugin is also required.

For each plugin core class, the initialization routine first checks the plugin’s properties to
see if it is subject to any dependencies. For example, a plugin may require that the
version of the Java runtime environment or of jEdit itself be equal to or above some
threshold version. A plugin can also require the presence of another plugin or a particular
class from another archive. If any dependency is not satisfied, the loader marks the
plugin as “broken” and logs an error message.

If all dependencies are satisfied, a new instance of the plugin core class is created and
added to the collection maintained by the appropriateEditPlugin.JAR object. By
accessing that object, jEdit can keep track of plugins it has successfully loaded, and call
methods or perform routines on them.
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Additional class libraries for plugins

JAR files with no plugin core classes are also loaded by jEdit; no special
initialization is performed on them, and the classes they contain are made available
to other plugins. For example, many plugins that rely on third-party class libraries
ship them as separate JAR archives. The libraries will be available inside the jEdit
environment but are not part of a general classpath or library collection when
running other Java applications.

A plugin that bundles extra JAR archives must define a property that lists these
JAR files in order for the plugin manager to be able to remove the plugin
completely. SeeSection 16.2.1.

16.1.2. Starting the Plugin

After creating and storing the plugin core object, jEdit calls thestart() method of the
plugin core class. Thestart() method can perform initialization of the object’s data
members. Because this method is defined as an empty “no-op” in theEditPlugin

abstract class, a plugin need not provide an implementation if no unique initialization is
required.

16.1.3. The EditPlugin Class

Recall that this abstract class is the base for every plugin core class. Its methods provide
for basic interaction between the plugin and jEdit. The class has four methods which are
called by jEdit at various times. None of these methods are required to be implemented,
but most plugins will override at least one.

• public void start ();

The jEdit startup routine calls this method for each loaded plugin. Plugins typically
use this method to register information with the EditBus and perform other
initialization.
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• public void stop ();

When jEdit is exiting, it calls this method on each plugin. If a plugin uses or creates
state information or other persistent data that should be stored in a special format,
this would be a good place to write the data to storage. If you use jEdit’s properties
API to hold “key-value” type settings for your plugins, no special processing is
needed for them, since jEdit loads application properties automatically at startup
and writes them to theproperties file in the user’s settings directory when the
application exits. Most plugins find this approach sufficient for saving settings.

• public void createMenuItems (Vector menuItems );

When aView object is created, it calls this method on each plugin core class to
obtain entries to be displayed in the view’sPlugins menu. ThemenuItems
parameter is aVector that accumulates menu items and menus as it is passed from
plugin to plugin.

While jEdit does not require a plugin to supply menu items, a plugin’s usefulness
would be extremely limited without them. The easiest way to provide menu items is
to package them as entries in the plugin’s property file and implement
createMenuItems() with a call to jEdit’sGUIUtilities.loadMenu() method.
The following code illustrates this approach:

public void createMenuItems(Vector menuItems)
{

menuItems.addElement(GUIUtilities.loadMenu(
"myplugin.menu"));

}

The parameter passed toloadMenu() is the name of a property defined in the
plugin’s own property file that contains menu data. The form of the property entry is
a list of labels that in turn correspond to other property names and ultimately to the
actual text for menu items as well as implementation code. We will detail the format
of the menu data inSection 17.2.3.2

TheGUIUtilities.loadMenuItem() method is also available for plugins that
only wish to add a single menu item to thePlugins menu. The parameter names a
property that points to label text in the plugin’s properties file and implementing
code in the plugin’sactions.xml file.
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• public void createOptionPanes (OptionsDialog dialog );

This method is called for each plugin during the creation of theGlobal Options
dialog box. To show an option pane, the plugin should define an option pane class
and implementcreateOptionPane() as follows:

dialog.addOptionPane(new MyPluginOptionPane());

Plugins can also define more than one option pane, grouped in an “option group”.

This class defines two other methods which may be useful to some plugins or for
debugging purposes. They are fully implemented in the parent class and used mainly by
jEdit’s core code.

• public String getClassName ();

This shortcut method returnsgetClass().getName() .

• public EditPlugin.JAR getJAR ();

This method returns theEditPlugin.JAR data object associated with the plugin.

16.2. Plugin Resources

16.2.1. Plugin Properties

jEdit maintains a list of “properties”, which are name/value pairs used to store
human-readable strings, user settings, and various other forms of meta-data. During
startup, jEdit loads the default set of properties, followed by plugin properties stored in
plugin JAR files, finally followed by user properties. Plugins can access properties from
all three sources.
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Property files contained in plugin JARs must end with the filename extension.props ,
and have a very simple syntax, which the following example illustrates:

# Lines starting with ’#’ are ignored.
name=value
another.name=another value
long.property=Long property value, split over \

several lines
escape.property=Newlines and tabs can be inserted \

using the \t and \n escapes
backslash.property=A backslash can be inserted by writing \\.

The following types of plugin information are supplied using properties:

• Information regarding the name, author, and version of the plugin. This information
is required. Here is an example:

plugin.MyPlugin.name=My Plugin
plugin.MyPlugin.author=Jay Edit
plugin.MyPlugin.version=1.0.3

Note that each property is prefixed withplugin. , followed by the fully qualified
name of the plugin core class (including a package name, if there is one).

• Identification of any dependencies the plugin may have on a particular version of a
Java runtime environment, the jEdit application, or other plugins.

Each dependency is defined in a property prefixed withplugin. class

name.depend. , followed by a number. Dependencies must be numbered in order,
starting from zero.

The value of a dependency property is one of the wordsjdk , jedit , or plugin ,
followed by a Java version number, a jEdit build number, or plugin class name and
plugin version number, respectively.

Here are some examples:

plugin.MyPlugin.depend.0=jdk 1.4
plugin.MyPlugin.depend.1=jedit 04.00.99.00
plugin.MyPlugin.depend.2=plugin console.ConsolePlugin 3.2.1
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• A list of external class library JARs shipped with the plugin. If your plugin bundles
extra JARs, this property is required for the plugin manager to be able to remove the
plugin completely.

The property is a space-separated list of filenames. Here is an example:

plugin.xslt.XSLTPlugin.jars=xml-apis.jar xalan.jar

• Labels for user actions for inclusion in menus and option panes relating to toolbars
and keyboard shortcuts.

Action labels are defined in properties named by the action’s internal name as
specified in the action catalog, followed by.label :

myplugin.label=My Plugin
myplugin-grok.label=Grok Current Buffer

• The list of menu items contained in plugin menus, if any.

This is discussed in detail inSection 17.2.3.2.

• Labels and other information regarding the controls contained in the plugin’s
windows. These properties can be named any way you like, however take care not
to choose names which may conflict with those in other plugins.

• The titles of dockable windows, as displayed in a tabbed or floating container.

These labels are specified in properties named by the dockable window’s identifier
(as specified in thedockables.xml file, seeSection 16.2.3), suffixed with.title .
For example:

quick-notepad.title=QuickNotepad
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16.2.2. The Action Catalog

Actions define procedures that can be bound to a menu item, a toolbar button or a
keyboard shortcut. They can perform any task encompassed in a public method of any
class currently loaded in jEdit, including plugin classes and classes of the host
application. Among other things, they can cause the appearance and disappearance of
plugin windows.

To manage user actions, jEdit maintains a lookup table of actions using descriptive
strings as keys. The values in the table are sets of statements written in BeanShell, jEdit’s
macro scripting language. These scripts either direct the action themselves, delegate to a
method in one of the plugin’s classes that encapsulates the action, or do a little of both.
The scripts are usually short; elaborate action protocols are usually contained in
compiled code, rather than an interpreted macro script, to speed execution.

Actions are defined by creating an XML file entitledactions.xml and placing it in the
plugin JAR file. A sample action catalog looks like so:

<!DOCTYPE ACTIONS SYSTEM "actions.dtd">

<ACTIONS>
<ACTION NAME="quicknotepad.choose-file">

<CODE>
view.getDockableWindowManager()

.getDockable(QuickNotepadPlugin.NAME).chooseFile();
</CODE>

</ACTION>

<ACTION NAME="quicknotepad.save-file">
<CODE>

view.getDockableWindowManager()
.getDockable(QuickNotepadPlugin.NAME).saveFile();

</CODE>
</ACTION>

<ACTION NAME="quicknotepad.copy-to-buffer">
<CODE>

view.getDockableWindowManager()
.getDockable(QuickNotepadPlugin.NAME).copyToBuffer();

</CODE>
</ACTION>

</ACTIONS>
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The defined elements have the following functions:

• ACTIONSis the top-level element and refers to the set of actions used by the plugin.

• An ACTIONcontains the data for a particular action. It has three attributes: a
requiredNAME; an optionalNO_REPEAT, which is a flag indicating whether the action
should not be repeated with theControl -Enter command (seeSection 2.4); and an
optionalNO_RECORDwhich is a a flag indicating whether the action should be
recorded if it is invoked while a user is recording a macro. The two flag attributes
can have two possible values, “TRUE” or “FALSE”. In both cases, “FALSE” is the
default if the attribute is not specified.

• An ACTIONcan have two child elements within it: a requiredCODEelement which
specifies the BeanShell code that will be executed when the action is invoked, and
an optionalIS_SELECTEDelement, used for checkbox menu items. The
IS_SELECTEDelement contains BeanShell code that returns a boolean flag that will
determine the state of the checkbox.

More discussion of the action catalog can be found inSection 17.2.3.1.

16.2.3. The Dockable Definition File

The jEdit Plugin API uses BeanShell to create the top-level visible container of a
plugin’s interface. The BeanShell code is contained in a file nameddockables.xml . It
usually is quite short, providing only a single BeanShell expression used to create a
visible plugin window.

The following example from the QuickNotepad plugin illustrates the requirements of the
data file:

<?xml version="1.0"?>

<!DOCTYPE DOCKABLES SYSTEM "dockables.dtd">

<!-- QuickNotepad dockable windows -->

<DOCKABLES>
<DOCKABLE NAME="quicknotepad">

new QuickNotepad(view, position);
</DOCKABLE>
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</DOCKABLES>

In this example, the<DOCKABLE>element has a single attribute, the dockable window’s
identifier. This attribute is used to key a property where the window title is stored; see
Section 16.2.1. The contents of the<DOCKABLE>element itself is a BeanShell expression
that constructs a newQuickNotepad object. Theview andposition are predefined by
the Plugin API as the view in which the plugin window will reside and the docking
position of the plugin.

16.2.4. Plugin Documentation

While not required by the plugin API, a help file is an essential element of any plugin
written for public release. A single web page is often all that is required. There are no
specific requirements on layout, but because of the design of jEdit’s help viewer, the use
of frames should be avoided. Topics that would be useful include the following:

• a description of the purpose of the plugin;

• an explanation of the type of input the user can supply through its visible interface
(such as mouse action or text entry in controls);

• a listing of available user actions that can be taken when the plugin does not have
input focus;

• a summary of configuration options;

• information on development of the plugin (such as a change log, a list of “to do”
items, and contact information for the plugin’s author); and

• licensing information, including acknowledgments for any library software used by
the plugin.

The location of the plugin’s help file should be stored in theplugin. class name .docs

property.

16.3. The User Interface of a Plugin
To display a user interface, plugins provide a top-level component derived (directly or
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indirectly) from the SwingJComponent class. This component will be embedded in a
docking of floating window created by the Plugin API. It is typically defined in a class
that is part of the plugin package but separate from the plugin core class (if one exists).

16.3.1. The Role of the View Object

A View is jEdit’s top-level frame window. The largest component it contains is an edit
pane that in turn contains a text area that displays a buffer. A view can have more than
one edit pane in a split window configuration. The view also contains a menu bar, an
optional toolbar and other window decorations, as well as docked windows.

TheView class performs two important operations dealing with plugins: creating plugin
menu items, and managing dockable windows.

When a view is being created, its initialization routine iterates through the collection of
loaded plugins and calls thecreateMenuItems() method of each plugin core class. In
the parent class,EditPlugin , this method is an empty “no-op”. In order to add items to
jEdit’s menu bar under thePlugins menu, the plugin core class must supply its own
version ofcreateMenuItems() . As we will explain inSection 16.1.3, the typical plugin,
instead of creating JavaJMenu andJMenuItem objects directly, relies on a wrapper
method in a utility class to create menu entries.

TheView also creates and initializes aDockableWindowManager object. This object is
responsible for creating, closing and managing dockable windows. It will be discussed in
more detail below.

Finally, theView andDockableWindowManager classes contain a number of methods
that can be called from plugins; seeSection 19.2andSection 19.11for details.

16.3.2. The DockableWindowManager

TheDockableWindowManager in eachView object keeps track of docked and floating
windows. When theView object initializes itsDockableWindowManager , the manager
iterates through the list of registered dockable windows and examines options supplied
by the user in theGlobal Options dialog box. It displays any plugins that the user
designated for one of the four docking positions when the corresponding button a
docking pane is selected.
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To create an instance of a dockable window, theDockableWindowManager finds and
executes the BeanShell code extracted from the plugin’sdockables.xml file during
application startup. This code will typically consist of a call to the constructor of the
docking window component that passes two parameters: theView associated with the
docking window component, and aString representing the component’s docking or
floating position. The result of the BeanShell expression, typically a newly constructed
component, is placed inside the docking or floating window managed by the
DockableWindowManager .

Eventually theDockableWindowManager destroys the plugin window, whether docking
or floating, in response to user action or as part of the destruction of the corresponding
View object.

With this broad outline of how jEdit behaves as a plugin host in the background, we will
next review the programming elements that make up a plugin.

16.4. The EditBus
The EditBus maintains a list of objects that have requested to receive messages. When a
message is sent using this class, all registered components receive it in turn.

Plugins register with the EditBus to receive messages reflecting changes in the
application’s state, including changes in buffers, views and editing panes, changes in the
set of properties maintained by the application, and the closing of the application. A full
list of message classes used by the EditBus are summarized beginning withSection 20.3.

Classes for objects that subscribe to the EditBus must implement theEBComponent

interface, which defines the single methodhandleMessage() . A View , for example, can
receive and handle EditBus messages because it also implementsEBComponent.

Any class in a plugin can receive messages by implementing theEBComponent interface.
A “plugin core class” that extends theEBPlugin abstract class (and whose name ends
with “Plugin” for identification purposes) will automatically be added to the EditBus
during jEdit’s startup routine. Any other class - for example, a docking window
component that needs to receive notification of buffer changes - must perform its own
registration by callingEditBus.addToBus(this) during its initialization. If this class if
derived fromJComponent , a convenient place to register would be in an implementation
of theJComponent methodaddNotify() .
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16.4.1. Class EBMessage

Every plugin class that uses the EditBus for receiving messages must implement this
interface.

TheEBComponent interface contains a single method that an implementing class
(including any class derived fromEBPlugin ) must provide:

• public void handleMessage (EBMessage message );

The parameter’s type,EBMessage, is another abstract class which establishes the core
elements of any message that is published to the EditBus. It has two attributes: an
EBComponent that is the source of the message (the source will benull in some cases),
and aboolean data member,vetoed . This flag indicates whether a prior recipient of the
message has determined that the message has been handled and need not be passed on to
other subscribers. The flag is set by a call to theveto() method of theEBMessage. Some
message classes, however, are configured so that they cannot be vetoed, to ensure they
are received by all subscribers.

Message classes extendingEBMessage typically add other data members and methods to
provide subscribers with whatever is needed to handle the message appropriately.
Descriptions of specific message classes can be found inChapter 20.

ThehandleMessage() method must specify the type of responses the plugin will have
for various subclasses of theEBMessage class. Typically this is done with one or more
if blocks that test whether the message is an instance of a derived message class in
which the plugin has an interest, as in the following example:

if(msg instanceof BufferUpdate) {
// a buffer’s state has changed!

}
else if(msg instanceof ViewUpdate) {

// a view’s state has changed!
}
// ... and so on

Note that any object, whether or not derived fromEBComponent, can send a message to
the EditBus by calling the static methodEditBus.send() . This method takes a single
parameter, anEBMessage object that is the message being sent. Most plugins, however,
will only concern themselves with receiving, not sending, messages.
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16.5. Conclusion
At this point, we can identify the following practical requirements for a plugin:

• it must be packaged as one or more JAR archives and contain a class file ending
with the prefixPlugin that extends theEditPlugin abstract class;

• the archive must contain at least one properties file having a.props extension.
Certain properties giving information about the plugin must be defined.

• if the plugin will provide a visible interface, the JAR archive must contain an XML
data file nameddockables.xml containing BeanShell code for creating a container
for that interface;

• the JAR archive may contain data concerning actions for display in jEdit’s menu
bar and elsewhere in a file entitledactions.xml ; and

• if the plugin must respond as a whole to changes in the state of the jEdit
application, the plugin core class should be derived from theEBPlugin class instead
of directly fromEditPlugin

We will provide more detail on these requirements later.
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One way to organize a plugin project is to design the software as if it were a “stand
alone” application, with three exceptions:

• The plugin can access theView object with which it is associated, as well as static
methods of thejEdit class, to obtain and manipulate various data and host
application objects;

• If the plugin has visible components, they are ultimately contained in aJPanel

object instead of a top-level frame window; and

• The plugin implements the necessary elements of the jEdit plugin API that were
outlined in the last chapter: a plugin core class, perhaps a number of plugin window
classes, maybe a plugin option pane class, and a set of required plugin resources.

Not every plugin has configurable options; some do not have a visible window.
However, all will need a plugin core class and a minimum set of other resources.

We will now illustrate this approach by introducing an example plugin.

17.1. QuickNotepad: An Example Plugin
There are many applications for the leading operating systems that provide a
“scratch-pad” or “sticky note” facility for the desktop display. A similar type of facility
operating within the jEdit display would be a convenience. The use of docking windows
would allow the notepad to be displayed or hidden with a single mouse click or keypress
(if a keyboard shortcut were defined). The contents of the notepad could be saved at
program exit (or, if earlier, deactivation of the plugin) and retrieved at program startup or
plugin activation.

We will keep the capabilities of this plugin modest, but a few other features would be
worthwhile. The user should be able to write the contents of the notepad to storage on
demand. It should also be possible to choose the name and location of the file that will be
used to hold the notepad text. This would allow the user to load other files into the
notepad display. The path of the notepad file should be displayed in the plugin window,
but will give the user the option to hide the file name. Finally, there should be an action
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by which a single click or keypress would cause the contents of the notepad to be written
to the new text buffer for further processing.

The full source code for QuickNotepad is contained in jEdit’s source code distribution.
We will provide excerpts in this discussion where it is helpful to illustrate specific points.
You are invited to obtain the source code for further study or to use as a starting point for
your own plugin.

17.2. Writing a Plugin Core Class
The major issues encountered when writing a plugin core class arise from the
developer’s decisions on what features the plugin will make available. These issues have
implications for other plugin elements as well.

• Will the plugin provide for actions that the user can trigger using jEdit’s menu
items, toolbar buttons and keyboard shortcuts?

• Will the plugin have its own visible interface?

• Will the plugin respond to any EditBus messages reflecting changes in the host
application’s state?

• Will the plugin have settings that the user can configure?

17.2.1. Choosing a Base Class

If the plugin will respond to EditBus messages, it must be derived fromEBPlugin .
Otherwise,EditPlugin will suffice as a base class.

Knowing what types of messages are made available by the plugin API is obviously
helpful is determining both the base plugin class and the contents of a
handleMessage() method. The message classes derived fromEBMessage cover the
opening and closing of the application, changes in the status of text buffers and their
container and changes in user settings, as well as changes in the state of other program
features. Specific message classes of potential interest to a plugin include the following:

• EditorStarted , sent during the application’s startup routine, just prior to the
creation of the initialView ;
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• EditorExitRequested , sent when a request to exit has been made, but before
saving open buffers and writing user settings to storage;

• EditorExiting , sent just before jEdit actually exits;

• EditPaneUpdate , sent when an edit pane containing a text area (including a pane
created by splitting an existing window) has been created or destroyed, or when a
buffer displayed in an edit pane has been changed;

• BufferUpdate , sent when a text buffer is created, loaded, or being saved, or when
its editing mode or markers have changed;

• ViewUpdate , sent when aView is created or closed; and

• PropertiesChanged , sent when the properties of the application or a plugin has
been changed through theGeneral Options dialog;

Detailed documentation for each message class can be found inChapter 20.

17.2.2. Implementing Base Class Methods

17.2.2.1. General Considerations

WhetherEditPlugin or EBPlugin is selected as the base of the plugin core class, the
implementations ofstart() andstop() in the plugin’s derived class are likely to be
trivial, or not present at all (in which case they will be “no-ops” inherited from
EditPlugin ).

The plugin core class can includestatic final String data members containing
information to be registered with the EditBus or key names for certain types of plugin
properties. This makes it easier to refer to the information when a method such as
handleMessage() examines the contents of a message. The kind of data that can be
handled in this fashion include the following:

• the name of the plugin;

• a label for identifying the plugin’s menu;

• a prefix for labeling properties required by the plugin API; and

• a prefix to be used in labeling items used in the plugin’s option pane
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17.2.2.2. Example Plugin Core Class

We will derive the plugin core class for QuickNotepad fromEditPlugin , since there are
no EditBus messages to which the plugin core class need respond. There are no special
initialization or shut down chores to perform, so we will not need astart() or stop()

method. We will define a few staticString data members to enforce consistent syntax
for the name of properties we will use throughout the plugin. Finally, we will use a
standalone plugin window class to separate the functions of that class from the visible
component class we will create.

The resulting plugin core class is lightweight and straightforward to implement:

public class QuickNotepadPlugin extends EBPlugin {
public static final String NAME = "quicknotepad";
public static final String MENU = "quicknotepad.menu";
public static final String PROPERTY_PREFIX

= "plugin.QuickNotepadPlugin.";
public static final String OPTION_PREFIX

= "options.quicknotepad.";

public void createMenuItems(Vector menuItems) {
menuItems.addElement(GUIUtilities.loadMenu(MENU));

}

public void createOptionPanes(OptionsDialog od) {
od.addOptionPane(new QuickNotepadOptionPane());

}

}

The implementations ofcreateMenuItems() andcreateOptionPane() are typically
trivial, because the real work will be done using other plugin elements. Menu creation is
performed by a utility function in jEdit’s API, using properties defined in the plugin’s
properties file. The option pane is constructed in its own class.

If the plugin only had a single menu item (for example, a checkbox item that toggled
activation of a dockable window), we would callGUIUtilities.loadMenuItem()

instead ofloadMenu() . We will explain the use of both methods in the next section.
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17.2.3. Resources for the Plugin Core Class

17.2.3.1. Actions

The plugin’s user action catalog,actions.xml , is the resource used by the plugin API to
get the names and definitions of user actions. The followingactions.xml file from the
QuickNotepad plugin can provide a model:

<!DOCTYPE ACTIONS SYSTEM "actions.dtd">

<ACTIONS>
<ACTION NAME="quicknotepad.choose-file">

<CODE>
view.getDockableWindowManager()

.getDockable(QuickNotepadPlugin.NAME).chooseFile();
</CODE>

</ACTION>

<ACTION NAME="quicknotepad.save-file">
<CODE>

view.getDockableWindowManager()
.getDockable(QuickNotepadPlugin.NAME).saveFile();

</CODE>
</ACTION>

<ACTION NAME="quicknotepad.copy-to-buffer">
<CODE>

view.getDockableWindowManager()
.getDockable(QuickNotepadPlugin.NAME).copyToBuffer();

</CODE>
</ACTION>

</ACTIONS>

This file defines three actions. They use the current view’sDockableWindowManager

object and the methodgetDockable() to find the QuickNotepad plugin window and
call the desired method.

When an action is invoked, program control must pass to the component responsible for
executing the action. The use of an internal table of BeanShell scripts that implement
actions avoids the need for plugins to implementActionListener or similar objects to
respond to actions. Instead, the BeanShell scripts address the plugin through static
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methods, or if instance data is needed, the currentView , its DockableWindowManager ,
and the plugin object return by thegetDockable() method.

If you are unfamiliar with BeanShell code, you may nevertheless notice that the code
statements bear a strong resemblance to Java code, with one exception: the variableview

is never assigned any value.

For complete answers to this and other BeanShell mysteries, seePart III in jEdit 4.0
User’s Guide; two observations will suffice here. First, the variableview is predefined by
jEdit’s implementation of BeanShell to refer to the currentView object. Second, the
BeanShell scripting language is based upon Java syntax, but allows variables to be typed
at run time, so explicit types for variables need not be declared.

A formal description of each element of theactions.xml file can be found inSection
16.2.2.

17.2.3.2. Action Labels and Menu Items

Now that we have named and defined actions for the plugin, we have to put them to
work. To do so, we must first give them labels that can be used in menu items and in the
sections of jEdit’s options dialog that deal with toolbar buttons, keyboard shortcuts and
context menu items. We supply this information to jEdit through entries in the plugin’s
properties file. A call toGUIUtilities.loadMenu() or
GUIUtilities.loadMenuItem() will read and extract the necessary labels from the
contents of a properties file.

The following excerpt fromQuickNotepad.props illustrates the format required for
action labels and menu items:

# action labels
quicknotepad.toggle.label=QuickNotepad
quicknotepad-to-front.label=Bring QuickNotepad to front
quicknotepad.choose-file.label=Choose notepad file
quicknotepad.save-file.label=Save notepad file
quicknotepad.copy-to-buffer.label=Copy notepad to buffer

# application menu items
quicknotepad.menu.label=QuickNotepad
quicknotepad.menu=quicknotepad.toggle - quicknotepad.choose-file \

quicknotepad.save-file quicknotepad.copy-to-buffer
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GUIUtilities.loadMenuItem() andGUIUtilites.loadMenu() use special
conventions for the value of a menu property to specify menu layout. InloadMenu() , the
use of the dash, as in the second item in the example menu list, signifies the placement of
a separator. In addition, the character’%’ used as a prefix on a label causesloadMenu()

to call itself recursively with the prefixed label as the source of submenu data. Most
plugins will not need to define menus that contain other submenus.

Note also thatquicknotepad-to-front is not included in the menu listing. It will
appear, however, on theShortcuts pane of theGlobal Options dialog, so that the action
can be associated with a keyboard shortcut.

17.3. Implementing a Dockable Window Class
Now we must provide the actual implementation of the dockable window referenced in
dockables.xml (seeSection 16.2.3andSection 17.6). Here is theQuickNotepad.java

source file, with some details not related to the dockable window API trimmed:

public class QuickNotepad extends JPanel
implements EBComponent

{
private View view;
private String position;
...
public QuickNotepad(View view, String position) {

this.view = view;
this.position = position;
...

}

...

public void handleMessage(EBMessage message) {
if (message instanceof PropertiesChanged) {

propertiesChanged();
}

}

...
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}

This excerpt does not set forth the layout of the plugin’s visible components, nor does it
show how our user actions will be implemented. Both these matters are covered in the
full source code.

17.4. The Plugin’s Visible Window

17.4.1. Class QuickNotepad

Here is where most of the features of the plugin will be implemented. To work with the
dockable window API, the top level window will be aJPanel . The visible components
reflect a simple layout. Inside the top-level panel we will place a scroll pane with a text
area. Above the scroll pane we will place a panel containing a small tool bar and a label
displaying the path of the current notepad file.

We have identified three user actions that need implementation here:chooseFile() ,
saveFile() , andcopyToBuffer() . As noted earlier, we also want the text area to
change its appearance in immediate response to a change in user options settings. In
order to do that, the window class must respond to aPropertiesChanged message from
the EditBus.

Unlike theEBPlugin class, theEBComponent interface does not deal with the
component’s actual subscribing and unsubscribing to the EditBus. To accomplish this,
we use a pair of methods inherited from the Java platform’sJComponent class that are
called when the window is made visible, and when it is hidden. These two methods,
addNotify() andremoveNotify() , are overridden to add and remove the visible
window from the list of EditBus subscribers.

We will provide for two minor features when the notepad is displayed in the floating
window. First, when a floating plugin window is created, we will give the notepad text
area input focus. Second, when the notepad if floating and has input focus, we will have
theEscapekey dismiss the notepad window. AnAncestorListener and a
KeyListener will implement these details.

Here is the listing for the data members, the constructor, and the implementation of the
EBComponent interface:
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public class QuickNotepad extends JPanel
implements EBComponent

{
private String filename;
private String defaultFilename;
private View view;
private boolean floating;

private QuickNotepadTextArea textArea;
private QuickNotepadToolPanel toolPanel;

//
// Constructor
//

public QuickNotepad(View view, String position)
{

super(new BorderLayout());

this.view = view;
this.floating = position.equals(

DockableWindowManager.FLOATING);

this.filename = jEdit.getProperty(
QuickNotepadPlugin.OPTION_PREFIX
+ "filepath");

if(this.filename == null || this.filename.length() == 0)
{

this.filename = new String(jEdit.getSettingsDirectory()
+ File.separator + "qn.txt");

jEdit.setProperty(QuickNotepadPlugin.OPTION_PREFIX
+ "filepath",this.filename);

}
this.defaultFilename = new String(this.filename);

this.toolPanel = new QuickNotepadToolPanel(this);
add(BorderLayout.NORTH, this.toolPanel);

if(floating)
this.setPreferredSize(new Dimension(500, 250));

textArea = new QuickNotepadTextArea();
textArea.setFont(QuickNotepadOptionPane.makeFont());
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textArea.addKeyListener(new KeyHandler());
textArea.addAncestorListener(new AncestorHandler());
JScrollPane pane = new JScrollPane(textArea);
add(BorderLayout.CENTER, pane);

readFile();
}

//
// Attribute methods
//

// for toolBar display
public String getFilename()
{

return filename;
}

//
// EBComponent implementation
//

public void handleMessage(EBMessage message)
{

if (message instanceof PropertiesChanged)
{

propertiesChanged();
}

}

private void propertiesChanged()
{

String propertyFilename = jEdit.getProperty(
QuickNotepadPlugin.OPTION_PREFIX + "filepath");

if(!defaultFilename.equals(propertyFilename))
{

saveFile();
toolPanel.propertiesChanged();
defaultFilename = propertyFilename.clone();
filename = defaultFilename.clone();
readFile();

}
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Font newFont = QuickNotepadOptionPane.makeFont();
if(!newFont.equals(textArea.getFont()))
{

textArea.setFont(newFont);
textArea.invalidate();

}
}

// These JComponent methods provide the appropriate points
// to subscribe and unsubscribe this object to the EditBus

public void addNotify()
{

super.addNotify();
EditBus.addToBus(this);

}

public void removeNotify()
{

saveFile();
super.removeNotify();
EditBus.removeFromBus(this);

}

...

}

This listing refers to aQuickNotebookTextArea object. It is currently implemented as a
JTextArea with word wrap and tab sizes hard-coded. Placing the object in a separate
class will simply future modifications.

17.4.2. Class QuickNotepadToolBar

There is nothing remarkable about the toolbar panel that is placed inside the
QuickNotepad object. The constructor shows the continued use of items from the
plugin’s properties file.

public class QuickNotepadToolPanel extends JPanel
{
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private QuickNotepad pad;
private JLabel label;

public QuickNotepadToolPanel(QuickNotepad qnpad)
{

pad = qnpad;
JToolBar toolBar = new JToolBar();
toolBar.setFloatable(false);

toolBar.add(makeCustomButton("quicknotepad.choose-file",
new ActionListener() {

public void actionPerformed(ActionEvent evt) {
QuickNotepadToolPanel.this.pad.chooseFile();

}
}));

toolBar.add(makeCustomButton("quicknotepad.save-file",
new ActionListener() {

public void actionPerformed(ActionEvent evt) {
QuickNotepadToolPanel.this.pad.saveFile();

}
}));

toolBar.add(makeCustomButton("quicknotepad.copy-to-buffer",
new ActionListener() {

public void actionPerformed(ActionEvent evt) {
QuickNotepadToolPanel.this.pad.copyToBuffer();

}
}));

label = new JLabel(pad.getFilename(),
SwingConstants.RIGHT);

label.setForeground(Color.black);
label.setVisible(jEdit.getProperty(

QuickNotepadPlugin.OPTION_PREFIX
+ "show-filepath").equals("true"));

this.setLayout(new BorderLayout(10, 0));
this.add(BorderLayout.WEST, toolBar);
this.add(BorderLayout.CENTER, label);
this.setBorder(BorderFactory.createEmptyBorder(0, 0, 3, 10));

}

...

}
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The methodmakeCustomButton() provides uniform attributes for the three toolbar
buttons corresponding to three of the plugin’s use actions. The menu titles for the user
actions serve double duty as tooltip text for the buttons. There is also a
propertiesChanged() method for the toolbar that sets the text and visibility of the
label containing the notepad file path.

17.5. Designing an Option Pane
Using the default implementation provided byAbstractOptionPane reduces the
preparation of an option pane to two principal tasks: writing a_init() method to layout
and initialize the pane, and writing a_save() method to commit any settings changed
by user input. If a button on the option pane should trigger another dialog, such as a
JFileChooser or jEdit’s own enhancedVFSFileChooserDialog , the option pane will
also have to implement theActionListener interface to display additional components.

The QuickNotepad plugin has only three options to set: the path name of the file that will
store the notepad text, the visibility of the path name on the tool bar, and the notepad’s
display font. Using the shortcut methods of the plugin API, the implementation of
_init() looks like this:

public class QuickNotepadOptionPane extends AbstractOptionPane
implements ActionListener

{
private JTextField pathName;
private JButton pickPath;
private FontSelector font;

...

public void _init()
{

showPath = new JCheckBox(jEdit.getProperty(
QuickNotepadPlugin.OPTION_PREFIX
+ "show-filepath.title"),

jEdit.getProperty(
QuickNotepadPlugin.OPTION_PREFIX + "show-filepath")
.equals("true"));

addComponent(showPath);
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pathName = new JTextField(jEdit.getProperty(
QuickNotepadPlugin.OPTION_PREFIX
+ "filepath"));

JButton pickPath = new JButton(jEdit.getProperty(
QuickNotepadPlugin.OPTION_PREFIX
+ "choose-file"));

pickPath.addActionListener(this);

JPanel pathPanel = new JPanel(new BorderLayout(0, 0));
pathPanel.add(pathName, BorderLayout.CENTER);
pathPanel.add(pickPath, BorderLayout.EAST);

addComponent(jEdit.getProperty(
QuickNotepadPlugin.OPTION_PREFIX + "file"),
pathPanel);

font = new FontSelector(makeFont());
addComponent(jEdit.getProperty(

QuickNotepadPlugin.OPTION_PREFIX + "choose-font"),
font);

}

...

}

Here we adopt the vertical arrangement offered by use of theaddComponent() method
with one embellishment. We want the first “row” of the option pane to contain a text field
with the current notepad file path and a button that will trigger a file chooser dialog when
pressed. To place both of them on the same line (along with an identifying label for the
file option), we create aJPanel to contain both components and pass the configured
panel toaddComponent() .

The_init() method uses properties from the plugin’s property file to provide the
names of label for the components placed in the option pane. It also uses a property
whose name begins withPROPERTY_PREFIXas a persistent data item - the path of the
current notepad file. The elements of the notepad’s font are also extracted from
properties using a static method of the option pane class.

The_save() method extracts data from the user input components and assigns them to
the plugin’s properties. The implementation is straightforward:
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public void _save()
{

jEdit.setProperty(QuickNotepadPlugin.OPTION_PREFIX
+ "filepath", pathName.getText());

Font _font = font.getFont();

jEdit.setProperty(QuickNotepadPlugin.OPTION_PREFIX
+ "font", _font.getFamily());

jEdit.setProperty(QuickNotepadPlugin.OPTION_PREFIX
+ "fontsize", String.valueOf(_font.getSize()));

jEdit.setProperty(QuickNotepadPlugin.OPTION_PREFIX
+ "fontstyle", String.valueOf(_font.getStyle()));

jEdit.setProperty(QuickNotepadPlugin.OPTION_PREFIX
+ "show-filepath", String.valueOf(showPath.isSelected()));

}

The class has only two other methods, one to display a file chooser dialog in response to
user action, and the other to construct aFont object from the plugin’s font properties.
They do not require discussion here.

17.6. Creating Other Plugin Resources
We have already covered in some detail one of the three types of resources that plugins
include with their class files - the user action catalog - and the need for help
documentation does not require extended discussion. The remaining resource is the
properties file.

The first type of property data is information about the plugin itself. The first few entries
from the QuickNotepad plugin’s properties file fulfills this requirement:

# general plugin information
plugin.QuickNotepadPlugin.name=QuickNotepad
plugin.QuickNotepadPlugin.author=John Gellene
plugin.QuickNotepadPlugin.version=2.0
plugin.QuickNotepadPlugin.docs=QuickNotepad.html
plugin.QuickNotepadPlugin.depend.0=jedit 04.00.01.00

These properties are described in detail inSection 16.2.1and do not require further
discussion here.
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Next in the file comes a property that sets the title of the plugin in docked or frame
windows. The use of the suffix.title in the property’s key name is required by the
plugin API.

# dockable window name
quicknotepad.title=QuickNotepad

The next sections, consisting of the action label and menu item properties, have been
discussed earlier inSection 17.2.3.2.

# action labels
quicknotepad.toggle.label=QuickNotepad
quicknotepad-to-front.label=Bring QuickNotepad to front
quicknotepad.choose-file.label=Choose notepad file
quicknotepad.save-file.label=Save notepad file
quicknotepad.copy-to-buffer.label=Copy notepad to buffer

# application menu items
quicknotepad.menu=quicknotepad.toggle - quicknotepad.choose-file \

quicknotepad.save-file quicknotepad.copy-to-buffer

We have created a small toolbar as a component of QuickNotepad, so file names for the
button icons follow:

# plugin toolbar buttons
quicknotepad.choose-file.icon=Open.gif
quicknotepad.save-file.icon=Save.gif
quicknotepad.copy-to-buffer.icon=Edit.gif

The menu labels corresponding to these icons will also serve as tooltip text.

Finally, the properties file set forth the labels and settings used by the option pane:

# Option pane labels
options.quicknotepad.label=QuickNotepad
options.quicknotepad.file=File:
options.quicknotepad.choose-file=Choose
options.quicknotepad.choose-file.title=Choose a notepad file
options.quicknotepad.choose-font=Font:
options.quicknotepad.show-filepath.title=Display notepad file path
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# Initial default font settings
options.quicknotepad.show-filepath=true
options.quicknotepad.font=Monospaced
options.quicknotepad.fontstyle=0
options.quicknotepad.fontsize=14

# Setting not defined but supplied for completeness
options.quicknotepad.filepath=

We do not define a default setting for thefilepath property because of differences
among operating systems. We will define a default file programatically that will reside in
the directory jEdit designates for user settings.

17.7. Compiling the Plugin
We have already outlined the contents of the user action catalog, the properties file and
the documentation file in our earlier discussion. The final step is to compile the source
file and build the archive file that will hold the class files and the plugin’s other resources.

Publicly released plugins include with their source a makefile in XML format for the Ant
utility. The format for this file requires few changes from plugin to plugin. Here is the
version ofbuild.xml used by QuickNotepad and many other plugins:

<project name="QuickNotepad" default="dist" basedir=".">

<property name="jedit.install.dir" value="../.."/>
<property name="jar.name" value="QuickNotepad.jar"/>

<property name="install.dir" value=".."/>

<path id="project.class.path">
<pathelement location="${jedit.install.dir}/jedit.jar"/>
<pathelement location="."/>

</path>

<target name="compile">
<javac

srcdir="."
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deprecation="on"
includeJavaRuntime="yes"

>
<classpath refid="project.class.path"/>

</javac>
</target>

<target name="dist" depends="compile">
<mkdir dir="${install.dir}"/>
<jar jarfile="${install.dir}/${jar.name}">

<fileset dir=".">
<include name="**/*.class"/>
<include name="**/*.props"/>
<include name="**/*.html"/>
<include name="**/*.gif"/>
<include name="actions.xml"/>
<include name="dockables.xml"/>

</fileset>
</jar>

</target>
</project>

For a full discussion of theAnt file format and command syntax, you should consult the
Ant documentation site (http://jakarta.apache.org/ant/manual/index.html). Modifying
this makefile for a different plugin will likely only require three changes:

• the name of the plugin;

• the choice of compiler (made by inserting and deleting the comment character
’#’ ); and

• the classpath variables forjedit.jar any plugins this one depends on.

If you have reached this point in the text, you are probably serious about writing a plugin
for jEdit. Good luck with your efforts, and thank you for contributing to the jEdit project.
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V. jEdit API Reference
This part of the user’s guide covers the jEditapplication programming interface. The
information in this part is only useful to macro and plugin developers; you do not need to
read it if you only want to use jEdit.

The first chapter covers BeanShell commands, which can only be used in macros. The
second chapter covers APIs useful to both macros and plugins. The final chapter covers
the EditBus message system, which is typically only used by plugins.

This part of the user’s guide was written by John Gellene <jgellene@nyc.rr.com >.





Chapter 18. BeanShell Commands
BeanShell includes a set ofcommands; subroutines that can be called from any script or
macro. The following is a summary of those commands which may be useful within
jEdit.

Note: Plugins, because they are written in Java and not BeanShell, cannot make
use of BeanShell commands.

18.1. Output Commands

• void cat (String filename );

Writes the contents offilename to the activity log.

• void javap (String | Object | Class target );

Writes the public fields and methods of the specified class to the output stream of
the current process. Requires Java 2 version 1.3 or greater.

• void print ( arg );

Writes the string value of the argument to the activity log, or if run from the
Console plugin, to the current output window. Ifarg is an array,print runs itself
recursively on the array’s elements.

18.2. File Management Commands

• void cd (String dirname );
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Changes the working directory of the BeanShell interpreter todirname .

• void dir (String dirname );

Displays the contents of directorydirname . The format of the display is similar to
the Unix ls -l command.

• void mv(String fromFile , String toFile );

Moves the file named byfromFile to toFile .

• File pathToFile (String filename );

Create aFile object corresponding tofilename . Relative paths are resolved with
reference to the BeanShell interpreter’s working directory.

• void pwd();

Writes the current working directory of the BeanShell interpreter to the output
stream of the current process.

• void rm(String pathname );

Deletes the file name bypathname .

18.3. Component Commands

• JFrame frame (Component frame );

Displays the component in a top-levelJFrame , centered and packed. Returns the
JFrame object.

• Object load (String filename );
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Loads and returns a serialized Java object fromfilename .

• void save (Component component , String filename );

Savescomponent in serialized form tofilename .

• Font setFont (Component comp, int ptsize );

Set the font size ofcomponent to ptsize and returns the new font.

18.4. Resource Management Commands

• URL getResource (String path );

Returns the resource specified bypath . A absolute path must be used to return any
resource available in the current classpath.

18.5. Script Execution Commands

• Thread bg(String filename );

Run the BeanShell script named byfilename in a copy of the existing namespace
and in a separate thread. Returns theThread object so created.

• void exec (String cmdline );

Start the external process by callingRuntime.exec() oncmdline . Any output is
directed to the output stream of the calling process.

• Object eval (String expression );

207



Chapter 18. BeanShell Commands

Evaluates the stringexpression as a BeanShell script in the interpreter’s current
namespace. Returns the result of the evaluation ofnull .

• bsh.This run (String filename );

Run the BeanShell script named byfilename in a copy of the existing
namespace. The return value represent the object context of the script, allowing you
to access its variables and methods.

• void source (String filename );

Evaluates the contents offilename as a BeanShell script in the interpreter’s
current namespace.

18.6. BeanShell Object Management Commands

• bind (bsh.This ths , bsh.Namespace namespace );

Binds the scripted objectths to namespace .

• void clear ();

Clear all variables, methods, and imports from this namespace. If this namespace is
the root, it will be reset to the default imports.

• bsh.This extend (bsh.This object );

Creates a new BeanShellThis scripted object that is a child of the parameter
object .

• bsh.This object ();
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Creates a new BeanShellThis scripted object which can hold data members. You
can use this to create an object for storing miscellaneous crufties, like so:

crufties = object();
crufties.foo = "hello world";
crufties.counter = 5;
...

• setNameSpace (bsh.Namespace namespace );

Set the namespace of the current scope tonamespace .

• bsh.This super (String scopename );

Returns a reference to the BeanShellThis object representing the enclosing method
scope specified byscopename . This method work similar to thesuper keyword
but can refer to enclosing scope at higher levels in a hierarchy of scopes.

• void unset (String name);

Removes the variable named byname from the current interpreter namespace. This
has the effect of “undefining” the variable.

18.7. Other Commands

• void debug ();

Toggles BeanShell’s internal debug reporting to the output stream of the current
process.

• getSourceFileInfo ();
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Returns the name of the file or other source from which the BeanShell interpreter is
reading.
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19.1. Class jEdit
This is the main class of the application. All the methods in this class are static methods,
so they are called with the following syntax, from both macros and plugins:

jEdit. method ( parameters )

Here are a few key methods:

• public static Buffer openFile (View view , String path );

Opens the file namedpath in the givenView . To open a file in the current view, use
the predefined variableview for the first parameter.

• public static Buffer newFile (View view );

This creates a new buffer captionedUntitled-<n>in the givenView .

• public static boolean closeBuffer (View view , Buffer buffer );

Closes the buffer namedbuffer in the view namedview . The user will be
prompted to save the buffer before closing if there are unsaved changes.

• public static void saveAllBuffers (View view , boolean confirm );

This saves all open buffers with unsaved changes in the givenView . The parameter
confirm determines whether jEdit initially asks for confirmation of the save
operation.

• public static boolean closeAllBuffers (View view );

Closes all buffers in the givenView . A dialog window will be displayed for any
buffers with unsaved changes to obtain user instructions.
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• public static void exit (View view , boolean reallyExit );

This method causes jEdit to exit. IfreallyExit is false and jEdit is running in
background mode, the application will simply close all buffers and views and
remain in background mode.

• public static String getProperty (String name);

Returns the value of the property named byname, or null if the property is
undefined.

• public static void setProperty (String name, String property );

Sets the property named byname with the valueproperty . An existing property is
overwritten.

• public static boolean getBooleanProperty (String name);

Returns aboolean value oftrue or false for the property named byname by
examining the contents of the property; returnsfalse if the property cannot be
found.

• public static void setBooleanProperty (String name, boolean

value );

Sets the property named byname to value . The boolean value is stored internally as
the string “true” or “false”.

• public static int getIntegerProperty (String name, int

defaultValue );

Returns the integer value of the property named byname. If the property value is not
a valid numeric string, returnsdefaultValue instead.

• public static void setIntegerProperty (String name, int value );
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Sets the property named byname to value .

• public static Color getColorProperty (String name);

Returns the value of the specified property as ajava.awt.Color instance, ornull

if the color value cannot be parsed.

• public static void setColorProperty (String name, Color value );

Sets the property named byname to the textual representation of the color instance
named byvalue .

• public static Font getFontProperty (String name);

Returns the value of the specified property as ajava.awt.Font instance, ornull if
the font specification cannot be parsed.

• public static void setFontProperty (String name, Font value );

Sets the property named byname to the textual representation of the font instance
stored invalue .

• public static void setTemporaryProperty (String name, String

property );

This sets a property that will be stored during the current jEdit session only. This
method is useful for storing a value obtained by one macro for use by another
macro, because it does not clutter up the user properties file on disk.

• public static String getJEditHome ();

Returns the path of the directory containing the jEdit executable file.

• public static String getSettingsDirectory ();
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Returns the path of the directory in which user-specific settings are stored. This will
benull if jEdit was started with the-nosettingscommand-line switch; so do not
blindly use this method without checking for a null return value first.

The jEdit object also maintains a number of collections which are useful in some
situations. They include the following:

• public static EditAction[] getActions ();

Returns an array of “actions” or short routines maintained and used by the editor.

• public static EditAction getAction (String action );

Returns the action namedaction , or null if it does not exist.

• public static Properties getProperties ();

Returns a JavaProperties object (a class derived fromHashtable ) holding all
properties currently used by the program. The constituent properties fall into three
categories: application properties, “site” properties, and “user” properties. Site
properties take precedence over application properties with the same “key” or name,
and user properties take precedence over both application and site properties. User
settings are written to a file namedproperties in the user settings directory upon
program exit or wheneverjEdit.saveSettings() is called.

• public static Buffer[] getBuffers ();

Returns an array of open buffers.

• public static int getBufferCount ();

Returns the number of open buffers.

• public static Buffer getBuffer (String path );
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Returns theBuffer object containing the file namedpath . or null if the buffer
does not exist.

• public static Mode[] getModes ();

Returns an array containing all editing modes used by jEdit.

• public static Mode getMode (String name);

Returns the editing mode named byname, or null if such a mode does not exist.

• public static EditPlugin[] getPlugins ();

Returns an array containing all loaded plugins.

• plugin static EditPlugin getPlugin (String name);

Returns the plugin named byname, or null if such a plugin does not exist.

19.2. Class View
This class represents the “parent” or top-level frame window in which the editing occurs.
It contains the various visible components of the program, including the editing pane,
menu bar, toolbar, and any docked windows.

Some useful methods from this class include the following:

• public void splitHorizontally ();

Splits the view horizontally.

• public void splitVertically ();

Splits the view vertically.
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• public void unsplit ();

Unsplits the view.

• public synchronized void showWaitCursor ();

Shows a “waiting” cursor (typically, an hourglass).

• public synchronized void hideWaitCursor ();

Removes the “waiting” cursor. This method andshowWaitCursor() are
implemented using a reference count of requests for wait cursors, so that nested
calls work correctly; however, you should be careful to use these methods in
tandem.

• public StatusBar getStatus ();

EachView displays aStatusBar at its bottom edge. It shows the current cursor
position, the editing mode of the current buffer and other information. The method
setMessage(String message) can be called on the return value ofgetStatus()

to display reminders or updates. The message remains until the method is called
again. To display a temporary message in the status bar, call
setMessageAndClear(String message) , which will erase the message
automatically after ten seconds.

• public DockableWindowManager getDockableWindowManager ();

The object returned by this method keeps track of all dockable windows. See
Section 19.11.
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19.3. Class JEditTextArea
This class is the visible component that displays the file being edited. It is derived from
Java’sJComponent class.

Methods in this class that deal with selecting text rely upon classes derived from jEdit’s
Selection class. The “Selection API” permits selection and concurrent manipulation of
multiple, non-contiguous regions of text. After describing the selection classes, we will
outline the selection methods ofJEditTextArea , followed by a listing of other methods
in this class that are useful in writing macros.

19.3.1. Class Selection

This is anabstract classwhich holds data on a region of selected text. As an abstract
class, it cannot be used directly, but instead serves as a parent class for specific types of
selection structures. The definition ofSelection contains two child classes used by the
Selection API:

• Selection.Range - representing an ordinary range of selected text

• Selection.Rect - representing a rectangular selection region

A new instance of either type ofSelection can be created by specifying its starting and
ending caret positions:

selRange = new Selection.Range(start, end);
setRect = new Selection.Rect(start, end);

Both classes inherit or implement the following methods of the parentSelection class:

• public int getStart ();

• public int getEnd ();

Retrieves the buffer position representing the start or end of the selection.

• public int getStartLine ();

• public int getEndLine ();
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Retrieves the zero-based index number representing the line on which the selection
starts or ends.

• public int getStart (Buffer buffer , int line );

• public int getEnd (Buffer buffer , int line );

These two methods return the position of the beginning or end of that portion of the
selection falling on the line referenced by theline parameter. The parameter
buffer is required because aSelection object is a lightweight structure that
does not contain a reference to theBuffer object to which it relates.

These methods do not check whether theline parameter is within the range of
lines actually covered by the selection. They would typically be used within a loop
defined by thegetStartLine() andgetEndLine() methods to manipulate
selection text on a line-by-line basis. Using them without range checking could
cause unintended behavior.

19.3.2. Selection methods in JEditTextArea

A JEditTextArea object maintains anVector of currentSelection objects. When a
selection is added, theJEditTextArea attempts to merge the new selection with any
existing selection whose range contains or overlaps with the new item. When selections
are added or removed using by these methods, the editing display is updated to show the
change in selection status.

Here are the principal methods ofJEditTextArea dealing withSelection objects:

19.3.2.1. Adding and removing selections

• public void setMultipleSelectionEnabled (boolean multi );

Set multiple selection on or off according to the value ofmulti . This only affects
the ability to make multiple selections in the user interface; macros and plugins can
manipulate them regardless of the setting of this flag. In fact, in most cases, calling
this method should not be necessary.
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• public Selection[] getSelection ();

Returns an array containing a copy of the current selections.

• public int getSelectionCount ();

Returns the current number of selections. This can be used to test for the existence
of selections.

• public Selection getSelectionAtOffset (int offset );

Returns theSelection containing the specific offset, ornull if there is no
selection at that offset.

• public void addToSelection (Selection selection );

• public void addToSelection (Selection[] selection );

Adds a singleSelection or an array ofSelection objects to the existing
collection maintained by theJEditTextArea . Nested or overlapping selections will
be merged where possible.

• public void extendSelection (int offset , int end );

Extends the existing selection containing the position atoffset to the position
represented byend . If there is no selection containingoffset the method creates
a newSelection.Range extending fromoffset to end and adds it to the
current collection.

• public void removeFromSelection (Selection sel );

• public void removeFromSelection (int offset );

These methods remove a selection from the current collection. The second version
removes any selection that contains the position atoffset , and has no effect if no
such selection exists.
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19.3.2.2. Getting and setting selected text

• public String getSelectedText (Selection s );

• public String getSelectedText (String separator );

• public String getSelectedText ();

These three methods return aString containing text corresponding to the current
selections. The first version returns the text corresponding to a particular selection
named as the parameter, allowing for iteration through the collection or focus on a
specific selection (such as a selection containing the current caret position). The
second version combines all selection text in a singleString , separated by the
String given as theseparator . The final version operates like the second
version, separating individual selections with newline characters.

• public void setSelectedText (Selection s , String selectedText );

• public void setSelectedText (String selectedText );

The first version changes the text of the selection represented bys to
selectedText . The second version sets the text of all active selections; if there
are no selections, the text will be inserted at the current caret position.

The second version ofsetSelectedText() is the method that will typically be
used in macro scripts to insert text.

• public int[] getSelectedLines ();

Returns a sorted array of line numbers on which a selection or selections are
present.

This method is the most convenient way to iterate through selected lines in a buffer.
The line numbers in the array returned by this method can be passed as a parameter
to such methods asBuffer.getLineText() (seeSection 19.4.4).
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19.3.2.3. Other selection methods

The following methods perform selection operations without usingSelection objects
as parameters or return values. These methods should only be used in macros.

• public void selectBlock ();

Selects the code block surrounding the caret.

• public void selectWord ();

• public void selectLine ();

• public void selectParagraph ();

• public void selectFold ();

Selects the “fold” (a portion of text sharing a given indentation level) that contains
the line where the editing caret is positioned.

• public void selectFoldAt (int line );

Selects the fold containing the line referenced byline .

• public void selectAll ();

• public void selectNone ();

• public void indentSelectedLines ();

19.3.3. Editing caret methods

These methods are used to get, set and move the position of the editing caret:

• public int getCaretPosition ();

Returns a zero-based index of the caret position in the existing buffer.
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• public void setCaretPosition (int caret );

Sets the caret position atcaret and deactivates any selection of text.

• public void moveCaretPosition (int caret );

This moves the caret to the position represented bycaret without affecting any
selection of text.

• public int getCaretLine ();

Returns the line on which the caret is positioned.

Each of the following shortcut methods moves the caret. If theselect parameter is set
to true , the intervening text will be selected as well.

• public void goToStartOfLine (boolean select );

• public void goToEndOfLine (boolean select );

• public void goToStartOfWhiteSpace (boolean select );

• public void goToEndOfWhiteSpace (boolean select );

• public void goToFirstVisibleLine (boolean select );

• public void goToLastVisibleLine (boolean select );

• public void goToNextCharacter (boolean select );

• public void goToPrevCharacter (boolean select );

• public void goToNextWord (boolean select );

• public void goToPrevWord (boolean select );

• public void goToNextLine (boolean select );

• public void goToPrevLine (boolean select );

• public void goToNextParagraph (boolean select );

• public void goToPrevParagraph (boolean select );

• public void goToNextBracket (boolean select );
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• public void goToPrevBracket (boolean select );

19.3.4. Methods for scrolling the text area

• public void scrollUpLine ();

• public void scrollUpPage ();

• public void scrollDownLine ();

• public void scrollUpPage ();

• public void scrollTo (int location , boolean doElectricScroll );

• public void scrollToCaret (boolean doElectricScroll );

The first version scrolls the text area to ensure that the caret is visible; the second
scrolls to ensure that an arbitrary offset (from the start of the buffer) is visible. The
doElectricScroll parameter determines whether “electric scrolling” will
occur. This leaves a minimum number of lines between the target line and the top
and bottom of the editing pane.

• public void centerCaret ();

Scrolls the text area so that the line containing the edit caret is vertically centered.

• public void setFirstLine (int firstLine );

• public int getFirstLine ();

This pair of methods deals with the line number of the first line displayed at the top
of the text area. Lines that are hidden by folds or narrowing are ignored when
making this “virtual” line count, so the line number will not necessarily conform to
the line numbers displayed in the text area’s gutter. In addition, the virtual line index
is zero-based, sogetFirstLine() will always return zero for the first line of text.

To convert a virtual line count to a physical count or vice versa, seeSection 19.3.8.
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19.3.5. Methods for deleting text

• public void backspace ();

• public void backspaceWord ();

• public void delete ();

• public void deleteWord ();

• public void deleteLine ();

• public void deleteParagraph ();

• public void deleteToStartOfLine ();

• public void deleteToEndOfLine ();

19.3.6. Methods for modifying text

• public void toLowerCase ();

• public void toUpperCase ();

These two methods operate on all selected text, including multiple selections.

• public void joinLines ();

Joins the current line with the following line.

• public void setOverwriteEnabled (boolean overwrite );

• public boolean isOverwriteEnabled ();

Sets and gets whether added text will overwrite text at the editing caret or whether it
will be inserted immediately to the right of the caret.

• public void userInput (char ch );

Inserts the character at the caret position as if it were typed at the keyboard
(keyboard input is actually passed to this method). UnlikesetSelectedText() , or
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insert() in theBuffer class, this method triggers any active text formatting
features such as auto indent, abbreviation expansion and word wrap.

19.3.7. Methods for creating comments

• public void lineComment ();

This inserts the line comment string at the beginning of each selected line.

• public void rangeComment ();

This surrounds each selected text chunk with the comment start and end strings.

19.3.8. Virtual and physical line indices

When jEdit’s folding or narrowing features are used to hide portions of a buffer, the
“virtual” line count visible in the text area is generally not equal to the “physical” line
count of the buffer represented by the gutter’s display. The following pair of methods
translate one enumeration to the other.

• public int virtualToPhysical (int lineNo );

• public int physicalToVirtual (int lineNo );

19.4. Class Buffer
A Buffer represents the contents of an open text file as it is maintained in the
computer’s memory (as opposed to how it may be stored on a disk).

225



Chapter 19. General jEdit Classes

19.4.1. File attribute methods

• public String getName ();

• public String getPath ();

• public File getFile ();

This method may returnnull if the file is stored on a remote file system (for
example, if the FTP or Archive plugins are in use). This method should be avoided
unless you really need to use thejava.io.File APIs and you are sure the buffer in
question is a local file.

• public boolean isNewFile ();

Returns whether a buffer lacks a corresponding version on disk.

• public boolean isDirty ();

Returns whether there have been unsaved changes to the buffer.

• public boolean isReadOnly ();

• public boolean isUntitled ();

19.4.2. Editing attribute methods

• public Mode getMode ();

• public void setMode (Mode mode);

Gets and sets the editing mode for the buffer.

• public int getIndentSize ();

• public int getTabSize ();

226



Chapter 19. General jEdit Classes

These methods return the size of an initial indentation at the beginning of a line and
the distance between tab stops, each measured in character columns. If these
properties are not individually set for a specific buffer, they are inherited from the
properties of the buffer’s associated editing mode.

TheBuffer object maintains a table of properties that describe a broad range of
attributes. The value of each property is stored using aString that names the particular
property. Most of these properties are documented inSection 6.2.

• public Object getProperty (String name);

Using this method is generally discouraged, because it returns anObject which
must be cast to another type in order to be useful, and this can cause problems if the
object is of a different type than what your plugin or macro expects.

jEdit 4.0 added a number of “wrapper” methods, documented below; you are
strongly encouraged to use them instead.

• public void setProperty (String name, Object value );

Sets the value of a property named byname to value .

These methods provide shortcuts for getting and setting string, integer andboolean

properties.

• public static String getStringProperty (String name);

Returns the value of the property named byname as a string.

• public static void setStringProperty (String name, String value );

Sets the property named byname to value .

• public static boolean getBooleanProperty (String name);
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Returns aboolean value oftrue or false for the property named byname by
examining the contents of the property; returnsfalse if the property cannot be
found.

• public static void setBooleanProperty (String name, boolean

value );

Sets the property named byname to value . The boolean value is stored internally as
the string “true” or “false”.

• public static int getIntegerProperty (String name, int

defaultValue );

Returns the integer value of the property named byname. If the property value is not
a valid numeric string, returnsdefaultValue instead.

• public static void setIntegerProperty (String name, int value );

Sets the property named byname to value .

19.4.3. Input/output methods

• public void reload (View view );

Reloads the buffer from disk intoview , asking for confirmation if the buffer has
unsaved changes.

• public boolean save (View view , String path );

• public boolean save (View view , String path , boolean rename );

Therename parameter causes a buffer’s name to change if set totrue ; if false ,
a copy is saved topath .
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• public boolean saveAs (View view , boolean rename );

Prompts the user for a new name for saving the file.

19.4.4. General editing methods

• public String getText (int offset , int length );

• public void getText (int offset , int length , Segment text );

These methods extract a portion of buffer text having lengthlength beginning at
offset positionoffset . The first method returns a newly createdString containing
the requested excerpt. The second version initializes an existingSegment object
with the location of the requested excerpt. TheSegment object represents array
locations within theBuffer object’s data and should be used on a read-only basis.
Calling toString() on theSegment will create a new object suitable for
manipulation.

Using aSegment is generally more efficient than using aString because it results
in less memory allocation and array copying. However,Segments are slightly
harder to set up and use.

• public String getLineText (int lineIndex );

• public void getLineText (int lineIndex , Segment text );

Returns the text of the given line. Just as withgetText() , there are two forms of
this method; the first returns aString , the second copies into aSegment .

• public void beginCompoundEdit ();

• public void endCompoundEdit ();

Marks the beginning and end of a series of editing operations that will be dealt with
by a singleUndo command.

• public void insert (int offset , String text );
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This method inserts the stringtext at offsetoffset in the buffer.

• public void remove (int offset , int length );

This method removeslength characters of text starting fromoffset .

• public void removeTrailingWhiteSpace (int[] lines );

Removes trailing whitespace in the lines referenced by the index numbers in
lines array.

• public int getLineOfOffset (int offset );

Returns the line on which the given offset is found.

• public int getLineStartOffset (int line );

• public int getLineEndOffset (int line );

Returns the offset of the beginning or end of the given line.

• public int getLineLength (int line );

Returns the length of the line numberline (using a zero-based count).

• public int getLineCount ();

Returns the number of lines in the buffer being edited.

• public int getLength ();

Returns the number of characters in the buffer.
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19.4.5. Marker methods

Buffers may have one or moremarkerswhich serve as textual bookmarks. AMarker has
three key attributes: theBuffer to which it relates, the line number to which the marker
refers, and an optional shortcut character. The shortcut identifies the the key that can be
pressed with theMarkers>Go To Marker command to move the editing caret to the
marker line location.

The position and shortcut character of aMarker object can be retrieved with the methods
getPosition() andgetShortcut() .

TheBuffer class includes the following methods to set and retrieve markers:

• public void addMarker (char shortcut , int pos );

Adds a marker for the line indicated bypos usingshortcut . Setshortcut to
’\0’ to indicate the absence of a shortcut.

• public Vector getMarkers ();

Returns aVector containing the buffer’s current markers.

• public Marker getMarkerAtLine (int line );

Returns the first marker at the specified line, ornull if no marker is present at the
line.

• public Marker getMarker (char shortcut );

Returns the marker with the specified shortcut, ornull if no such marker exists.

• public void removeMarker (int line );

Removes all markers at the specified line.

• public void removeAllMarkers ();

Removes all markers in the buffer.
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19.5. Class Macros
This class contains a few methods useful for displaying output messages or obtaining
input from a macro. These methods are documented in detail inSection 12.2. Plugins
should use the methods in theGUIUtilities class instead; seeSection 19.6.

• public static void message (Component comp, String message );

• public static void error (View view , String message );

• public static String input (View view , String prompt );

• public static String input (View view , String prompt , String

defaultValue );

• public static int confirm (View view , String message , int

buttons );

19.6. Class GUIUtilities
The first set of methods in this class, documented below, display various common dialog
boxes. The remainder deal with various miscellaneous user interface-related tasks.

• public static void message (Component comp, String prefix ,

Object[] args );

• public static void error (Component comp, String prefix , Object[]

args );

These two methods both show a dialog box; they are identical in every way except
for the icon used (either a message icon, or an error icon). The title of the dialog is
taken from a property namedprefix .title ; the message text is taken from
prefix .message . The message property can consist of multiple lines of text.

The elements of theargs array are substituted into the value of the message
property in place of strings of the form{ n} , wheren is an index in the array. You
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can find out more about this feature by reading the documentation for theformat

method of thejava.text.MessageFormat class.

• public static String input (Component comp, String prefix , Object

def );

• public static String input (Component comp, String prefix ,

Object[] args , Object def );

These two methods prompt for input; both returnnull if the user pressedCancel,
or the entered value if they pressedOK.

The dialog box title and message is obtained in the same manner as with the
message() anderror() methods.

• public static String inputProperty (Component comp, String prefix ,

Object def );

• public static String inputProperty (Component comp, String prefix ,

Object[] args , Object def );

• public static int confirm (Component comp, String prefix , Object[]

args , int buttons , int type );

• public static String[] showVFSFileDialog (View view , String path ,

int type , boolean multipleSelection );

This method displays theVFSFileChooserDialog provided by jEdit. Ifpath is
set tonull , the dialog will display the directory of the current buffer. Thetype
parameter can either beVFSBrowser.OPEN_DIALOG or VFSBrowser.SAVE_DIALOG .
The final parameter determines whether multiple selection of files is permitted.

• public static void showPopupMenu(JPopupMenu popup , Component

comp, int x , int y );

Plugins should use this method to display popup menus. Unlike the standard
JPopupMenu.show() method, this one ensures that the popup is positioned within
the bounds of the screen.
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• public static Icon loadIcon (String name);

Loads an icon from the specified URL. Relative URLs are resolved relative to the
standard icon directory insidejedit.jar .

The following two methods are described inSection 17.2.3.2.

• public static JMenuItem loadMenuItem (String name);

• public static JMenu loadMenu (String name);

19.7. Class TextUtilities
This class contains a number ofstatic methods that can be helpful in handling buffer
text.

• public static int findMatchingBracket (Buffer buffer , int line ,

int offset );

Returns the offset of the bracket matching the one at offsetoffset of line line
of the buffer; returns -1 if the bracket is unmatched or if the specified character is
not a bracket.

• public static int findWordStart (String line , int pos , String

noWordSep );

• public static int findWordEnd (String line , int pos , String

noWordSep );

Returns the position on which the word found on lineline , positionline begins
or ends. The parameternoWordSep contains those non-alphanumeric characters
that will be treated as part of a word for purposes of finding the beginning or end of
word (such as an underscore character).

• public static String format (String text , int maxLineLength );
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Reformats a string and inserts line separators as necessary so that no line exceeds
maxLineLength in length.

• public static String spacesToTabs (String in , int tabSize );

• public static String tabsToSpaces (String in , int tabSize );

Makes the indicated change based upon a tab size oftabSize .

19.8. Class MiscUtilities
This class is another collection ofstatic utility methods.

These methods extract various elements from a path name:

• public static String getFileName (String path );

• public static String getFileNameNoExtension (String path );

• public static String getFileExtension (String name);

• public static String getParentOfPath (String path );

Returns the directory containing the specified local file.

• public static String constructPath (String parent , String path );

If path is absolute, it is returned. Otherwise, an absolute path is constructed from it
and theparent . If parent is null , the current working directory is assumed.

These methods are hard to categorize, but are useful nonetheless:

• public static String createWhiteSpace (int len , int tabSize );

If tabSize is set to zero, the string will consist entirely of space characters. To get
a whitespace string tuned to the current buffer’s settings, call this method as follows:
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myWhitespace = MiscUtilities.createWhiteSpace(myLength,
buffer.getTabSize());

• public static void compareStrings (String str1 , String str2 );

Compares two strings. Returns a negative number ofstr1 is “before” str2 , zero if
they are equal, and a positive number ofstr1 is “after” str2 . Unlike
String.compareTo() , this method correctly recognizes and handles embedded
numbers.

ThecompareStrings() method is very useful for sorting strings. TheMiscUtilities

class defines severaljava.util.Comparator implementations that use this method,
useful for using with the sorting features of the Java collections API:

• StringCompare

• StringICaseCompare

• MenuItemCompare

For example, you might call:

Arrays.sort(myListOfStrings,
new MiscUtilities.StringICaseCompare());

19.9. Class SearchAndReplace
Search and replace routines are undertaken by jEdit’sSearchAndReplace class.

The following static methods allow you to set or get the parameters for a search. You can
do this prior to or even without activating the search dialog.

• public static void setSearchString (String search );

• public static String getSearchString ();

• public static void setReplaceString (String replace );

• public static String getReplaceString ();
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• public static void setIgnoreCase (boolean ignoreCase );

• public static boolean getIgnoreCase ();

• public static void setRegexp (boolean regexp );

• public static boolean getRegexp ();

• public static void setReverseSearch (boolean reverse );

• public static boolean getReverseSearch ();

Determines whether a reverse search will conducted from the current position to the
beginning of a buffer. Note that reverse search and regular expression search is
mutually exclusive; enabling one will disable the other.

• public static void setBeanShellReplace (boolean beanshell );

• public static boolean getBeanShellReplace ();

Determines whether the replace string will be interpreted as a BeanShell expression.

• public static void setAutoWrapAround (boolean wrap );

• public static boolean getAutoWrapAround ();

Determines whether a search will automatically “wrap” to the beginning of a buffer
after the search reaches the buffer’s end. If this flag is set tofalse , a dialog will
request confirmation of a wrap-around search.

• public static void setSearchFileSet (SearchFileSet fileset );

A SearchFileSet is an abstract class representing the set of files that are the
subject of a search. There are four classes derived fromSearchFileSet :

DirectoryListSet

This represents a set of files taken from a directory. It can be extended recursively to
include files in subdirectories. The constructor for this class has the following syntax:
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• public DirectoryListSet (String directory , String glob , boolean

recurse );

The parameterglob is the glob pattern that determines which files from the
directory will be selected (seeAppendix Dfor information about glob patterns), and
recurse determines whether the selection will recurse into subdirectories.

class AllBufferSet

This class represents the set of all buffers currently open. The constructor for this class
takes a file mask as a single parameter:

• public AllBufferSet (String glob );

class CurrentBufferSet

This class represents a buffer set consisting of the current buffer only. The constructor
has no parameters.

• public CurrentBufferSet ();

The actual tasks of searching and replacing, based on these parameters, are performed by
the following methods. The return value of each indicates whether the operation
succeeded.

• public static boolean find (View view );

This will select the next instance of matching text if the search is successful.

• public static boolean replace (View view );

This will replace the each occurrence of the “search string” in selected text with the
“replace string”. If no text is selected, the method has no effect.

• public static boolean replace (View view , Buffer buffer , int

start , int end );
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This will replace the each occurrence of the “search string” in the specified range
with the “replace string”.

• public static boolean replaceAll (View view );

This method performs a replacement in all buffers in theSearchFileSet . Text
selection is ignored.

• public static boolean hyperSearch (View view , boolean selection );

Performs a HyperSearch either in the current selection (ifselection is true) or in
the currentSearchFileSet (if selection is false).

The “HyperSearch” and “Keep dialog” features, as reflected in checkbox options in the
search dialog, are not handled from withinSearchAndReplace . If you wish to have
these options set before the search dialog appears, make a prior call to either or both of
the following:

jEdit.setBooleanProperty(“search.hypersearch.toggle”,true);
jEdit.setBooleanProperty(“search.keepDialog.toggle”,true);

If you are not using the dialog to undertake a search or replace, you may call any of the
search and replace methods (includinghyperSearch() ) without concern for the value of
these properties.

To create and display the search and replace dialog, first assign desired values to the
search settings using the methods described above. Then create a newSearchDialog

object using the following static method in theSearchDialog class:

• public static void showSearchDialog (View view , String

searchString , int searchIn );

The parametersearchIn can take the defined constant valuesCURRENT_BUFFER,
ALL_BUFFERSor DIRECTORY, defined in theSearchDialog class. This parameter
determines which file set radio button to preselect in the dialog box.
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19.10. Class Registers
A Register is string of text indexed by a single character. Typically the text is taken
from selected buffer text and the index character is a keyboard character selected by the
user.

The application maintains a singleRegisters object consisting of an dynamically sized
array ofRegister objects. TheRegisters class defines a number of methods that give
each register the properties of a virtual clipboard.

The following methods provide a clipboard operations for register objects:

• public static void copy (JEditTextArea textArea , char register );

Saves the selected text in the designatedtextArea to the register indexed at
register . This will replace the existing contents of the designated register.

• public static void cut (JEditTextArea textArea , char register );

Saves the selected text in the designatedtextArea to the register indexed at
register , and removes the text from the text area. This will replace the existing
contents of the designated register.

• public static void append (JEditTextArea textArea , char register ,

String separator , boolean cut );

• public static void append (JEditTextArea textArea , char register ,

String separator );

• public static void append (JEditTextArea textArea , char register );

These three methods append the selected text in thetextArea to the designated
register. If thecut parameter is not specified, the selected text remains in the text
area. If theseparator parameter is not specified, a newline character is used to
separate the appended text from any existing register text.

The following methods provide a lower-level interface for working with registers:
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• public static void setRegister (char name, Registers.Register

register );

• public static void setRegister (char name, Registers.Register

newRegister );

• public static void clearRegister (char name);

Sets the text of the designated register tonull . If the register is one of the two
registers reserved by the application (as discussed in the next section), the text value
is set to an empty string.

• public static Registers.Register getRegister (char name);

• public static Registers.Register[] getRegisters ();

19.10.1. Interface Registers.Register

This interface requires implementation of two methods:setValue() , which takes a
String parameter, andtoString() , which return a textual representation of the
register’s contents. Two classes implement this interface. AClipboardRegister is tied
to the contents of the application’s clipboard. The application assigns a
ClipboardRegister to the register indexed under the character$. A StringRegister

is created for registers assigned by the user. In addition, the application assigns to the
StringRegister indexed under%the last text segment selected in the text area.

A Register object does not maintain a copy of its index key. Indexing is performed by
theRegisters object.

19.11. Class DockableWindowManager
Windows conforming to jEdit’s dockable window API can appear in “panes” located
above, below or to the left or right of the main editing pane. They can also be displayed
in “floating” frame windows. ADockableWindowManager keeps track of the windows
associated with a particularView . EachView object contains an instance of this class.

• public JComponent getDockable (String name);
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Returns the dockable window named by thename parameter. If there is no dockable
window bearing the requested name, the method returnsnull .

Note: You might wonder why this method is not named getDockableWindow() .
A method with that name already exists, but it is deprecated since it returns
instances of the DockableWindow interface, which should no longer be used.

Always call getDockable() instead.

• public void addDockableWindow (String name);

If the dockable window named by thename parameter does not exist, it is created.
The dockable window is then made visible.

• public void showDockableWindow (String name);

• public void removeDockableWindow (String name);

• public void toggleDockableWindow (String name);

These methods, respectively show, hide and toggle the visibility of the dockable
window object named by thename parameter. If theDockableWindowManager does
not contain a reference to the window, these methods send an error message to the
activity log and have no other effect. OnlyaddDockableWindow() can cause the
creation of a dockable window.

19.12. Class BeanShell
This class integrates the BeanShell interpreter into jEdit. One method is worth
mentioning here because it can be used in a macro to chain together execution of several
macros:

• public static void runScript (View view , Reader in , String path ,

boolean ownNamespace);
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If the in parameter is non-null, the script is read from that stream; otherwise it is read
from the file identified bypath . Within that script, references tobuffer , textArea
andeditPane are determined with reference to theview parameter.

The parameterownNamespace determines whether a separate namespace will be
established for the BeanShell interpreter. If set tofalse , methods and variables defined
in the script will be available to all future uses of BeanShell; if set totrue , they will be
lost as soon as the script finishes executing. jEdit uses a value offalse when running
startup scripts, and a value oftrue when running all other macros.

19.13. Class AbstractOptionPane
Most plugin option panes extend this implementation ofOptionPane , instead of
implementingOptionPane directly. It provides a convenient default framework for
laying out configuration options in a manner similar to the option panes created by jEdit
itself. It is derived from Java’sJPanel class and contains aGridBagLayout object for
component management. It also contains shortcut methods to simplify layout.

The constructor for a class derived fromAbstractOptionPane should call the parent
constructor and pass the option pane’s “internal name” as a parameter. The internal name
is used to key a property where the option pane’s label is stored; seeSection 16.2.1. It
should also implement two methods:

• protected void _init ();

This method should create and arrange the components of the option pane and
initialize the option data displayed to the user. This method is called when the
option pane is first displayed, and is not called again for the lifetime of the object.

• protected void _save ();

This method should save any settings, to the jEdit properties or other data store.

AbstractOptionPane also contains three shortcut methods, typically called from
_init() , for adding components to the option pane:

• protected void addComponent (String label , Component comp);
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• protected void addComponent (Component comp);

These shortcut methods add components to the option pane in a single vertical
column, running top to bottom. The first displays the text of thelabel parameter
to the left of theComponent represented bycomp.

• protected void addSeparator (String label );

This is another shortcut method that adds a text label between two horizontal
separators to the option pane. Thelabel parameter represents the name of a
property (typically a property defined in the plugin’s property file) whose value will
be used as the separator text.

19.14. Class OptionGroup
In those cases where a single option pane is inadequate to present all of a plugin’s
configuration options, this class can be used to create a group of options panes. The
group will appear as a single node in the options dialog tree-based index. The member
option panes will appear as leaf nodes under the group’s node. Three simple methods
create and populate an option pane:

• public OptionGroup (String name);

The constructor’s single parameter represents the internal name of the option group.
The internal name is used to key a property where the option group’s label is stored;
seeSection 16.2.1.

• public void addOptionPane (OptionPane pane );

• public void addOptionGroup (OptionGroup group );

This pair of methods adds members to the option group. The second method
enables option groups to be nested, for plugins with a particularly large set of
configurable options.

244



Chapter 20. EditBus Classes
This section describes theEditBus class itself, as well as the abstractEBMessage class
and all classes that derive from it. SeeSection 16.3.2for an overview of how the EditBus
works.

20.1. Class EditBus
This class provides a messaging system for all components that implement the
EBComponent interface, includingView andEBPlugin objects.

• public static void addToBus (EBComponent component );

• public static void removeFromBus (EBComponent component );

Adds or removes a subscribing component.

• public EBComponent[] getComponents ();

Returns an array of all components connected to the EditBus.

• public void send (EBMessage message );

Send the specified message to all subscribers on the EditBus.

20.2. Interface EBComponent
This interface is required for any class that subscribes to messages published on the
EditBus. It contains a single method.

• public void handleMessage (EBMessage message );
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20.3. Class EBMessage
This abstract class defines a message that can be sent on the EditBus to subscribing
components. It contains two attributes that can be obtained with the following methods:

• public EBComponent getSource ();

• public boolean isVetoed ();

• public void veto ();

This sets thevetoed state totrue , which terminates circulation of the message to
subscribers on the EditBus. To prevent a message from being vetoed, the message
object must be derived from the abstract classEBMessage.NonVetoable . An object
of this class will throw anInternalError if the veto() method is called on it.

A summary of classes derived fromEBMessage can be found in the following sections.

20.4. Class BufferUpdate
This message is sent when the status of a buffer changes. It may not be vetoed by a
subscriber, so that all subscribers are assured of receiving it regardless of an individual
subscriber’s response.

• public Buffer getBuffer ();

• public View getView ();

This may benull with some message types.

• public Object getWhat ();

Returns one of the following constants defined in theBufferUpdate class:

• CREATED

• LOAD_STARTED

• DIRTY_CHANGED

246



Chapter 20. EditBus Classes

• MARKERS_CHANGED

• MODE_CHANGED

• ENCODING_CHANGED

• SAVING

20.5. Class EditorExiting
This message signifies that the host application is about to exit. The message has no
parameters and may not be vetoed.

20.6. Class EditorExitRequested
This message signifies that a request has been made for the host application to exit. The
request is subject to cancellation in response to a request to write a modified buffer to
storage. It may not be vetoed.

• public View getView ();

20.7. Class EditorStarted
This message signifies that the host application has started. The message is sent before
any views are created. The message has no parameters and it may not be vetoed.

20.8. Class EditPaneUpdate
This message is sent when the status of a edit pane changes. It may not be vetoed.

• public EditPane getEditPane ();

• public Object getWhat ();
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Returns one of the following constants defined in theEditPaneUpdate class:

• CREATED

• DESTROYED

• BUFFER_CHANGED- a change in the buffer displayed in the edit pane

20.9. Class MacrosChanged
This message signifies that the list of available macros have changed. The message has
no parameters and may not be vetoed.

20.10. Class PropertiesChanged
This message is sent when configuration settings have been changed through any of the
option panes in the options dialog. The message has no parameters and may be vetoed.

20.11. Class SearchSettingsChanged
This message is sent when settings in the “Search and Replace” dialog have changed.
The message has no parameters and may be vetoed.

20.12. Class VFSUpdate
This message is sent when the status of a file or directory changes. This allows
subscribers that display or operate upon files an opportunity to adjust their state. This
message may not be vetoed.

• public String getPath ();
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20.13. Class ViewUpdate
This message is sent when the status of a view changes. It may not be vetoed.

• public View getView ();

• public Object getWhat ();

Returns one of the following constants defined in theViewUpdate class:

• CREATED

• CLOSED
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